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P r e f a c e
COPYRIGHT AND TRADEMARK NOTICE

Copyright 2015 Telestream, LLC. All rights reserved. No part of this publication may be reproduced, 
transmitted, transcribed, altered, or translated into any languages without written permission of 
Telestream, LLC. Information and specifications in this document are subject to change without notice and 
do not represent a commitment on the part of Telestream. 

Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, Lightspeed, ScreenFlow, Switch, 
Vantage, Wirecast, GraphicsFactory, MetaFlip, and Split-and-Stitch are registered trademarks and 
Pipeline, MacCaption, and e-Captioning are trademarks of Telestream, LLC. All other trademarks are the 
property of their respective owners. 

QuickTime, Mac OS X, Final Cut Pro, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour logo, 
and the Bonjour symbol are trademarks of Apple, Inc.

All other brand, product, and company names are property of their respective owners, and are used only 
for identification purposes.

MPEG-2 License Requirements
Telestream has obtained a license from MPEG LA, to produce MPEG-2 video, to meet the following 
requirement on behalf of its FlipFactory and Pipeline licensees: The use of this product in any manner that 
complies with the MPEG-2 standard is expressly prohibited without a license under applicable patents in 
the MPEG-2 patent portfolio, which license is available from MPEG LA, L.L.C., 250 Steele Street, Suite 
300, Denver, Colorado 80206.

Obtaining Pipeline Support | Information | Assistance

Web Site. http://www.telestream.net/telestream-support/pipeline/support.htm

Terms and times of support services vary, per the terms of your current service contract with Telestream.

http://www.telestream.net/telestream-support/pipeline/support.htm


Prefaceii
Pipeline Web Site – FAQs, Forums & Updates

Web Site. http://www.telestream.net/telestream-support/pipeline/support.htm

Returning Inoperative Pipelines (RMA)

If your Pipeline is inoperative, contact Telestream at the Pipeline support E-mail address provided below, 
or contact your authorized reseller. Provide your company and contact information, the serial number of 
the inoperative unit, and request instructions for Return Material Authorization.

Company and Product Information
For information about Telestream or its products, please contact us via:

Web Site. www.telestream.net

Sales and Marketing Email. info@telestream.net

We’d Like to Hear From You!
If you have comments or suggestions about improving this document, other Telestream documents, or our 
Web site – or if you've discovered an error or omission, please email us at techwriter@telestream.net

Mail

Telestream, LLC. 
848 Gold Flat Road, Suite 1
Nevada City, CA. USA 95959

International Telestream Distributors

See the Telestream Web site at www.telestream.net for your regional authorized Telestream distributor.

FCC Emission Information
Ethernet connections to Pipeline devices must be made using a shielded Category 5 or Category 6 cable 
to ensure emissions are within applicable standards. This equipment has been tested and found to comply 
with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference with other electronic 
equipment in which case the user will be required to correct the interference at his/her own expense. 
Changes or modifications not expressly approved by Telestream can affect emission compliance and could 
void the user's authority to operate this equipment.
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Canadian EMC Notice of Compliance
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus 
set out in the Radio Interference Regulations of the Canadian Department of Communications.

Le present appareil numerique n'emet pas de bruits radioelectriques depassant les limites applicables aux 
appareils numeriques de la classe A prescrites dans le Reglement sur le brouillage radioelectrique edicte 
par le Ministere des Communications du Canada.

Important Safety Instructions
Before using Pipeline devices, read the following safety instructions to ensure it is used safely:

• Unplug the device before cleaning.

• Use only a lightly-dampened cloth to clean the unit; never pour liquids onto the device.

• Do not place the device on an unstable surface or near extreme heat.

• Do not stack Pipelines more than two units high to avoid over-heating.

• Use only the power source supplied, and recommended in this manual.

• Connect all electronic equipment to properly grounded power outlets.

• Telestream recommends using surge protection equipment (may be feature of a UPS). 

EN55022 Class A Warning

In a domestic environment this product may cause radio interference in which case the user may be 
required to take adequate measures.

Regulatory Approved Standards for Electrical Safety

This equipment complies with the minimum requirements of these standards:

IEC950 (or EN60950/BS7002/VDE0805 May 1990)
UL1950
CSA C22.2-950-M89

Radiation Emission Susceptibility Regulatory Approved Standards

This equipment complies with the minimum requirements of these standards:

FCC155, Class A
EN55022, Class A
EC DIR 89/336/EEC
EN50082-1

Caution

Pipelines contain no user serviceable parts. Never open the chassis 
enclosure. Doing so without express permission from Telestream may 
void your warranty.
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Prefaceiv
Limited Warranty and Disclaimers
Telestream LLC (the Company) warrants to the original registered end user that the product will perform as stated 
below for a period of one (1) year from the date of shipment from factory:
Hardware and Media. The Product hardware components, including equipment supplied but not manufactured by the 
Company but NOT including any third party equipment that has been substituted by the Distributor for such equipment 
(the “Hardware”), will be free from defects in materials and workmanship under normal operating conditions and use.
Software. If software is supplied as part of the product, the software will operate in substantial conformance with 
specifications set forth in its product user's guide. The Company does not warrant that the software will operate 
uninterrupted or error-free, will meet your requirements, or that software errors will be corrected.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media. The Company will either repair or replace (at its option) any defective Hardware component or 
part, or Software Media, with new or like new Hardware components or Software Media. Components may not be 
necessarily the same, but will be of equivalent operation and quality. 

Software. If software is supplied as part of the product and it fails to substantially confirm to its specifications as stated 
in the product user's guide, the Company shall, at its own expense, use its best efforts to correct (with due allowance 
made for the nature and complexity of the problem) such defect, error or nonconformity. 

Software Updates
If software is supplied as part of the product, the Company will supply the registered purchaser/licensee with 
maintenance releases of the Company’s proprietary Software Version Release in manufacture at the time of license for 
a period of one year from the date of license or until such time as the Company issues a new Version Release of the 
Software, whichever first occurs. To clarify the difference between a Software Version Release and a maintenance 
release, a maintenance release generally corrects minor operational deficiencies (previously non-implemented 
features and software errors) contained in the Software, whereas a Software Version Release adds new features and 
functionality. The Company shall have no obligation to supply you with any new Software Version Release of 
Telestream software or third party software during the warranty period, other than maintenance releases.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or Software Media, or any part 
thereof, is damaged due to abuse, misuse, alteration, neglect, or shipping, or as a result of service or modification by a 
party other than the Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. No oral or written information or advice given by the Company, its 
distributors, dealers or agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty. This limited warranty is valid only within the country in which the Product is 
purchased/licensed.

Limitations on Remedies. YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF TELESTREAM, LLC. 
WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS LIMITED WARRANTY. Your sole and 
exclusive remedy for any and all breaches of any Limited Warranty by the Company shall be the recovery of 
reasonable damages which, in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages. TELESTREAM LLC., SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST 
PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR 
USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, 
EVEN IF THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY 
PROVIDED FAILS OF ITS ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC.
848 Gold Flat Road, Suite 1
Nevada City, CA 95959

You can call Telestream  via telephone at (530) 470-1300.
December 2015
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1

C H A P T E R 1

I n t r o d u c t i o n
Chapter 1, Introduction

Pipeline is an industry-first network-based video capture and playout device for moving SD & HD SDI 
video & audio in and out of Mac OS X & Windows file-based workflows. Pipeline systems provide real-time 
SD and HD SDI ingest and capture into industry-standard QuickTime, MXF OP1a, and MXF OPAtom 
directly to any storage location.

Pipeline can also be used as the front-end capture system supplying media files that can be immediately 
used directly with Telestream’s transcoding workflow automation tools. It can encode media into 
QuickTime or MXF for use in products including Apple’s Final Cut Pro, Avid Media Composer, and Adobe 
Premiere Pro. 

Pipeline captures media from tape or live sources, making it ideal for integration in broadcast, production, 
postproduction, government, and other professional media workflow applications. A Pipeline software 
development kit (SDK) is also available from Telestream, which enables integration in custom applications.

PIPELINE AUTOMATES REAL-TIME MEDIA WORKFLOWS

Designed into Pipeline is ease of use for broadcasters, post-production houses, government agencies, 
universities, and video professionals. Setting up a Pipeline is easy. Connect Ethernet and SDI, attach an 
optional VTR, and configure your network settings – you’re often up and running in under ten minutes.

Figure 1–1. Pipeline automates and adds value to real-time transcoding workflows
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2

TELESTREAM’S PIPELINE FAMILY OF PRODUCTS

Pipeline SC
Pipeline SC is a single-channel, single-session device. It is ideally suited for low-volume workflows where 
easy location and setup is important.

Figure 1–2. Pipeline SC – compact, and easy to set up

Pipeline SC offers these features:

• Network-accessible SDI video encoding and playout

• Real-time encoding from standard definition NTSC/PAL SDI to DV, DVCPro, IMX 30|40|50, ProRes 422 
SQ (SD), MJPEG A, and MPEG-2 50 mb/sec I-frame video

• Real-time decoding from SD DV, DVCPro, IMX, and ProRes 422 SQ to PAL/NTSC SDI video

• Extends FlipFactory, Final Cut Pro, and Episode to include workflows with tape or live sources

• VBI closed caption and timecode data extraction

• Shared network access to Pipeline saves time, effort and money

• Digitizes tapes into online libraries for an end-to-end DAM solution

• Records clips to tape for sharing with clients or colleagues.

Pipeline Quad
Pipeline Quad is a four-channel, rack-mounted device with Gigabit Ethernet and four independent Pipeline 
channels. Pipeline Quad also has a Sync Input for synchronizing output streams and for extracting VITC 
timecode.

Figure 1–3. Pipeline Quad – four-channels for high-volume applications

The Pipeline Quad’s rack-mount form is ideal for high-volume, scalable workflows where throughput and 
performance are important factors.

Pipeline Quad performs all encoding and decoding available in Pipeline SC, and adds these features: 

• Four concurrent, independent Pipeline channels on a single, rack-mount device

• Digital SDI sync input channel (sync in only) for frame-synchronized playout across all channels

• Optional, configurable confidence monitoring of client-bound video on a dedicated channel

• Gigabit Ethernet and dual, common power supplies for increased fail-safe operation.
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Pipeline HD Dual
Pipeline HD Dual is a two-channel, rack-mounted system with dual Gigabit Ethernet enabling two 
independent Pipeline HD channels. Pipeline HD Dual also has an SDI Reference input for synchronizing 
output streams and for extracting VITC timecode.

Figure 1–4. Pipeline HD Dual – two channels for high-volume HD applications

The Pipeline HD Dual’s rack-mount form is ideal for high-volume, scalable workflows where throughput 
and performance are important factors.

Pipeline HD Dual performs all encoding and decoding available in Pipeline SC, and adds these features:

• HD codec support for Uncompressed SD 8-bit, DVCPro50, Apple ProRes 422 HD, Avid DNxHD, and 
DVCProHD

• Two concurrent, independent Pipeline HD channels on a single, rack-mount device

• Digital SD or HD SDI sync input channel (sync in only) for frame synchronized playout across all 
channels

• Gigabit Ethernet for each channel and dual, common power supplies for increased fail-safe operation.

PIPELINE BENEFITS

A better way to capture and playout baseband media
Telestream Pipeline is a network-based video capture and playout device for moving HD and SD video and 
audio in and out of any file-based workflow. This cross-platform solution offers Mac OS X and Windows 
users more choices for fast, robust, reliable video capture.

Accessible from any workstation on your network
Pipeline provides freedom from the hassles, limitations, and expense of traditional capture-card solutions 
on a dedicated workstation. Common network protocols, RS-422 deck control, and frame-accurate
ingest/playout make Pipeline a smart choice for any video workflow.

Pipeline provides direct support for MXF workflows, creating OPAtom and OP1a media. For users who 
need to maintain closed captions and other ancillary data, Pipeline offers methods of achieving this via 
MXF, TIFO, and Avid/Apple proprietary schemes.

In addition to capture, Pipeline provides an easy Print to Tape interface for users who need to insert edit, 
assemble edit, controlled playout, or crash playout back to tape.

Edit or transcode during capture for quick turnaround
Pipeline allows you to edit or transcode your media files while they are being captured. There is no need to 
wait for the complete file to arrive. Batch ingest from an EDL file allows you to encode multiple clips from a 
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single tape. Plus, real-time reliable hardware encoding removes capture card/workstation operating 
system and driver incompatibilities.

Cost-effective network import/export station
Pipeline enables any machine on the network to act as a dedicated, network import/export station – 
making it very cost effective. In addition, Pipeline offers support for direct extraction and preservation of 
ancillary data and a wide variety of timecode sources. A powerful Web service API makes it easy to 
develop applications that automate control of multiple Pipeline systems. A comprehensive SDK is 
available for easy integration into any workflow.

Multi-channel scalability
Pipeline Quad and Pipeline HD Dual offer unparalleled encoding power in a compact 1RU box, plus they 
include dual power supplies for critical workflows. Pipelines can be stacked or racked for scalability to an 
unlimited number of channels.

Ingest into editing workflows
Pipeline saves significant time and costs over traditional ingest solutions by importing media directly into 
your editing workflow. A single workstation or server can handle the demands of ingesting multiple SD or 
HD streams. QuickTime movie files are ready immediately, allowing incoming events and breaking news to 
be edited while they are being captured. External encoding allows you to use your workstation for editing 
instead of waiting for clips to be rendered. Additionally, Pipeline's keyboard commands allow you to set up 
your workflow the way you want.

Ingest into transcoding workflows
Use Pipeline for high-quality baseband ingest into your transcoding workflow. Telestream's FlipFactory, 
Vantage, Agility, and Episode products allow you to simultaneously create high-res files for storage while 
creating a low-res proxy, or create any number of additional file formats in near-realtime. Transcoding 
begins immediately while ingesting media, saving you time and money. Pipeline also preserves important 
metadata throughout your transcoding workflow.
December 2015
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C H A P T E R 2

P i p e l i n e  H a r d w a r e ,
I n s ta l l a t i o n  &  S e t u p
Chapter 2, Pipeline Hardware, Installation & Setup

Use this chapter to unpack and set up Pipeline SC, Pipeline Quad, and Pipeline HD Dual devices, connect 
video equipment, and configure the Pipeline for a LAN connection. Before proceeding, work with your 
network administrator to determine network setting requirements: IP address, netmask, and the gateway 
address. You should also understand your media workflow requirements and read Disk and Network 
Requirement by Media Format (page 38).

To set up and configure your Pipeline correctly, complete the tasks in this chapter, referring to Chapter 5, 
Using the Configure Panel on page 44 for network configuration tasks.

Topics

 Environmental Operating Requirements (page 6)

 Power Requirements (page 6)

 Unpack the Pipeline (page 6)

 Locate the Pipeline SC (page 7)

 Locate the Pipeline Quad | Pipeline HD Dual (page 7)

 Pipeline SC Hardware (page 8)

 Pipeline Quad Hardware (page 10)

 Pipeline HD Dual Hardware (page 14)

 Connecting Pipeline to Mac OS X or Windows Computers (page 19)

 Adding Pipeline to a Network (page 20)

 Powering up the Pipeline (page 21)

 Configuring & Connecting to Pipelines (page 21)

 Registering Your Pipeline with Telestream (page 22)

Note

Topics in this chapter refer to all Pipeline devices unless specifically noted.
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ENVIRONMENTAL OPERATING REQUIREMENTS

Plan adequate space for cable routing from the back of the chassis. Ensure that the Pipeline is in close 
proximity to your Ethernet and video cables, and that cable connectors are not stressed, bent, or crimped. 
Also make sure that you have adequate space for a VTR deck, if necessary.

Allow at least six inches (15 cm) of space between the Pipeline and the nearest object to ensure adequate 
airflow. Keep the temperature range within acceptable limits (table below), and keep humidity moderate in 
the vicinity. Temperature specifications are as follows:

POWER REQUIREMENTS

Input Voltage. Auto-sensing 100 to 240V AC, 50/60Hz 

UNPACK THE PIPELINE

Unpack the contents of the original shipping container; identify each component and determine that they 
are in satisfactory condition. If any shipping damage is visible, note it on your shipping documents and 
contact your shipping agent and Telestream or authorized Telestream distributor. 

Caution

Do not place more than two Pipeline SCs in a stack. If you do, you risk 
overheating a unit, potentially leading to operational failure.

Table 2–1. Operating and Storage Temperature Parameters

Modes Temperature Ranges

Operating Temperature 0°C to 40°C (32°F to 104°F)

Storage Temperature -40°C to 60°C (-40°F to 140°F)

Caution

Telestream recommends connecting computer equipment to AC power through 
an uninterruptible power supply (UPS) with surge protection. Fluctuations in 
commercial supply voltage can damage unprotected electronic equipment. 

A high quality surge suppressor may be substituted if a UPS is not available, but 
it may not provide adequate protection.

Note

Save all packaging materials and store them in a safe place. If you require service – or 
move your Pipeline – the packaging materials may be used for safe shipment.
December 2015
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Pipeline SC Shipping Container Contents
In addition to the Pipeline itself, each package contains the following:

• Software Installation and User’s Guide CD-ROM

• Power adapter with power cord

• Quick Start Guide (in CD case)

Pipeline Quad Shipping Container Contents
In addition to the Pipeline itself, each package contains the following:

• Software Installation and User’s Guide CD-ROM

• Power cords

• Quick Start Guide (in CD case)

Pipeline HD Dual Shipping Container Contents
In addition to the Pipeline itself, each package contains the following:

• Software Installation and User’s Guide CD-ROM

• Power cords

• Quick Start Guide (in CD case)

LOCATE THE PIPELINE SC

For permanent locations, select a stable and level, smooth, hard surface. Avoid carpeted or cloth-covered 
surfaces which inhibit airflow or reduce heat dissipation, which contributes to overheating. Select an 
isolated area that provides a proper operating environment and protection from accidental damage to the 
Pipeline. Route power, Ethernet, and other cables to protect users from a tripping hazard and damage to 
the Pipeline.

LOCATE THE PIPELINE QUAD | PIPELINE HD DUAL

For permanent locations, mount the Pipeline Quad|HD Dual in a single rack-unit slot in a computer rack 
and secure it in place. Make sure the following issues are adequately addressed:

Elevated Operating Ambient Temperature. If installed in a closed or multi-unit rack assembly, the 
operating ambient temperature of the rack environment may be greater than room ambient. Therefore, 
consideration should be given to installing the equipment in an environment compatible with the maximum 
ambient temperature specified (Operating and Storage Temperature Parameters on page 6).

Reduced Air Flow. Installation of the equipment in a rack should be such that the amount of air flow 
required for safe operation of the equipment is not compromised.

Mechanical Loading. Mounting of the equipment in the rack should be such that a hazardous condition is 
not achieved due to uneven mechanical loading.

Circuit Overloading. Consideration should be given to the connecting equipment to the supply circuit and 
the effect that overloading of the circuits might have on over-current protection and supply wiring. 
Appropriate consideration of equipment nameplate ratings should be given when addressing this concern.
178027
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Reliable Earthing. Reliable earthing of rack-mounted equipment should be maintained. Particular 
attention should be given to supply connections other than direct connections to the branch circuit (e.g. 
use of power strips).

PIPELINE SC HARDWARE

The Pipeline SC is 7.5 inches (19.1 cm) wide, 5.5 inches (14.0 cm) deep, and 1.5 inches (3.8 cm) high.

Pipeline SC is a compact, network-ready SDI encoder/decoder device equipped with 10/100Mb Ethernet 
using TCP/IP, UDP, RTSP, and RTP. It uses Bonjour for service discovery. Additionally, it employs Serial 
Digital Interface (BNC, SMPTE-259M 270mb/sec) with 8-channel embedded audio input and output ports, 
plus automatic detection of 525/625. It also has an RS-422 deck control port using Sony 9 Pin Protocol.

Pipeline can capture and play out NTSC/PAL having DV/DVCPRO 25Mb, IMX 30|40|50 and MPEG-2 
I-Frame 50Mb MJPEG, ProResSQ video (capture only) video, and 48 KHz, 16/24 bit, uncompressed 
audio.

Processing VBI Closed Captions and Timecode Data
Pipeline automatically processes Vertical Blanking Interval (VBI) data on ingest operations to obtain closed 
caption and timecode data. Closed captions are extracted from line 21, and timecode from lines 16 through 
20 (5 lines beginning with line 16). The last line (usually 20) with a valid timecode is the line whose data is 
used. Pipeline encodes the closed caption and timecode data into the data stream of the digital output, 
making it available for processing by client applications, such as FlipFactory, Vantage, Agility, and Episode.

Front Panel Indicators
The front panel contains LED indicators, making it easy to check its status.

Figure 2–1. Pipeline SC front panel

There are three LEDs you use to determine the state of the Pipeline:

Power. Displays green light when power is present.

SDI In. Display green light when Pipeline is configured to encode SDI In and send it out via Ethernet. How 
media is encoded is determined by the selected codec. If the LED lights orange, data is being lost. The 
reason should be corrected before continuing operation. During a firmware upgrade, this LED lights yellow 
until you reboot.

SDI Out. Displays green light when the Pipeline is configured to decode digital media from the Ethernet 
port, and send decoded media to the SDI Out port. If the LED lights orange, data is being lost. The reason 
should be corrected before continuing operation.

Power On
LED

SDI In
LED

SDI Out
LED
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Rear Panel Ports and Connectors
The rear panel contains the power jack, plus video and network connector ports.

Figure 2–2. Pipeline SC rear panel

When connecting video equipment, Ethernet, and RS-422 cables, be sure that the power supply is 
disconnected from the Pipeline. Failure to do so may result in equipment malfunction or damage. 

DC Power Port. Use to connect and turn on the Pipeline. Only connect the Pipeline to power using the 
Telestream-supplied power supply.

10/100 Ethernet Port. The Ethernet port has two LEDs:
Link (left LED): If the LED is not lit, no link is available. If the LED is lit orange, link has been established.

Connection/Activity (right LED): If the port is connected at 100 Mb, the LED lights green, and blinks on 
activity. If the port is connected at 10 Mb, the LED is unlit, but blinks green during activity.

RS-422. Female DB-9 (9-pin D-connector) RS-422 port for VTR.

SDI In. BNC jack for SDI input signal.

SDI Out. BNC jack for SDI output. 

Pin # Function

1 GND

2 RX-

3 TX+

4 GND

5 No Connection

6 GND

7 RX+

8 TX-

9 GND

Caution

If the Connection LED is unlit, the Pipeline is operating at 10 Mb, which is 
unacceptable for real time video traffic. Resolve the problem before continuing, 
to avoid video stream data loss.

DC Power 
Connector

SDI
In

SDI
Out

10/100
Ethernet

VTR RS-422
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PIPELINE QUAD HARDWARE

The Pipeline Quad is 17.3 inches (43.9 cm) wide, 13.2 inches (33.5 cm) deep, and 1.5 inches (3.8 cm) 
high. Pipeline Quad is a single rack unit device, with four onboard SDI encoder/decoder devices equipped 
with an external Gigabit Ethernet port and an onboard switch routing 100Mb Ethernet to each device, using 
TCP/IP, UDP, RTSP, and RTP and Bonjour for service discovery. Serial Digital Interfaces are provided for 
each device (BNC, SMPTE-259M 270mb/sec).

There are 4 SDI in and out ports (per Quad, not per channel), each supporting up to 16 channels of 
embedded audio, with four SDI in and out ports (per Quad) with automatic detection of 525/625, and RS-
422 deck control ports, using Sony 9 Pin Protocol.

Pipeline Quads can encode and decode NTSC or PAL with DV/DVCPRO 25Mb, IMX 30, 40, 50, MPEG2 I-
Frame 50Mb MJPEG, and ProRes SQ video (encode only, in FlipFactory workflows), and 48 kHZ, 16 and 
24 bit, uncompressed audio, in up to four concurrent sessions; each individual Pipeline channel operates 
independently, each communicating via a common physical Ethernet port on the Quad’s backplane.

The Pipeline Quad and HD Dual provides common, dual power supplies for redundancy and fail-safe 
operation. Telestream highly recommends that both power supplies be connected during operations. The 
Pipeline can operate normally on a single power supply, however you will lose the redundant safety of the 
second power supply.

Using SDI Sync Input
The SDI Sync Input is used in both capture and playout modes, but for two different purposes. 

In capture mode, the SDI Sync Input is used as a method for supplying a common timecode reference to 
all input channels. For the timecode to be extracted, the SDI signal connected to the SDI Sync Input must 
contain a valid timecode in the ancillary data area of the signal. The SDI signal must be a digital signal that 
is frame synchronized with the SDI signals used as input video sources connected to each channel's input. 
An analog sync/reference signal, such as bi-level or tri-level, cannot be connected to the SDI Sync input.

In playout mode, the SDI Sync Input is used as a frame synchronization source for each channel's SDI 
outputs. Any timecode on the SDI Sync Input is ignored in this mode. If no signal is connected to the SDI 
Sync Input, each channel's SDI output will be frame synchronized to the video input. If no video input is 
connected, each channel's SDI output will free run. This means they will not be synchronized with each 
other or with any common reference. An analog sync/reference signal, such as bi-level or tri-level, cannot 
be connected to the SDI Sync input.

.

Using SDI Sync Out
Re-clocked loop-through port of SDI Sync In. You can use this re-clocked reference for additional Pipelines 
or other devices. This output is only active when the Pipeline device is powered up and is in an operational 
state.

Note

The Sync Input signal must match the intended video output signal's frame size, frame 
rate and line scan (interlaced or progressive) modes.
December 2015
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Processing Closed Caption and Timecode Data
Pipeline automatically processes Ancillary Data on ingest operations to obtain closed captions and 
timecode data. Pipeline encodes the closed caption and timecode data into the data stream of the digital 
output, making it available for further processing by client applications, such as FlipFactory, Vantage, 
Agility, and Episode.

The Pipeline automatically analyzes the signal during the Vertical Blanking Interval (VBI) on ingest 
operations to obtain closed captions and timecode data. Closed caption data is extracted from line 21, and 
timecode data from lines 16 through 20 (the 5 lines beginning with line 16). The last line (usually line 20) 
with a valid timecode is the line whose data is used.

Front Panel Indicators
The front panel contains LED indicators, making it easy to check its status.

Figure 2–3. Pipeline Quad front panel

SDI In. One per channel. Lights green when the Pipeline is configured to encode SDI In and send it out via 
the Ethernet port. Media is encoded based on the selected codec. If the LED lights orange, data is being 
lost. Correct problem before continuing. During a firmware upgrade, the LED lights yellow until the upgrade 
completes and the Pipeline is automatically rebooted.

SDI Out. One per channel. Lights green when the Pipeline is configured to decode digital media from the 
Ethernet port, and send decoded media to the SDI Out port. If the LED lights orange, data is being lost. 
The problem should be corrected before continuing operation.

The LED blinks orange at one second intervals when the internal Ethernet switch and network that 
connects the four Pipelines has failed. Usually, at least one of the Pipelines can’t communicate, indicating 
that potentially an input channel has failed, and confidence monitoring is not operational. Reboot Pipeline 
to solve the problem, or contact Telestream customer service.

Link. Lights green when Ethernet link has been established.

Sync. Lights green when an SDI signal is detected on the sync reference input channel.

PWR 1 & 2. Lights green when power is present and the power supply is operating normally. PWR1 
indicates power supply 1; PWR2 indicates power supply 2. An orange PWR LED indicates a failed power 
supply or that no power is present.

If a power supply fails, complete jobs in progress. RMA the Pipeline to Telestream for repair as soon as 
practical.

Power 1 & 2 LEDsSDI In LED (1 per channel) Link LED
SDI Out LED (1 per channel) Sync LED
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Front Panel Reset Switches
With the front panel bezel removed, five recessed reset buttons are exposed. They are not labeled.

Figure 2–4. Pipeline Quad reset switches behind front panel

Channel 1 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 1. The channel will be disconnected from any client currently attached.

Channel 2 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 2. The channel will be disconnected from any client currently attached.

Channel 3 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 3. The channel will be disconnected from any client currently attached.

Channel 4 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 4. The channel will be disconnected from any client currently attached.

 Factory Default Reset. Insert a pointed object to depress the recessed button to restore the factory 
defaults of the Pipeline device. Both channels are returned to their original factory default values, including 
IP address and global options selected. During reset all LEDs glow green. When reset is complete, the 
LEDs return to their normal state.

Rear Panel Ports and Connectors
The rear panel contains power plugs, plus video and network connector ports.

Figure 2–5. Pipeline Quad rear panel

When connecting video equipment, Ethernet, and RS-422 cables, be sure that the power supply is 
disconnected from the Pipeline. Failure to do so may result in equipment malfunction or damage.

AC Power Plugs. Use to connect and turn on the Pipeline. Only connect the Pipeline Quad to power using 
the Telestream-supplied power cords. To insure fail-safe operation, be sure to use both power supplies. 
These supply common power to the Pipeline; if one power supply fails, the Pipeline continues to operate.

Note

Resetting factory defaults does not change the firmware or app loader versions.

Channel 3 reset

Channel 1 reset Factory defaults

Channel 2 reset Channel 4 reset

AC Power 
Connectors

SDI In (one per channel)

Gigabit
Ethernet

VTR RS-422
 (one per channel)

SDI Out (one per channel)Sync In/Out
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Sync In. The SDI Sync Input is used in both capture and playout modes, but for two different purposes. 

In capture mode, the SDI Sync Input is used as a method for supplying a common timecode reference to 
all input channels. For the timecode to be extracted, the SDI signal connected to the SDI Sync Input must 
contain a valid timecode in the ancillary data area of the signal. The SDI signal must be a digital signal that 
is frame-synchronized with any SDI signals used as video sources connected to each channel’s input. An 
analog signal cannot be connected to the SDI Sync input.

In playout mode, the SDI Sync Input is used as a frame-synchronization source for each channel’s SDI 
outputs. Any timecode on the SDI Sync Input is ignored in this mode. If no signal is connected to the SDI 
Sync Input, each channel’s SDI output will free run (they will not be synchronized with each other or with 
any common reference). 

Sync Out. Re-clocked loop-through port of SDI Sync In. You can use this re-clocked reference for 
additional Pipelines or other devices.

RS-422. Female DB-9 (9-pin D-connector) RS-422 port for VTR (one per channel).

SDI In. BNC jack for SDI input (one per channel).

SDI Out. BNC jack for SDI output (one per channel).

Gigabit Ethernet Port. The Ethernet RJ-45 jack has two LEDs: If the left, orange LED is lit and the right, 
green LED is lit, the port is operating at 1Gbs (gigabit). If only the orange LED is lit, the Ethernet port is not 

Note

Pipeline does not support any analog (bi-level or tri-level) reference. Do not attempt to 
use any form of analog reference with Pipeline.

Pin # Function

1 GND

2 RX-

3 TX+

4 GND

5 No Connection

6 GND

7 RX+

8 TX-

9 GND

WARNING

SDI-OUT is intended to be used for monitoring of the looped SDI-IN input source 
and should not be used to distribute this source to additional capture channels. 
Do not connect the looped SDI-OUT signal into any other Pipeline SDI-IN port. 
This may cause unintended capture interruptions on the channel connected to 
the looped source.
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connected. Be sure to use CAT-6 cabling end-to-end from Pipeline to your Macintosh or Windows PC 
client for best results.

PIPELINE HD DUAL HARDWARE

The Pipeline HD Dual is 17.3 inches (43.9 cm) wide, 13.2 inches (33.5 cm) deep, and 1.5 inches (3.8 cm) 
high. Pipeline HD Dual is a single rack unit device with two onboard HD/SD-SDI encoder/decoder devices 
equipped with two external Gigabit Ethernet ports. It uses TCP/IP, UDP, RTSP, and RTP and Bonjour for 
service discovery. Serial Digital Interfaces are provided for each device (BNC, SMPTE-259M 270mb/sec) 
with 2 SDI in and out ports (per HD Dual), each supporting up to 16 channels of embedded audio, with 
automatic input format detection. It also provides RS-422 deck control ports using Sony 9-Pin Protocol.

Pipeline HD Dual can encode DV/DVCPRO 25/50, IMX 30|40|50, MPEG-2 50M I-frame (FlipFactory 
workflows) MJPEG, ProRes HQ/SQ/LT/Proxy, Avid DNxHD and DVCProHD video, and 48 KHz, 16/24 bit, 
uncompressed audio.

The Pipeline Quad and HD Dual provides dual power supplies for redundancy and fail-safe operation. 
Telestream highly recommends that both power supplies be connected during operations. Pipeline can 
operate normally on a single power supply, however you will lose the redundant safety of the second 
power supply.

Using SDI Sync Input
The SDI Sync Input is used in both capture and playout modes, but for two different purposes. 

In capture mode, the SDI Sync Input is used as a method for supplying a common timecode reference to 
all input channels. For the timecode to be extracted, the SDI signal connected to the SDI Sync Input must 
contain a valid timecode in the ancillary data area of the signal. The SDI signal must be a digital signal that 
is frame synchronized with the SDI signals used as input video sources connected to each channel's input. 
An analog sync/reference signal, such as bi-level or tri-level, cannot be connected to the SDI Sync input.

In playout mode, the SDI Sync Input is used as a frame synchronization source for each channel's SDI 
outputs. Any timecode on the SDI Sync Input is ignored in this mode. If no signal is connected to the SDI 
Sync Input, each channel's SDI output will be frame synchronized to the video input. If no video input is 
connected, each channel's SDI output will free run. This means they will not be synchronized with each 
other or with any common reference. An analog sync/reference signal, such as bi-level or tri-level, cannot 
be connected to the SDI Sync input.

Caution

If only the green LED is lit or the LED is unlit, the Pipeline is operating at 100 or 
10 Mb respectively. These data rates are unacceptable for real time video traffic 
from all four channels. Resolve the problem by connecting at 1 Gbs before 
processing jobs to avoid data loss.

Note

The Sync Input signal must match the intended video output signal's frame size, frame 
rate and line scan (interlaced or progressive) modes.
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Using SDI Sync Out
Re-clocked loop-through port of SDI Sync In. You can use this re-clocked reference for additional Pipelines 
or other devices. This output is only active when the Pipeline device is powered up and is in an operational 
state.

Processing Closed Caption and Timecode Data
Pipeline automatically processes Ancillary Data on ingest operations to obtain closed captions and 
timecode data. Pipeline encodes the closed caption and timecode data into the data stream of the digital 
output, making it available for further processing by client applications, such as FlipFactory and Episode.

When a Standard Definition SDI signal is connected, the Pipeline automatically analyzes the signal during 
the Vertical Blanking Interval (VBI) on ingest operations to obtain closed captions and timecode data. 
Closed caption data is extracted from line 21, and timecode data from lines 16 through 20 (the 5 lines 
beginning with line 16). The last line (usually line 20) with a valid timecode is the line whose data is used.

When an HD SDI signal is connected, the Pipeline automatically processes all ancillary data packets to 
obtain closed captions and timecode data. Closed caption data is extracted from Ancillary data packets 
with a DID of 0x161 and timecode data is extracted from Ancillary data packets with a DID of 0x260.

Front Panel Indicators
The front panel contains LED indicators, making it easy to check its status.

Figure 2–6. Pipeline HD Dual front panel

SDI In. One per channel. Lights green continuously when an HD source is connected. Flashes green when 
an SD source is connected. If the LED flashes orange, data is being lost. The problem should be corrected 
before continuing operation.

SDI Out. One per channel. Lights green continuously when HD format media is being output. Flashes 
green when SD format media is being output. If the LED lights orange, data is being lost. The problem 
should be corrected before continuing operation.

Mode. Lights green continuously when the selected codec is creating HD content. Flashes green when the 
selected codec is creating SD content.

Reference. Lights green continuously when an HD source signal is detected on the sync input reference 
channel. Flashes green when the source signal is SD.

Sync. Lights green when an HD source signal is detected on the sync input reference channel. Flashes 
green when the source signal is SD.

LAN. Flashes green to indicate LAN activity.

PWR 1 & 2. Lights green when power is present and the power supply is operating normally. PWR1 
indicates power supply 1; PWR2 indicates power supply 2. Orange indicates a failed power supply or that 

Power 1 & 2 LEDsIn LED (1 per channel)

Reference LED

Out LED (1 per channel) LAN LED
Mode LED
178027



Chapter 2
Pipeline Hardware, Installation & Setup

16
power is not present. If a power supply fails, complete jobs in progress and RMA the Pipeline to 
Telestream for repair as soon as practical.

Front Panel Reset Switches
With the front panel bezel removed, three recessed reset buttons are exposed. They are not labeled.

Figure 2–7. Pipeline HD Dual reset switches behind front panel

Channel 1 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 1. The channel will be disconnected from any client currently attached.

Channel 2 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 2. The channel will be disconnected from any client currently attached.

Factory Default Reset. Insert a pointed object to depress the recessed button to restore the factory 
defaults of the Pipeline device. Both channels are returned to their original factory default values, including 
IP address and global options selected. During reset all LEDs glow green. When reset is complete, the 
LEDs return to their normal state.

Rear Panel Ports and Connectors
The rear panel contains power plugs, plus video and network connector ports.

Figure 2–8. Pipeline HD Dual rear panel

When connecting video equipment, Ethernet, and RS-422 cables, be sure that the power supply is 
disconnected from the Pipeline. Failure to do so may result in equipment malfunction or damage.

Note

Resetting factory defaults does not change the firmware or app loader versions.

Channel 2 reset

Channel 1 reset Factory defaults

Unused Unused

AC Power Connectors

SDI In (one per channel)
Gigabit Ethernet
(one per channel)

VTR RS-422
 (one per channel) SDI Out (one per channel)

Sync In/Out
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AC Power Plugs. Use to connect and turn on the Pipeline. Only connect the Pipeline Quad to power using 
the Telestream-supplied power cords. To insure fail-safe operation, be sure to use both power supplies. 
These supply common power to the Pipeline; if one power supply fails, the Pipeline continues to operate.

Sync In. The SDI Sync Input is used in both capture and playout modes, but for two different purposes. 

In capture mode, the SDI Sync Input is used as a method for supplying a common timecode reference to 
all input channels. For the timecode to be extracted, the SDI signal connected to the SDI Sync Input must 
contain a valid timecode in the ancillary data area of the signal. The SDI signal must be a digital signal that 
is frame-synchronized with any SDI signals used as video sources connected to each channel’s input. An 
analog signal cannot be connected to the SDI Sync input.

In playout mode, the SDI Sync Input is used as a frame-synchronization source for each channel’s SDI 
outputs. Any timecode on the SDI Sync Input is ignored in this mode. If no signal is connected to the SDI 
Sync Input, each channel’s SDI output will free run (they will not be synchronized with each other or with 
any common reference).

 

Sync Out. Re-clocked loop-through port of SDI Sync In. Use for additional Pipelines or other devices.

RS-422. Female DB-9 (9-pin D-connector) RS-422 port for VTR (one per channel).

SDI In. BNC jack for SD-SDI or HD-SDI input (one per channel).

SDI Out. BNC jack for SD-SDI or HD-SDI output (one per channel).

Note

Pipeline does not support any analog (bi-level or tri-level) reference. Do not attempt to 
use any form of analog reference with Pipeline.

Pin # Function

1 GND

2 RX-

3 TX+

4 GND

5 No Connection

6 GND

7 RX+

8 TX-

9 GND

WARNING

SDI-OUT is intended to be used for monitoring of the looped SDI-IN input source 
and should not be used to distribute this source to additional capture channels. 
Do not connect the looped SDI-OUT signal into any other Pipeline SDI-IN port. 
This may cause unintended capture interruptions on the channel connected to 
the looped source.
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Gigabit Ethernet Ports. Each Ethernet RJ-45 jack has two LEDs: If the left, orange LED is lit and the 
right, green LED is lit, the port is operating at 1Gbs (gigabit). If only the orange LED is lit, the Ethernet port 
is not connected. Be sure to use CAT-6 cabling end-to-end from Pipeline to your Macintosh or Windows 
PC client for best results.

Caution

If only the green LED is lit or the LED is unlit, the Pipeline is operating at 100MB 
or less – rates unacceptable for real time video on all four channels. Resolve the 
problem by connecting at 1 Gb/sec. before processing jobs to avoid data loss.
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CONNECTING PIPELINE TO MAC OS X OR WINDOWS 
COMPUTERS

Pipeline can be connected to a Mac OS X computer – a Final Cut Pro workstation or Episode Engine 
server, for example. Or, it can be connected to a Windows computer – a FlipFactory server or Pipeline 
Control workstation, for example. You can connect Pipelines directly or via LAN using a Gigabit Ethernet 
(Gig-E) switch for Pipeline Quad|HD Dual or 100MB Ethernet for Pipeline SC.

Note

For workstations or servers with multiple network adapters, you should always connect 
the Pipeline (or switch) to the second interface on the system (Windows: Local Area 
Connection 2, Mac OS X: en1).

If you are not able to connect to Pipelines using this configuration you may have 
devices on your first network using the same address scheme as your Pipelines. To 
correct this, run the following commands in a command window (verify with your 
network administrator). 

This example is for modifying your system's routing table for a Pipeline configuration 
using the default 169.254.xxx.xxx self-assigned address scheme. Modify these 
commands accordingly for your configuration:

Mac OS X:

To remove:
sudo route delete -net 169.254.0.0/16

To add it back to en1:
sudo route add -net 169.254.0.0/16 -interface en1

Windows:

When Pipeline Control discovers Pipelines on the network, it records the Network 
Interface Card (NIC) that the Pipeline responded on. The computer's routing tables are 
then examined to see if a valid route is available to the Pipeline Control application on 
which to communicate. If a valid route is not found then Update Route is displayed. 
Click Update Route to add a valid entry into the computer's routing table.

Click R to refresh status. A green bullet icon indicates that this Pipeline is available. A 
red bullet indicates that it is currently busy (connected to another client application). 
Gray indicates offline; yellow indicates an unknown state. To enable you to select a 
Pipeline to set up a document for use later, you can select a Pipeline regardless of its 
state. This dialog reports the Pipeline's current status (idle, capturing, recording, 
unknown), name, input source, firmware version, device type (SD or HD) and system 
NIC connection.

If any type of Bonjour is installed, the R icon is greyed out and the refresh functionality 
is not available.

Click 
Update 
Route

Click R
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Use the instructions in this section to make Ethernet and video connections to your Pipeline when 
connecting it to a Mac OS X or Windows computer – either directly or via a switch.

Figure 2–9. Pipeline video, VTR & network connections

1. Make sure the Pipeline is not plugged in.

2. Connect the Pipeline Ethernet port directly, or via a switch, to the computer with an Ethernet cable. (A 
crossover cable may be required for direct connections with some NICs.)

3. Connect your VTR SDI Out port to the Pipeline SDI In port with a BNC coax cable connected to your 
video source – a VTR, for example.

4. (Optional) Connect the VTR RS-422 port to the Pipeline RS-422 port.

5. (Pipeline Quad/HD – Optional) Connect video equipment to your Sync In and Sync Out video ports.

ADDING PIPELINE TO A NETWORK

One or more Pipelines can connect to a LAN. To assure acceptable performance, be sure to connect 
Pipelines to a media network or a single Gigabit switch dedicated specifically for Pipelines, edit stations, 
and media servers. If you connect to a backbone, ensure it is Gigabit, to handle the real-time traffic. Make 
certain that switches do not have a firewall, and that TCP and UDP ports 7000/7002 (video), 7004/7006 
(audio), 7008/7010 (status), 554 (RTSP), and 80 (http) are open.

Each Pipeline channel is assigned a unique, automatically assigned, link-local IP address in the range 
169.254.1.0 to 169.254.255.255, so that it can communicate directly with your computer without a 
gateway. Each of the Pipelines (channels) in a Pipeline HD Dual and Pipeline Quad is assigned an 
incremental IP address.

You can also set up the Pipeline with a static address. Make IP address modifications with Pipeline 
Administrator, a Web application built into each Pipeline (Using the Configure Panel on page 44).

WARNING

Do not enable Windows or Internet Explorer Proxy server on a Pipeline System 
host machine. This may cause various network and performance issues related 
to the Pipeline Control application.

Ethernet

RS-422
VTR Control

SDI
Video/Audio

Ethernet

RS-422
VTR Control

SDI
Video/Audio
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Use these instructions to make power, Ethernet, and video connections to one or more Pipelines when 
connecting it to a LAN where FlipFactory server or Final Cut Pro editing stations are located.

Figure 2–10. Pipeline video, VTR control & network LAN connections

1. Make sure the Pipeline is not plugged in.

2. Connect the Pipeline Ethernet port to a network switch with an Ethernet cable on the same LAN as 
your Final Cut Pro editing station or FlipFactory server.

3. Connect each Pipeline SDI IN port to an SDI source such as your VTR or SDI router with a BNC cable.

4. (Optional) Connect each Pipeline’s RS-422 port to an RS-422 control, such as your VTR.

5. (Pipeline Quad and HD Dual – Optional) Connect video equipment to your Sync In and Sync Out video 
ports.

POWERING UP THE PIPELINE

For Pipeline SC, plug the Telestream-supplied power adapter jack into the power port on the rear panel, 
and then connect the power cord to an AC source (or power converter) to power the Pipeline on.

For Pipeline HD Dual and Pipeline Quad (with redundant power supplies) plug both Telestream-supplied 
power cords into the power plugs on the rear panel, and then connect each power cord to an AC source (or 
power converter) to power the Pipeline on.

CONFIGURING & CONNECTING TO PIPELINES

As with other network devices, each Pipeline has a fixed MAC address and a default IP address, which 
you can change. Before using Pipeline, you’ll need to contact your IT administrator (especially when 
connecting to a LAN) to determine which IP address and net mask to use for each Pipeline and how to set 
it up (automatic link-local, DHCP F/W v2.4 or earlier, or static), based on your facility’s network address 
policy.

Note

Do not enable Windows or Internet Explorer Proxy server on a Pipeline System host 
machine. This may cause various network and performance issues related to the 
Pipeline Control application.

RS-422
VTR Control

SDI
Video/Audio

100MB
Ethernet

RS-422
VTR Control

SDI
Video/Audio

GigaBit Ethernet Backbone100MB
Ethernet
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Configuring Pipeline Network Settings
To view and modify the Pipeline’s network configuration, log on and display the Configure panel (click 
Configure in the toolbar at the top of Pipeline Administrator). See Using the Configure Panel on page 44.

After plugging the Pipeline into the network and powering it on, you can connect to Pipeline via Bonjour, or 
you can use the Pipeline’s default IP address.

When you connect, Pipeline Administrator displays in your browser. For details on using Pipeline 
Administrator, see Chapter 5, Using Pipeline Administrator on page 41. 

REGISTERING YOUR PIPELINE WITH TELESTREAM

When the Pipeline is operational and you can connect via Pipeline Administrator, register the Pipeline with 
Telestream – display the About panel and click the Register button. Follow the steps on the Web page to 
complete registration.

If the computer you’re using is on a LAN without Internet access, use a computer that has Internet access 
and go to dynamic.telestream.net/pipeline-register/register.asp to register your Pipeline. You should 
register your Pipeline to ensure ongoing warranty service and customer service, per the terms of service.

Note

In the unlikely event that you can’t connect, try these steps:

Make sure the Pipeline is connected to a switch on your LAN and powered on, and the 
Power LED on the front is lit.

Ping the Pipeline using the IP address. If you can’t ping it, there may be an IP address 
conflict, causing Pipeline to use a secondary address. Unplug the Pipeline and connect 
the Pipeline directly to a computer via an Ethernet cable, plug it in and ping it again.

If you’re connected directly to a computer, but can’t ping it, you may be using a standard 
Ethernet cable, but due to computer limitations, you need to use a cross-over cable.

If you can ping the Pipeline but still can’t connect, you may have a firewall blocking the 
connection.

See Appendix A, TroubleShooting, for assistance.
December 2015
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I n s ta l l i n g  P i p e l i n e
S o f t w a r e
Chapter 3, Installing Pipeline Software

Use this chapter to install, upgrade, or uninstall Pipeline software.

Topics

 Installing Pipeline Software (page 23)

 Upgrading Pipeline Software (page 24)

 Removing Pipeline Software (page 24)

INSTALLING PIPELINE SOFTWARE

Pipeline Control for Windows is distributed from Telestream’s Web site (www.telestream.net) as an EXE 
file, and is also distributed on the Pipeline CD. After verifying that you have all of the required subsystems 
(below), download or open the installer and run it. Follow the steps to install Pipeline Control for Windows.

Notes

Telestream recommends that Pipeline Control be installed on a computer that is not 
hosting FlipFactory, Vantage, Agility, Episode Engine, or other media processing 
applications: intense disk and CPU consumption can interfere with proper operation of 
both applications.

Be sure to review your platform, system and workflow requirements before installing 
Pipeline software (Chapter 4, Implementing Pipeline Workflows on page 25). When 
you install or upgrade Pipeline client software, you may have to upgrade the firmware 
revision in your Pipeline hardware.

Pipeline Control software captures data coming from one or more Pipeline channels, 
and write this data to disk in real-time. To prevent interference with the Pipeline 
Control, any process (such as real-time anti-virus scanning) should be disabled while 
Pipeline Control is in use. Other processes that periodically run (such as operating 
updates) should also be disabled.

Note

Pipeline Control requires local Admin privileges for installation.

http://www.telestream.net
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UPGRADING PIPELINE SOFTWARE

Pipeline software upgrades are periodically posted on the Telestream Web site at www.telestream.net. On 
the Telestream site, click Support > Support Home, then select Pipeline under the Pipeline section – 
Pipeline software updates are displayed in the left column.

Before running the installer, be sure to remove the previous version of Pipeline, using Add/Remove 
Programs in Control Panels. Then, follow the instructions in Installing Pipeline Software (above) to upgrade 
your Pipeline software.

REMOVING PIPELINE SOFTWARE

To uninstall Pipeline Control, display Control Panel > Add/Remove programs (Programs and Features in 
Windows 7). Select Pipeline Control and click Remove. Removing the Pipeline application does not 
remove any schedules you’ve made, or any media you’ve saved on the computer from which you are 
removing Pipeline Control.
December 2015
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C H A P T E R 4

I m p l e m e n t i n g  P i p e l i n e
W o r k f l o w s
Chapter 4, Implementing Pipeline Workflows

To implement Pipeline workflows, which capture or play out media on Mac OS X or Windows, you’ll need to 
install Pipeline software. Use this chapter to determine your workflow and system requirements, and to 
install, update, or uninstall Pipeline software.

Topics

 Pipeline Application Feature Comparison (page 25)

 Workflow System Requirements (page 27)

 General Pipeline System Setup Information (page 27)

 Disk Buffering Details (page 36)

 Disk and Network Requirement by Media Format (page 38)

PIPELINE APPLICATION FEATURE COMPARISON

Pipeline software includes two applications – Pipeline Control and Pipeline Plugin for Episode and Final 
Cut Pro, compared below.

Note

Telestream recommends that you only install Pipeline Control on a computer that is not 
hosting FlipFactory, Vantage, Agility, Episode Engine, or other media processing 
applications: intense disk and CPU consumption can interfere with proper operation of 
both applications.

When you install or update Pipeline client software, you may have to upgrade the 
firmware revision in your Pipeline hardware.

Note

If you haven’t installed the Pipeline yet, proceed to Chapter 2, Pipeline Hardware, 
Installation & Setup on page 5 before continuing.

Before you use a Pipeline to capture and play out media, the device must be 
configured using Pipeline Administrator (Chapter 5, Using Pipeline Administrator on 
page 42).
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Pipeline Control.  Pipeline Control is available for Mac OS X Snow Leopard, Windows 2008 Server, and 
Windows 7. You can use Pipeline Control to capture or play out media from/to Pipeline SC, Pipeline Quad, 
and Pipeline HD Dual.

Pipeline Plugin for Final Cut Pro and Episode | Episode Pro. The feature set of Telestream's Pipeline 
applications vary by platform, and by program type - application or plugin. The following table identifies the 
features implemented in each Pipeline program:

Table 4–1. Feature comparison of Pipeline client applications

Pipeline Software Features Pipeline Control
(Windows)

Pipeline Control
(Mac OS X)

Pipeline 
Log & 
Capture 
Plugin

Supports Pipeline HD Dual   
Supports Pipeline SC and Pipeline Quad   
24-hour recurring record  
24-hour recurring playout 
Log & Capture with deck control   
Triggered manual and automated capture  
Print to Tape – Insert Edit   
Print to Tape – Assemble Edit   
Print to Tape – Crash Playout   
Web Service API  
Open directly from Final Cut Pro 
Open directly from Episode Desktop 
Edit while capturing  
Transcode while capturing
(FlipFactory|Episode Engine)

 

Import Pipeline G4G EDL files   

Import|Export Final Cut Interchange files   

Create QuickTime Open files directly  

Create QuickTime Closed files directly   

Create TIFO files directly  

Controlled Playout (Virtual VTR) 

Video Wall 

Create Avid AAF/MXF OPAtom files directly  

Create Generic MXF DNxHDOP1a files with
with DV|DVCPro|IMX video essence

 
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Pipeline Log and Capture Plugin

You can install the Pipeline Plugin in Final Cut Pro Version 5.01 or later, and you can install it in Episode 
v5.x (this plug-in is not compatible with Episode v6).

When you install the plugin, you can use all of the Pipeline features listed in the table above. For complete 
details, Using Pipeline in Final Cut Pro & Episode on page 63.

WORKFLOW SYSTEM REQUIREMENTS

Pipeline applications can be used with these versions of FlipFactory, Vantage, Episode, and Final Cut Pro:

• FlipFactory 6.0 with Service Pack 5, FlipFactory 6.1, 7.0 and 7.1.

• Episode Engine version 5.0 or greater

• Final Cut Pro Version 5.1.4 or newer

• Vantage 1.0 or later

GENERAL PIPELINE SYSTEM SETUP INFORMATION

Pipeline is a unique, network-attached encoder that can be used in a variety of capture and playout 
workflows. As a network device, architectural constraints figure prominently in configuring an efficient and 
reliable Pipeline workflow.

Pipeline System Architecture

Pipeline capture workflows consist of ingesting baseband HD/SD-SDI input, compressing it, creating a file 
with the compressed data, and delivering the completed file to a folder location. You can connect one or 
more Pipelines (Single, Quad, or HD Dual) to a Pipeline host computer (Mac OS X or Windows).

Pipelines should be connected directly via CAT6 Ethernet to a Pipeline host computer or via an enterprise 
class, fully non-blocking, professional-quality Ethernet switch. 

The key components include the Pipeline device itself, the network, the Pipeline host computer, the 
Pipeline Control application, software and the Pipeline media disk storage device. Each of these 
components is described below. 

The Pipeline Device

Each Pipeline has one to four channels each (single channel, Quad or HD Dual) with SDI I/O for capture 
and play out. The SDI connectors ingest baseband SD/HD-SDI signals, compress them into one of many 
supported formats and stream the compressed data out their respective Ethernet ports using Real Time 
Streaming Protocol (RTSP). Each channel's RTSP stream contains video, audio and application/control 
data in RTP transport packets. These streams are ingested by the Pipeline Control application running on 
a Pipeline host computer.
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Pipeline Host & Pipeline Application Software

The Pipeline Control wraps each RTSP stream into the appropriate file wrapper and delivers these files to 
their respective media storage locations. The Pipeline host computer is primarily responsible for delivering 
one or more Pipeline channel's RTSP streams via Ethernet to the Pipeline application it is hosting.

A Pipeline host computer can control multiple Pipeline channels concurrently. See the examples below to 
determine how best to configure a Pipeline System to meet your particular needs.

Pipeline applications, such as Pipeline Control, perform many tasks. These tasks include scheduled 
capture and play out, log/capture from tape sources, manual and automated capture from live sources, 
print to tape, and controlled playout.

Pipeline applications also provide interfaces to (or within) video edit software, FlipFactory, Vantage, Agility, 
Episode Engine, Episode desktop, and disk file systems.

There are five key factors to consider when configuring your Pipeline host system:

• CPU cores and speed

• Disk storage systems (both for the media destination and for disk buffering)

• Network connection 

• System RAM

• System Video Card

Use the system descriptions, recommended systems chart, and network and storage sections to configure 
your Pipeline host system appropriately for your workflow requirements.

Pipeline Network

For best results, Pipelines should be connected directly to a Pipeline host computer or via a single 
enterprise class, fully non-blocking professional-quality Ethernet switch via CAT6 Ethernet cabling. Multiple 
hops via routers and switches increase the risk that video frames will not be processed in a timely manner 
resulting in lost frames. It is highly recommended that the Pipeline host's network adapter be based on 
Intel Gigabit cards.

Capturing across multiple switches or routers is possible with Pipeline only when the link is a full 1 gigabit. 
Always consult with your network administrator when attempting to utilize Pipeline across multiple 
switches, networks or VLAN's.

Recommended network switches:

• Extreme Networks

• Force 10, Cisco

• Foundry (Brocade)

Use of a private Pipeline video VLAN is highly recommended.

Special care must be taken to insure that Pipeline real-time processes can be achieved. To ensure reliable 
Pipeline performance, Pipeline must be on a dedicated media network. Operating on a general information 
network will expose Pipeline to network processes that can consume unbounded bandwidth and excessive 
network stack cycles which can cause Pipeline real-time streams to be interrupted. These interruptions 
can cause Pipeline to become unstable and stop operating.

• Pipeline Encoders and Pipeline Control host machines should not be connected to a general informa-
tion network. If operating Pipeline on a general information network the recommended procedure is to 
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reboot Pipeline once per week (every seven days) as part of your standard system maintenance. Not 
doing this recommended procedure may cause Pipeline to stop operating.

• If Pipeline is operating on a dedicated media network with adequate bandwidth there is no need to per-
form the recommended weekly reboot procedure.

• The Pipeline Control host machines should be dedicated to running Pipeline Control and should not 
have other applications or services installed.

The best practice is to separate Pipeline traffic from data traffic by using more than one network adapter 
within the Pipeline host computer. Design your system with one (or more) Ethernet ports dedicated to the 
incoming Pipeline streams and separate Ethernet port(s) for general data and media delivery traffic. 

As a rule of thumb, never exceed 50% usage of any one Ethernet port or network switch. For example 
when capturing Pro Res 422 HQ at 220Mbps use one GigE Ethernet port for every two (2) streams. 
Multiple port Ethernet is required for this purpose.

Network examples

Figure 4–1. Eight channel Pipeline SD capture system

Figure 4–2. Four channel Pipeline HD capture system
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Capture-only Workflows

For capture-only workflows, when writing to internal or direct attached (non-shared) RAID arrays, you only 
need to calculate the overall write speed requirements. Configure your media storage array based on the 
write performance required for the number of streams being captured.

Figure 4–3. Configuration for capturing 4 HD streams onto Fibre-attached storage.

Concurrent Edit/Transcode Workflows

For capture with concurrent edit or transcode workflows, calculate the total read/write speed requirements 
based on the write processes of Pipeline streams and read processes for edit and transcode operations. 

To guarantee error-free operations when writing to NAS, you must use disk buffering. Use an internal or 
direct-attached non-shared RAID array that meets the read/write performance requirement (Disk Buffering 
Details on page 36). 

Pipeline's media storage location (NAS, direct-attached shared storage, or shared network folder) must 
also meet certain read/write performance requirements. When using NAS, direct-attached shared storage 
or shared network folder, be sure to verify that your system has the communications bandwidth for writing 
all Pipeline media data to the media storage location in real-time.

For SD, Telestream recommends that the host's disk storage system provide and maintain a sustained 10 
MB/sec. transfer rate per stream from the Pipeline host computer to the media disk (read/write). 

For DVCPro HD, ProRes 422/SQ/LT/Proxy and standard quality DNxHD, Telestream recommends that the 
Pipeline host's disk storage system provide and maintain a sustained 40 MB/sec. transfer rate per stream 
from the Pipeline host computer to media disk (read/write). For ProRes 422 HQ and high quality DNxHD, 
Telestream recommends at least a 50 MB/second sustained transfer rate.

Note

Disk buffering is required when the destination path is located on a NAS, shared 
network folder, or when edit/transcode while capture operations are to be performed on 
the incoming Pipeline media files.

Some format wrappers do not support this feature. Take special care when writing 
these file types to shared disks.
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Capture Workflows Utilizing NAS|Direct-Attach Storage|Network Folders

For capture writing to NAS, direct-attached shared storage or shared network folder, you should enable 
Pipeline disk buffering (Disk Buffering Details on page 36). 

Disk buffering requires a separate RAID array to guarantee error-free write operations of media streams. 

Figure 4–4. Configuration for capturing four HD streams onto NAS with Fibre-attached buffer.

When calculating disk buffer RAID array read/write performance requirements, you should use two times 
the required Pipeline streams write requirements. This is required to support a write and a read operation 
on the data buffer array for each Pipeline stream. 

The Pipeline's media storage location (NAS, direct-attached shared storage or shared network folder) 
must meet the write performance requirements. When using NAS, direct-attached shared storage or 
shared network folder, be sure to verify that your system has the communications bandwidth for writing all 
Pipeline media data to the media storage location in real-time.

Note

Disk buffering is required when the destination path is located on a NAS, a shared 
network folder, or when edit/transcode while capture operations are to be performed on 
the incoming Pipeline media files.

Some format wrappers do not support this feature. Take special care when writing 
these file types to shared disks.

Caution

Capturing video is a disk intensive operation. It is important that you create a 
system with adequate disk performance for writing and reading real-time video 
files. In addition to the information provided below, make sure that the disks 
used for Pipeline operations are defragmented often. A fragmented drive can 
decrease performance and may cause capture and playout operations to fail.
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Pipeline Media Storage

In determining storage requirements, there are two main factors to consider – the overall sustained read/
write performance and local data disk buffering.

To ensure performance and quality, the disk storage systems used with the Pipeline host computer must 
be able to meet the demands of reading and writing one or more real-time SD and HD media streams.

For SD, Telestream recommends that the Pipeline host's disk storage system provide and maintain a 
sustained 10 MB/sec transfer rate per stream from the Pipeline host computer to the media disk (read/
write). 

For DVCPro HD, ProRes 422/SQ/LT/Proxy, and standard quality DNxHD, Telestream recommends that 
the Pipeline host's disk storage system provide and maintain a sustained 40 MB/sec transfer rate per 
stream from the Pipeline host computer to media disk (read/write) for each stream. For ProRes 422 HQ 
and high quality DNxHD, Telestream recommends at least a 50 MB/sec transfer rate for each stream. 

To evaluate your needs, first take into account the data rate for the format that you'll be using and the 
number of streams your system will be capturing concurrently. Disk and Network Requirement by Media 
Format on page 38 provides approximate data rates for a variety of formats and resolutions. Use these 
tables to calculate the overall read/write performance requirements for your main storage disk system and 
if needed for your local data buffering storage disk system.

Capture-only, writing to internal or direct-attached RAID array. For systems utilizing internal or direct 
attached (non-shared) storage for capture only operations, you only need to calculate the overall write 
speed requirements. Configure your media storage array based on the write performance requirement for 
the number of streams being captured.

Figure 4–5. Four channel Pipeline HD with direct attached Fibre RAID storage

Capture with concurrent edit or transcode. For systems that are capturing with concurrent edit or 
transcode operations, you should calculate the overall read/write speed requirements based on the write 
processes of Pipeline streams, and the read processes for the edit and transcode operations. To 
guarantee error-free operations you must use Pipeline's data buffering feature utilizing an internal or direct 
attached non-shared storage RAID array for data buffering that meets the desired read/write performance 
requirement (see Disk Buffering Details on page 36). The Pipeline's media storage location (NAS, direct 
attached shared storage or shared network folder) must also meet these minimum read/write performance 
requirements. When using NAS, direct attached shared storage or shared network folder, be sure to verify 
that your system has the communications bandwidth for writing all Pipeline media data to the media 
storage location in real-time.
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Capture writing to NAS, direct attached shared storage or shared network folder. For systems that 
are capturing media written to a NAS or shared network folder, the Pipeline data buffering feature must be 
enabled (see Disk Buffering Details on page 36). Data Buffering requires a separate data buffer RAID array 
to guarantee error-free write operations of Pipeline media streams. Calculating the disk buffer RAID array 
read/write performance requirements use 2X the required Pipeline streams write requirements. This is 
needed to support a write and a read operation on the data buffer array for each Pipeline stream. 

The Pipeline's media storage location (NAS, direct attached shared storage or shared network folder) must 
meet the minimum write performance requirements. When using NAS, direct attached shared storage or 
shared network folder, be sure to verify that your system has the communications bandwidth for writing all 
Pipeline media data to the media storage location in real-time.

Figure 4–6. Four channel Pipeline HD with direct attached data buffer RAID

Example Systems

Distributed Pipeline model. Individual workstations controlling individual channels, each workstation 
meeting the Pipeline channel specification with a network to support all traffic:
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Centralized Pipeline ingest model. A central workstation controlling multiple Pipeline channels. The 
central workstation meets the multiple Pipeline channel specification with a network and storage system to 
support the workflow:

Four channel HD with data buffering. Four channels of HD hosted by a central workstation with delivery 
to a NAS. Data Buffering is enabled through directly attached RAID storage:
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Multiple channel Transcode while capture. Multiple Pipeline channels hosted by a central workstation 
with delivery to a directly attached storage device. The storage is shared to the transcoding servers for 
concurrent processing:

Multiple channel edit while capture. Multiple Pipeline channels hosted by a central workstation with 
delivery to shared storage device. Internal 15K RAID array is used as a Disk Buffer in case the shared 
storage cannot maintain real time writes:
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DISK BUFFERING DETAILS

When Disk Buffering is checked, video and audio data are written into a FIFO disk buffer file in a local 
folder before the data is written to the media file destination.

Figure 4–7. FIFO disk buffering enhances file writing performance

Disk buffering prevents the RAM buffer from overflowing when disk writes are temporarily blocked or 
performance is reduced on the media file destination disk.

The read/write performance for a volume used for disk buffering needs to be able to support the media 
format and number of channels being captured. As a rule of thumb, the buffer disk should be RAID-0 with 
the appropriate number of drives to support the read and write requirements for the number of channels 
with the respective media format used (Disk and Network Requirement by Media Format (page 38)).

Enable Disk Buffering whenever your media file destination is not a local drive or array – such as a NAS, or 
shared network folder.

Figure 4–8. Pipeline buffering process

 

Note

Disk Buffering must be enabled when the destination path is a located on a NAS, a 
shared network folder, or when edit/transcode while capture operations are to be 
performed on the incoming Pipeline media files.

During capture operations, when the file destination drive's performance is reduced 
due to additional read processes (when performing transcoding, file editing or other 
disk-intensive activity), data is placed into the FIFO (First In, First Out) buffer.

Note

The disk used for buffering should be used exclusively for Pipeline buffering. Using the 
disk buffer drive for other read/write processes may cause unpredictable results.

Incoming media 
stream

RAM buffer Disk buffer

Pipeline Host Computer

Media file 
destination
system
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PLATFORM AND SYSTEM REQUIREMENTS

General Pipeline Host System Requirements

• Pipeline firmware v2.6 or later

• CPU: Intel Core 2 Duo, Intel Quad Core, or greater

• Operating System:

— Mac OS X Version 10.6 (Snow Leopard). Requires QuickTime Version 7.5.5 or newer 
with ProRes decoder component.

— Windows 7 Pro 64 bit, Windows Server 2008 R2. NET Framework v3.5 SP1
• Video card with minimum 256MB RAM (for Mac OS X - card must support Quartz Extreme/OpenGL 

accelerated surfaces and be attached to a compatible video display)
• GigE or faster Ethernet adapter

• Final Cut Pro Version 5.0.1 or newer is required when using Pipeline plug-in

System Requirements for FlipFactory Pipeline Workflows
FlipFactory supports workflows utilizing Pipeline SD systems.

• FlipFactory v6.0 with Update Packs 1-5 or FlipFactory v6.1

• Concurrent Pipeline ingest streams may vary depending on CPU and disk speeds

• Recommended server spec:

• Dual 2.3Ghz (or higher) Intel Quad Core CPU 

• Dedicated RAID-0 media storage

• 2GB RAM

Caution

The disk selected for buffering should be used exclusively for Pipeline video/
audio data buffering. Using the disk buffer drive for other read/write processes 
may cause unpredictable results.

Never write to a disk buffer that does not meet the minimum performance 
requirement for the number of channels and media format being captured. See 
Disk and Network Requirement by Media Format (page 38).

The disk buffering drive must never be the same as the media file destination 
drive. This will result in doubling the amount of read and writes operations to 
this drive and will severely degrade overall disk performance.

When schedule events are touching (one file stops and the other starts at the 
same moment) and there is a handle setting of more than zero, the amount of 
data being processed and written to disk doubles for the duration of the handle.

Double capturing may result in data loss in workflows on slow computers, or in 
workflows with multiple simultaneous ingests, since the application may be 
pushing the limits of CPU capacity or disk write speed.
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PIPELINE HOST COMPUTER RECOMMENDATIONS

Network and Hard Disk Performance Requirements (per stream)

Table 4–2. Disk and Network Requirement by Media Format

Recommended Hardware Systems.

General guidelines 

CPU

• Single or Dual channel systems: Dual Dual Core 2.3Ghz CPU or faster

• Three or Four channel systems: Dual Quad Core 2.3Ghz CPU or faster

• Four or Five channel: Dual Six Core 2.3Ghz CPU or faster

RAM: 4GB RAM per channel

Operating System: Check Telestream web site for the latest supported OS

Media Storage: Sustained read and/or write speeds (separate from OS drive)

• Capture only: 40MB/s per channel

• Play out only: 60MB/s per channel

• Transcode/Edit/Disk Buffering while Capture: 100MB/s per channel

CODECS
Disk 
Read/Write 
Mbps

Network 
Throughput 
Mbps

Storage (per hour)
Required for 
8-Channel Audio

SD Codecs

Motion JPEG A 0.75 8 5GB

DV/DVC Pro 4.4 35 15GB

IMX30 5.3 43 16GB

IMX40 7.0 56 20GB

IMX50/DVCPro50 8.3 67 25GB

ProRes422 SQ 7.3 58 21GB

Uncompressed 8-bit 422 22 175 80GB

HD Codecs 
(range based on codec and bit rate)

DVCPro HD 16.5 135 73GB

ProRes 422 HQ 10-36 62-240 50-100GB

DNxHD 10-36 62-240 50-100GB

Note

All systems assume media storage local (internal or direct attached) to the host system 
with adequate storage to support 24 hours of content at the chosen format, and drive 
array is less than 80% full without serious fragmentation.
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Note

Check the Pipeline Configuration and Setup Guide located on the Pipeline Support 
page http://www.telestream.net/telestream-support/pipeline/support.htm) for more 
details on system configuration and setup.

Edit while ingest and transcode while ingest workflows require increased disk I/O 
performance to support the additional read processes, and may require disk buffer 
cache drive system (see Pipeline User Guide disk buffering details). Viewing HD 
preview stream(s) can consume high levels of CPU which may cause dropped frames. 
It is recommended that preview be turned off during capture.
178027
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C H A P T E R 5

U s i n g  P i p e l i n e
A d m i n i s t r a t o r
Chapter 5, 

Pipeline Administrator is a Web application embedded in each Pipeline, which enables you to connect to 
Pipeline devices on your network with a Web browser.

You can use Pipeline Administrator to perform administrative tasks on the Pipeline, including network 
configuration and firmware upgrades.

Topics

 Supported Web Browsers (page 41)

 Launching Pipeline Administrator (page 42)

 Using Pipeline Administrator (page 41)

 Using the About Panel (page 43)

 Using the Configure Panel (page 44)

 Using the Quad Panel (page 50)

 Using the Counters Panel (page 53)

 Using the Upgrade Panel (page 55)

SUPPORTED WEB BROWSERS

You can configure Pipeline using your Browser of choice. However, you may need a plug-in for Bonjour if 
you want to discover Pipelines automatically.

Note

Web browsers are supported only on the platform specified. You may encounter 
situations where features may not function correctly in all cases. In particular when 
running Windows 7 or Windows Server 2008 with Internet Explorer, you may encounter 
security issues that prevent Pipeline Administrator from displaying correctly or from 
saving configuration changes. In these cases consult with your IT administrator to adjust 
the browser's security setting to allow Pipeline Administrator to run properly. 
Alternatively you can install another browser such as Mozilla Firefox or Google Chrome 
as your default.
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You can run Pipeline Administrator from anywhere on your network. You can run it directly on a Pipeline 
host system or any computer with visibility to the Pipeline device.

LAUNCHING PIPELINE ADMINISTRATOR

The Pipeline Administrator can be accessed through a web browser. To connect to a Pipeline and launch 
Pipeline Administrator perform one of the following steps:

• Using a known Pipeline channel IP address: Open a web browser and enter the IP Address in the 
browsers address bar.

• In Mac OS X: Open Safari and select Bookmarks > Show All Bookmarks. In the Collections panel, click 
Bonjour. From the list of available devices double-click the Pipeline you wish to connect to, to display 
Pipeline Administrator.

• In Windows: Open Pipeline Control and select any document type (Schedule, Log and Capture, Trig-
ger, Print-to-Tape or Controlled Playout). Select the Pipeline you wish to connect to from the Pipeline 
dropdown list. Open the Diagnostics panel and click on the Administer button. This will open the 
selected Pipeline's Administrator page in your default browser.

If this is the first time connecting to this Pipeline since starting the browser, and if the Pipeline is password-
protected (configure panel > Security), the browser displays a Pipeline Authentication dialog. Enter the 
username (always administrator) and a password (if you added one), and click OK to connect to the 
Pipeline and display Pipeline Administrator:

Figure 5–1. Connect dialog – enter your username and password to connect

USING PIPELINE ADMINISTRATOR

Pipeline Administrator has several panels you can use to perform various tasks:

 Using the About Panel – provides general information about Pipeline and registration.

 Using the Configure Panel – displays Pipeline and network settings, allows you to change network set-
tings and options.

 Using the Quad Panel – displays when connected to a Pipeline Quad, to control confidence monitoring.

 Using the Counters Panel – displays statistical information about Pipeline activity.

 Using the Upgrade Panel – enables you to upgrade the firmware and Pipeline Administrator.

Enter the username (administrator) and password if 
you added one, and click OK to connect.
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You can access the Pipeline User’s Guide (the document you are currently reading) from each panel by 
clicking the User’s Guide link at the bottom of each panel.

USING THE ABOUT PANEL

To display the About panel, click about in the menu bar at the top of the window:

Figure 5–2. The About panel displays a link to product registration.

Register the Pipeline by clicking the Register button. Follow the steps on the Web page to complete 
registration. If you’ve already registered this Pipeline, the Register button no longer displays.

If the computer you’re using is on a LAN without Internet access, use a computer that has Internet access 
and go to dynamic.telestream.net/pipeline-register/register.asp to register your Pipeline. You should 
register your Pipeline to ensure ongoing warranty service and customer support. 

The About panel – as well as the other panels – provides online access to the Pipeline User’s Guide (this 
document), by clicking the link in the lower left corner.
178027
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Using the Configure Panel
To display the Configure panel, click configure in the menu bar at the top of the window:

Figure 5–3. Configure panel displays details & allows you to change settings

SD Options

HD Options
December 2015
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Use the Configure panel to view and make changes to Pipeline’s identity, IP settings, and options. Click the 
LAN, Security, Options, and EDL toolbar to view their respective control panels, as shown in the callouts in 
the figure above. Each control is described in the following table:

Table 5–1. Configure Panel controls and descriptions.

Control Description

Pipeline Identity

Name Editable field. Default for Pipeline SC: Pipeline-XXXX, where XXXX is the 
serial number printed on the bottom of the Pipeline. 

Default for Pipeline Quad: PipelineQuadXXXX_N where N is the device 
number 1 through 4.
Default for Pipeline HD Dual: PipelineHDDual_XXXX_N where N is the 
device number 1 through 2.

To change the name, enter a new name, and click Save Changes. The 
name is updated in the Pipeline, and is reflected in the Bonjour panel. 
Limit: 255 characters.
If you enter a friendly name that already exists, Pipeline adds (1), (2,), as 
necessary to maintain uniqueness.
For best naming practices, you should identify the Pipeline model (SC or 
Quad), uniquely name it, and, in the case of the Quad, refer to the 
channel number. For example, PipelineQuad_Prod7_Channel2.

App (firmware version) Displays Pipeline’s firmware version number, composed of <Major 
Version>,<Minor Version><Build Number>,<Channel Number Identifier>. 
For example: 2,2,33165,00 indicates Version 2.2, Build 33165, channel 0. 
On Pipeline SC, the channel number ID is always 0. Upgrades are 
identified by major version and minor version numbers: 2.2, for example.

Loader (version) Displays Pipeline’s boot loader version number, composed of <Major 
Version>,<Minor Version><Build Number>,<Channel Number Identifier>.

CPLD Version CPLD chip version number on the Pipeline, for Telestream use.

FPGA FPGA chip version number on the Pipeline, for Telestream use.

Serial Number Four digit serial number of the device, not changeable.

LAN When changing the IP address, you should click Save Changes to 
update the Pipeline, then close Internet Explorer or Safari. Wait about 30 
seconds, then restart your Web browser and log back on. If you don’t, 
your Control application will behave incorrectly, and Pipeline 
Administrator will periodically display an error: “Can’t communicate with 
Pipeline”.

Self-Assigned Select to utilize the default link-local IP address, generated based on the 
Pipeline’s serial number; incremented on Pipeline 2, 3, and 4 on Quad.

Static Select to use the IP address, subnet mask, & gateway, entered manually. 

IP Address Enter the IP address assigned by your network administrator.

Mask Enter the subnet mask assigned by your network administrator.

Gateway Enter the gateway address provided by your network administrator.

Security
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Password Editable field. No password is assigned by default. (Username is always 
administrator.) Limited to 15 characters; standard HTTP password rules 
apply. May be empty to disable authentication.

Confirm Password Editable field. Enter second time to confirm.

Control Description
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Options

Default format when no 
input connected

Select the default format from the menu. On HD Pipelines, you can 
choose an SD NTSC|PAL or various HD 720|1080 profiles. On SC/Quad 
Pipelines, choose SD NTSC|PAL. If the channel boots with no SDI input it 
will default to the value specified here. If the channel is already running 
with SDI input, selecting this setting will do nothing until the next time it 
boots without SDI input. If the channel is already running with SDI input 
and the input is removed, selecting a setting and clicking the save button 
will set the channel to the selected format. 

Note: If play out of 1080PsF at 23.98/24fps is desired you must select 
1080psf@23.98.

Default to black if SDI not 
present (SD units) / Render 
black and silence if SDI not 
present (HD units)

Pipeline generates a test pattern when SDI input signal is not present. If 
this option is checked, the test pattern is a black frame. Otherwise, the 
generated test pattern is color bars. The pattern is generated in NTSC or 
PAL (or HD formats on HD Dual), based on the Pipeline mode. The last 
valid SDI signal sets the mode, unless there is no SDI present when it 
boots. In this case it reverts to the setting specified above. Audio is muted 
when this option is checked.

Ignore input discontinuities 
(SD units) / Continue 
capture even if input 
frames are lost (HD units)

Unchecked by default, to insure capture quality. Check when you do not 
want Pipeline to report missing/partial frames in input stream during 
capture. This is useful if, for example, you are capturing from a satellite 
feed or an unreliable SDI signal where errors occur more often and you 
do not want Pipeline to report an input error causing the capture session 
to abort the capture.

Disable loopback Prevents input SDI from being present on the output SDI during capture. 
Consider enabling when exporting (or capturing) to a deck and the deck 
complains about the reference signal.

Note: Due to hardware limitations it is never fully disabled. Even a small 
amount of signal causes some decks to complain. If this happens the 
user should physically remove either the SDI input or output (depending 
on capture or playout) from either the video source or the Pipeline.

Assume F2 dominant input 
(SD units) / Check if input 
video is F2 dominant (HD 
units)

When checked during encoding, Pipeline constructs a frame by using a 
field pair consisting of an F2 field followed temporally by an F1 field. This 
is in contrast to normal operation, which constructs a frame using a field 
pair consisting of an F1 field followed temporally by an F2 field.

Burn in Timecode (SD 
capture only)

When checked, Pipeline overlays the timecode it is using as its primary 
clock on the video image. This option applies for SD codecs only.

Remove VBI data before 
compression (SD units) / 
Replace VBI data with 
black before compression 
(HD units)

When checked, Pipeline strips each frame of VBI data, replacing it with 
black before passing it to the encoder for compression.

Capture uncompressed 
VBI lines (HD units only)

When checked, Pipeline passes the Uncompressed VBI data contained 
in an SD SDI signal to the control software to be included in appropriate 
output formats.

Control Description
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VANC playout from 
essence metadata (HD 
units only)

Check this option if you wish to play out the VANC data contained in the 
video essence of the file. This option overrides the play out of track based 
VANC metadata contained in QuickTime Closed Caption tracks or MXF 
SMPTE-436M packets.

Disable Bonjour (HD only) Check this option to disable all Bonjour communication on this Pipeline 
channel. The channel will no longer transmit or listen for Bonjour traffic. 
Use this option in conjunction with the Discovery Option within Pipeline 
Control for Windows (see Discovery Tab on page 86).

Prefilter Video (HD only) This option applies a softening filter to non-full raster codecs 
(DVCProHD, MJPEG, ProRes 1440). This option will apply an effect that 
will smooth sharp edges and can improve picture quality. Apply this filter 
if this effect is desired. Full raster codecs are not affected by this filter.

Control Description
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EDL

Use IP address instead of 
Pipeline name

Check when you want communication to utilize the IP address of the 
Pipeline, instead of using the Pipeline name and resolving it via Bonjour.

Signal to abort on dropped 
frames

Check when you want FlipFactory to abort the capture process if a 
dropped frame occurs.

Buttons If another user is connected and processing media with this Pipeline, 
using these buttons will interrupt the process, and it must be re-started.

Save Changes Click to update the Pipeline with the new settings. If you change the IP 
address (by any means – returning to self-assigned, enabling DHCP, or 
assigning a static address), in about 30 seconds, Pipeline Administrator 
displays an error: “Unable to communicate with Pipeline”. Click OK, then 
reconnect to the Pipeline using the new IP address.

Default Return settings to default. After returning the settings to default, be sure 
to click Save to make the settings take effect.

Reboot This reboot performs a hardware-level reset, which disconnects Pipeline 
from any client which may attach without warning. You are warned if you 
attempt to reboot the channel while it's in use. Click to reboot the Pipeline 
if you change the password, to log on using the new password. You do 
not need to reboot when changing IP settings.

Soft Reboot This reboot resets the Pipeline and any clients WILL lose their 
connection. Pipeline Administrator displays an alert to warn you.

In cases where the Pipeline is non-responsive, click Soft Reboot to clear 
the problem.

Note

Always exit Pipeline Control before changing any parameters. If you leave it open and 
rename channels (or IP's), it will create duplicates in the UI. This can result in wrong 
channel connections.

Control Description
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Using the Quad Panel
The Quad panel only displays when Pipeline Administrator is connected to one of the Pipeline channels on 
a Pipeline Quad. When you’re connected to any other Pipeline device, this page does not display.

To display the Quad panel, click quad in the menu bar at the top of the window:

Figure 5–4. Quad panel controls confidence monitoring

Be sure to click Save Changes 
to make the change.

Choose which channel if any, to 
monitor.
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Use the Quad panel to set up confidence monitoring.

Table 5–2. Configure Panel controls and descriptions.

Confidence Monitoring

Confidence monitoring is the process of employing channel 4 on the Pipeline Quad to sniff the exact same 
video packets being captured from any of the other Pipeline channels on the Quad and processed by the 
client application during a capture operation (crash recording), for the purpose of verifying that the output is 
a true representation of the input, or that the output meets certain quality limits or other metrics.

Confidence monitoring can be enabled when you are performing a capture operation or crash recording 
from channels 1, 2, or 3 on a Pipeline Quad. When enabled, Pipeline 4 is also dedicated to the capture 
operation for the duration of the capture operation.

Figure 5–5. Confidence monitoring is performed by channel 4 via internal Ethernet bridge

As SDI is being fed into the capture channel’s SDI In port, it is encoded and sent out in TCP packets on the 
Ethernet port to the client application (Pipeline Control, Pipeline Administrator, FlipFactory, Episode, Final 
Cut Pro, and other media systems). Unlike other confidence monitoring that just re-encodes the media 
directly in the same device, the channel 4 Pipeline sniffs the very same packets on the Ethernet just as the 
client does; it then decodes the Ethernet input, and outputs the resulting SDI on its own SDI Out port.

Control Description

Confidence Monitoring

Normal Operation – no 
monitoring

Check to disable confidence monitoring. When confidence monitoring is 
disabled, channel 4 (Pipeline 4 on the Quad) operates normally, and can 
be used for capture/playout operations.

Note: This option is only enabled when you log on to channel 4. You 
cannot make this change from other channels.

Monitor channel 1 | 2 | 3 Check to enable confidence monitoring and encode and send the 
rendered stream of the selected channel on channel 4 SDI Out as well. 
Click Save Changes when you’re done to update the settings.

Ethernet Out

Pipeline Quad
Confidence monitoring of channel 1 enabled.

Internal Ethernet bridge

Pipeline Quad’s Channel 1 is performing a capture operation – 
decoding SDI from the SDI Input to Ethernet out, to Pipeline Control.

Channel 4 is confidence monitoring channel 1 – 
sniffing the outbound traffic on the internal 
Ethernet bridge and re-encoding it, outputting the 
resulting SDI on SDI Out for review.

Channel 1 SDI In
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Operators can attach monitors and vector scopes to the SDI out to view and measure the actual media in a 
full-circle operation, confident that they are testing and viewing exactly the same input as the client system 
is receiving.

When confidence monitoring is enabled and the preview media stream from the channel selected is being 
consumed by Pipeline Control, Pipeline Administrator, or in FlipFactory, the confidence monitor (channel 4 
SDI Out) displays black.

If the monitored channel’s stream is DV, DVCPro, IMX, MPEG-2, or ProRes then the confidence monitor 
displays the full frame video as it is encoded.

If the monitored channel is not streaming media on the LAN, then the confidence monitor displays a 
banner on the image. The frame background is either the last frame of the previous stream or black.

Figure 5–6. Confidence monitor displays a banner when no media stream is present

Note

To enable confidence monitoring, you must log on to channel 4 to display the enabled 
confidence monitoring option on the Quad panel. Channel 4 must be idle before you can 
enable confidence monitoring. You can confidence monitor both capture operations and 
crash recording operations.
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Using the Counters Panel
To display the Counters panel, click counters in the menu bar at the top of the window:

Figure 5–7. Counters panel displays various processing values

Use the Counters panel to view various values related to encoding and decoding to determine if operations 
are normal or if there are failures that must be corrected. These values are reset each time a new RTSP 
connection is made. This information may also be utilized when you are working with Telestream Customer 
Service to resolve an issue.

Table 5–3. Counters Panel controls and descriptions.

Value Description

Frames The number of frames processed during this RTSP session.

Process The number of frames dropped because of excessive CPU load. If this 
number is greater than zero, you’re losing frames and quality. Determine 
the cause of the error and reprocess the media.

Video Sent Number of video frames sent over RTP connection during an capture 
operation.

Audio Sent The number of audio frames sent during capture over RTP.

Status Sent The number of status frames sent during capture over RTP.
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Video Encode Time Number of microseconds it took to process the current video frame.

Video Queue The number of video frames dropped due to excessive network traffic. If 
this number is greater than zero, you’re losing frames and quality. 
Determine the cause of the error and reprocess the media

Audio Queue The number of audio frames dropped due to excessive network traffic. If 
this number is greater than zero, you’re losing frames and quality. 
Determine the cause of the error and reprocess the media

Status Queue The number of status frames dropped due to excessive network traffic.

Video Sequence Count of frames where the timecode (as observed on the RS-422 
connection) was not incrementally increasing.

Audio Align Number of times the audio processor re-synchronized due to an 
Embedded SDI audio error.

Video Align Number of times the video processor had to re-synchronize due to an 
SDI video error.

Video Frame Exceeded CBR codec error counter.

Audio Frames Requested During playout, Pipeline requests audio and video frames serially. This is 
the number of audio frames requested, and should be the same number 
as Audio Frames Received.

Audio Frames Received Number of audio frames received during playout.

Video Frames Requested Number of video frames requested during playout. Should be the same 
number as Video Frames Received

Video Frames Received Number of video frames received during playout.

TCP retransmissions Number of times TCP packets had to be retransmitted.

Value Description
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Using the Upgrade Panel
To display the Upgrade panel, click upgrade in the menu bar at the top of the window:

Figure 5–8. Upgrade panel allows you to upgrade Pipeline firmware

Pipeline is designed so its firmware and Pipeline Administrator Web application can be upgraded easily 
when new revisions of Pipeline software are made available by Telestream. 

You can periodically check the Pipeline support page at www.telestream.net/telestream-support/pipeline/
updates.htm to determine if there is newer software. (Registered users are notified of upgrades via E-mail.) 
On the site, click Support > Support Home in the main menu at the top of the page, then select Pipeline > 
Updates on the right, under Enterprise Product Support. Pipeline firmware updates are available on this 
page.

To upgrade a Pipeline, follow these steps:

Note

To determine the current version of your Pipeline, log on and display the Configure 
page. The version number is the value in the App field, which displays the firmware 
version number: <Major Version>,<Minor Version><Build Number><Internal Use>. For 
example: 2,2,33165,00 indicates Version 2.2, Build 33165.
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1. Connect to the target Pipeline with a Web browser and determine the current firmware version via the 
Configure panel (Using the Configure Panel on page 44).

2. Log on to the Pipeline support page at www.telestream.net/telestream-support/pipeline/updates.htm.

3. Download the Pipeline firmware file (firmware-xxxxx.pln) to your computer.

After downloading the firmware file, upgrade the firmware by following these steps:

1. Log on to the target Pipeline using a Web browser.

2. Select Upgrade from the menu to display the Upgrade panel.

3. Click Choose File to locate and select the firmware file (firmware.xxxxx.pln) you plan to use.

4. Click Upgrade and observe the progress bar and notes about the process.

During a firmware upgrade, the front SDI In LED (on left) lights yellow during the upgrade process. 
When the Pipeline has been upgraded, Pipeline Administrator reboots the Pipeline channel and 
displays a rebooting message on the Upgrade page. In about 15 to 30 seconds, both the In and Power 
LEDs light green. Pipeline Administrator reconnects automatically and displays the Configure panel.
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U s i n g  P i p e l i n e  C o n t r o l
Chapter 6, Using Pipeline Control

Use this chapter to learn about Pipeline Control and how to use Pipeline Control’s general features.

Pipeline Control is the host application for controlling digital media capture and play out from Pipeline 
devices. Pipeline Control is available for both Mac OS X and Windows users. Pipeline control provides 
different document types to provide log and capture, scheduled capture and play out, triggered manual and 
automated capture, various types of Print to Tape operations, and Controlled Playout.

Pipeline Control supports both SD and HD – Pipeline SC, Pipeline Quad, and Pipeline HD Dual.

Topics

 Pipeline Control Overview (page 57)

 Starting Pipeline Control (page 59)

 Creating New Pipeline Control Documents (page 59)

 Pipeline Control Menus (page 61)

 Using The Pipeline Settings Panel (page 64)

 Configuring Publishers (page 68)

 Using the Pipeline State Panel (page 78)

 Using The Video Preview Panel (page 79)

 Using the Audio Preview Panel (page 80)

 Loading and Saving Clip List Files (page 81)

 Setting Up Pipeline Control Options (page 81)

 Using the Video Wall (page 88)

 Using the Label Editor (page 91)

 File Formats/Wrappers (page 93)

 Using the Diagnostics Panel (page 92)

 Telestream Intermediary Format (TIFO) (page 104)

PIPELINE CONTROL OVERVIEW

Pipeline Control enables you to select a specific Pipeline and configure it for your workflow requirements. 
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Pipeline Control provides specific document types to support various digital media recording and playout 
tasks: Scheduled Capture (usually called a Schedule, for short), Log & Capture, Trigger (for manual or 
automated capture), Print to Tape, and Controlled Playout.

Pipeline Control allows you to open multiple documents at the same time and work with them in a tabbed 
window. 

Figure 6–1. Typical Pipeline Control window for Windows (Schedule window shown)

Pipelines are discovered and tracked on your network by two methods: Bonjour or manually. Bonjour is 
preferred on most networks, because it’s automatic. You can use the manual discovery feature (Discovery 
Tab on page 86) to discover and select Pipelines devices across sub-nets or when Bonjour communication 
traffic is blocked.

Pipeline Control executes the tasks you specify in each document independently of tasks in other open 
documents. Tasks are executed when you activate (or turn on) a document. The panels on the left are 
generally the same in all document types. The panels and controls on the right are unique to each 
document type. Tasks specified in a document are executed when the document is activated.

Before you start working in a tab, make sure the tab is actually the one you want to update.

Note

Drag and Drop is supported in some windows. On Windows Server platforms, 
Windows Explorer does not run as administrator. However, Pipeline Control by default 
runs as administrator. When running Pipeline as administrator, files cannot be dragged 
from a Windows Explorer window into Pipeline Control window.
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STARTING PIPELINE CONTROL

You can start Pipeline Control by selecting Start > Programs > Telestream > Pipeline > Pipeline Control.

You can also start Pipeline Control by double-clicking a Pipeline document you’ve saved. Or, by dropping a 
Pipeline document onto the Pipeline Control icon in the Programs folder or a Pipeline Control shortcut on 
your desktop, for example.

By default, Pipeline documents are saved in the My Documents folder. When you open Pipeline Control in 
this manner, the Pipeline document you double-clicked is displayed. 

CREATING NEW PIPELINE CONTROL DOCUMENTS

Pipeline Control provides specific document types to support various tasks you can perform.

Creating New Documents via the Task Selector
When you start Pipeline Control (or when no documents are open), it displays a Task Selector panel that 
allows you to choose which task you want to perform (and thus, which type of document to display):

Note

Pipeline Control can only be used with Pipelines whose firmware is compatible.

When you install or upgrade Pipeline software, you may need to upgrade your Pipeline 
firmware as well. If you select a Pipeline with older firmware that is incompatible with 
the current version of Pipeline Control, you will be warned that this may cause 
problems.

When you open schedules created in previous versions of Pipeline Control, you may 
need to reset the audio and video settings before using them.

Note

If you’re opening Pipeline Control for the first time, you should set up your Pipeline 
Control preferences. For details on setting up Pipeline Control preferences, see Setting 
Up Pipeline Control Options (page 81).
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Figure 6–2. Use the Task Selector to create new documents.

Scheduled Capture (Page 107). Click the Scheduled Capture button to create and display a new, untitled 
Scheduled Capture document.

Log & Capture. (Page 117) . Click the Log & Capture button to create and display a new, untitled Log & 
Capture document. 

Triggered Capture (Page 127).  Click the Triggered Capture button to create and display a new, untitled 
Triggered Capture document.

Print to Tape (Page 137).  Click the Print to Tape button to create and display a new, untitled Print to Tape 
document.

Controlled Playout (Page 145).  Click Controlled Playout to create and display a new, untitled Controlled 
Playout document.

Creating New Documents via the File Menu
You can also create a new, untitled document by selecting the menu item of the appropriate window type in 
the File menu.

For details about how to use these documents to perform various recording tasks, see these chapters:

Note

For details on how to use the panels, controls, and features of each type of document, 
go to their respective chapters.
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 Scheduled Capture – Page 107

 Log & Capture – Page 117

 Triggered Capture – Page 127

 Print to Tape – Page 137

 Controlled Playout – Page 145

PIPELINE CONTROL MENUS

Use this section as a quick reference for menu items. (General menus and menu items are not described.)

File Menu

Open. Displays an Open File dialog so you can browse and open saved Pipeline Control documents.

New Schedule Document. Displays a new, untitled Schedule Capture document.

New Log & Capture Document. Displays a new, untitled Log & Capture document.

New Trigger Document. Displays a new, untitled Triggered Capture document.

New Print to Tape Document. Displays a new, untitled Print to Tape document.

New Controlled Playout Document. Displays a new, untitled Controlled Playout document.

Import GVG 4 EDL. Displays an Open dialog so you can import a GVG 4 EDL file. (Loading and Saving 
Clip List Files (page 81)). EDLs are generated by Final Cut Pro and Avid software.

Import Final Cut Pro XML. Displays an Open dialog, so you can import a Final Cut Pro XML Interchange 
file. (Loading and Saving Clip List Files (page 81)).

Export GVG 4 EDL. Displays an File dialog so you can save the current clip list as a GVG 4 EDL file. 
(Loading and Saving Clip List Files (page 81)).

Export Final Cut Pro XML. Displays a File dialog so you can save the current clip list as a Final Cut Pro 
XML Interchange file. (Loading and Saving Clip List Files (page 81)).

Note

When exporting one of the capture documents, the value of the name element (in the 
XML file) of a clip is determined by: 

1. If a clip has already been written to disk, the name element takes on the clip's file 
name without the extension.

2. If the clip has not yet been written to disk and if its title is in tokenized format, then 
the value of the name element becomes the tokenized format converted to a string. 
For example, if the clip's title was Pipeline plus the counter token, the name element 
used is Pipeline COUNTER.

3. The default name element used is A Clip.
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Exit. Closes the program. If any document has not been saved or has unsaved changes, Pipeline Control 
asks you if you want to save the document before closing.

Save. Saves the changes to the active window in a new document.

Save All. Saves all of the opened Pipeline documents simultaneously. Only saves documents previously 
saved with a name other than the default.

Save As. Displays a Save File dialog so you can save the document with a different name or in a different 
directory.

Save Settings as Template. Saves your current settings as default: Pipeline, wrapper, video (codec, 
frame size, frame rate, quality), audio (type, channels, bit depth), clock, handles, and publish. After saving 
your settings as a template, new documents that you create inherit these settings.

Control Menu
Control Menu items control the state of the selected tab.

Preview. Click to connect to the selected Pipeline and display the source media, if any. You can preview 
video and audio whether the document is activated or deactivated. Select again to stop preview.

Active. Click to activate the document. When a document is active, it can’t be edited, and it is being 
processed. To deactivate the document (to stop processing or to modify it), select it again.

Device Menu and Keyboard Shortcuts

WARNING: During capture within a Trigger session depressing the '-' or '=' key will stop the 
capture immediately.

The Device menu provides commands for controlling the VTR of the connected device using the following 
keyboard commands and keyboard shortcuts. 

Play – Space bar. Put VTR in play mode and play the video forward at normal forward speed.

Stop – K. Stop the VTR at the current play point.

Rewind – J. Play video backward at the deck’s rewind speed.

Note

Templates are stored in a file named template.pipeline located in:

Win7: C:\Users\<username>\AppData\Roaming\Telestream

To return Pipeline Control to the default document settings, delete this file.

Note

When opening Saved Schedule and Trigger documents they can be automatically 
activated by editing the AutoActivate element in the document with an XML or text 
editor. Simply change the AutoActivate element from false to true: 
        Document will auto activate - <AutoActivate>true</AutoActivate>
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Fast Forward – L. Play forward at deck’s fast forward speed.

Step Backward – [ (Left Brace). Step one frame backward.

Step Forward – ] (Right Brace). Step one frame forward.

Go To Start (local playback only) – Control-[ (Left Brace). Return the clip to the beginning.

Go To End (local playback only) – Control-] (Right Brace). Go to the end of the tape.

Clip Menu
The Clip menu commands enable you to edit or delete clips, and provide keyboard shortcuts when you are 
creating a new clip.

Add. Creates a new event.

Clear. Remove the selected clip (the file is not deleted from the file system.)

Edit. Edit the selected clip details and metadata.

Review. Select to review a captured clip in the Preview panel.

The following menu items are only available in Log and Capture documents:

Quick Mark – M. Single-click feature for logging a clip and setting a new mark in point. Click to set the 
current point on the tape as the mark out point and logs the clip. The last clip’s mark out point becomes the 
new mark in point, so that you only have to click Quick Mark again to set the out point and log the clip.

Set Mark In – I. Set the tape’s current timecode as the clip’s in point.

Set Mark Out – O. Set the tapes current timecode as the clip’s out point.

Go To Mark In. Roll the tape to the point specified in the Mark In timecode field.

Go To Mark Out. Roll the tape to the point specified in the Mark Out timecode field.

Log Clip – P. Create a clip under the current tape name in the tape field, using the values in the General 
and metadata tabs.

Tools Menu

Options. Displays the Options window, so you can configure your capture, device, update, discovery, and 
security settings (Setting Up Pipeline Control Options (page 81)).

Video Wall. Displays a panel with multiple video streams (Using the Video Wall (page 88)).

Label Editor. Displays an editor that allows you to create your own metadata labels (Using the Label 
Editor (page 91)).

Help Menu

User’s Guide. Displays the Pipeline User’s Guide (the guide you are reading).

Gather Support Information. Displays the Support Information dialog window that enables you to 
automatically gather information for use by technical support. The following information is gathered:
178027



Chapter 6
Using Pipeline Control

64
• Pipeline Trace logs

• Host system profile information

• Screen shot of the Pipeline document

• Saved document file

• Windows System and Application Event Logs 

• Pipeline Device Crash log

• Pipeline F/W and Software versions

• Gather Telent 911 information

Obtain a case number from Telestream Support and enter it into the Case Number field. Click Export To 
Desktop to save information in a zip file on your desktop. Email this zip file to Telestream Support.

Figure 6–3. Support Information.

About Pipeline Control. Displays the About dialog with Pipeline Control’s version number.

USING THE PIPELINE SETTINGS PANEL

At the top of Pipeline Control is the Pipeline Settings panel. This panel displays the Pipeline settings for the 
active tab. There are several selectors in the panel. These selectors enable you to select a specific 
Pipeline and configure the document to use it specifically for the tasks or workflow you intend. Some 
selectors do not display in certain document types. For example, in a Trigger document, the Handles 
selector doesn’t display.

Note

In preview mode, these settings are disabled and you can’t make changes. To make 
changes, you must first return to idle mode. If Pipeline Control is has been locked 
(Security Tab on page 87), you also can’t make changes to Pipeline settings. Use the 
password to unlock Pipeline Control if you need to make changes to Pipeline settings.

Enter case number

Click Export To 
Desktop
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Figure 6–4. Windows Pipeline Settings panel.

These settings are saved with the document. When the document is connected to a Pipeline, the Pipeline 
is configured for the task, based on these settings.

Selecting a Pipeline
To select a Pipeline, click the Pipeline drop-down list and pick one from the list. Additionally, when Pipeline 
Control discovers Pipelines on the network, it records the Network Interface Card (NIC) that the Pipeline 
responded on. The computer's routing tables are then examined to see if a valid route is available to the 
Pipeline Control application on which to communicate. If a valid route is not found then Update Route is 
displayed. Click Update Route to add a valid entry into the computer's routing table.

Figure 6–5. Windows Pipeline browser and selection window.

Click R to refresh status. A green bullet icon indicates that this Pipeline is available. A red bullet indicates 
that it is currently busy (connected to another client application). Gray indicates offline; yellow indicates an 
unknown state. To enable you to select a Pipeline to set up a document for use later, you can select a 
Pipeline regardless of its state. This dialog reports the Pipeline's current status (idle, capturing, recording, 
unknown), name, input source, firmware version, device type (SD or HD) and system NIC connection.

Selecting and Configuring Codecs
When you don't have a Pipeline selected (None), all codecs display. When you select a specific Pipeline, 
only those codecs supported by the target Pipeline are hinted with a green star icon. When choosing the 
frame rate, make sure you’re providing an appropriate source.

Pipeline Selector. Click 
to select a Pipeline.

Wrapper. Click to 
select a file type.

Clock. Click to select a 
timecode clock source.

Publish. Click to select an action to 
perform when each clip is ready.

Audio. Click to select and 
configure the audio codec.

Handles. Adjust the time 
value of handles.

Video. Click to select and 
configure the video codec.

Select a Pipeline

Click Update 
Route

Click R
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Figure 6–6. Pipeline Control notifies you when your configuration is not supported by the Pipeline.

Based on your Pipeline, you can select from Motion JPEG, DV, DVCPro, DVCPro HD, IMX, MPEG2 I-
Frame, ProRes, Avid DNxHD, and Uncompressed codecs. Each codec has one or more profiles from 
which you can choose.

Each codec’s profile details are located in Appendix C, Pipeline Control Codec Profiles (page 159). 

When you select a codec only the resolutions that apply to that codec are selectable. Frame Rate and 
Quality settings are filtered based on the resolution you select. Based on the SDI signal of the connected 
Pipeline, resolutions and frame rates that display a green star are compatible with the current signal.

The SDI stream being ingested by the Pipeline may be from one of many possible sources. if you select an 
NTSC frame rate to encode PAL, or a PAL frame rate to encode NTSC, or other incompatible parameters, 
Pipeline Control displays an error and prevents the capture from occurring.

When selecting a Quality setting for NTSC or PAL captures be sure to select a setting with an Anamorphic 
suffix if the SDI source of the Pipeline requires anamorphic encoding. When selected, video preview is 
displayed at the correct aspect ratio and Pipeline Control embeds a display size flag in the QuickTime file 
so that other QuickTime applications can determine the correct display aspect ratio.

Selecting and Configuring a Video Codec

Click the Video drop-down menu to select the video codec you want to use. Based on your selection, the 
frame size, frame rate, and quality drop-down menus populate with available values. Select the frame size, 
rate, and quality from the drop-down menus to meet your workflow requirements. 

Note

Settings are hinted when they are known to work with the selected Pipeline or wrapper 
and its current input signal. However, you may be creating documents for later use, 
when the signal is different, so you can select settings that may work if you change the 
Pipeline’s input signal.

Hints also indicate the settings that are known to work given the selected wrapper 
format, such as QuickTime, TIFO, MXF OP-Atom, or MXF-OP1a. If both the selected 
wrapper and the selected Pipeline support the setting, it is hinted.

If you’ve already selected a codec and settings – and you select a Pipeline that doesn't 
support it – Pipeline Control will notify you when you connect that it doesn’t support the 
selected codec.

Note

If your source is HD and you choose an SD codec, Pipeline down-converts the video 
according to your settings. However, Pipeline's down-convert is not intended for 
production use.
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Configuring the Audio Codec

In the Windows version, DolbyE is also available. Select the number of channels, bit rate, and sample size 
from the drop-down menus. Valid options display with a green star icon (hinted).

When you don't have a specific Pipeline selected (None), all Quality settings can be selected. Audio 
parameters include Channels (2, 4. 8, or 16), Sample Rate (always 48K) and Quality (16-bit or 24-bit, Big 
Endian and Little Endian).

Audio Tracks

When 2 channels are selected, audio track selection can be: Mono tracks (PCM) for all channels to be in 
individual audio tracks, or Stereo tracks (PCM) to pair audio channels into stereo tracks. If 4, 8, or 16 
channels are selected, a third option is available which combines all channels in one track.

Each of these audio track selections (mono, stereo, and n-tracks) has an additional selection of PCM 
(default) or DolbyE that can be made for each channel. Select DolbyE only if you are sure DolbyE is 
present on the selected track.

Selecting a Timecode Clock Source
Click the Clock drop-down menu to select which device provides the timecode clock source signal. You 
must be connected to a Pipeline in order to obtain a timecode clock source, except when you choose 
Computer Clock. Choose from Auto, RS-422 Device, Sync Input (Pipeline Quad and Pipeline HD Dual), 
Video Input, Internal Clock, Computer Clock, Pipeline Channel 1 (when connected to a Pipeline Quad), or 
Zero Based timecode. When you change your timecode clock source, save your file to save changes.

Auto. When you select Auto the Pipeline system will search for the first appropriate time source in the 
following order: RS422, Ext Sync SDI VITC, Input Signal VITC, Zero Based.

For example, if you’re connected to a Pipeline SC and RS-422 has a timecode, it will be used because it is 
highest priority (column on right). If not, SDI timecode will be used (2nd priority), etc.

RS-422 Device. Uses the timecode provided by the device attached to the RS-422 port on the target 
Pipeline; usually a VTR. If the timecode is not available, a zero-based timecode is provided.

Sync Input. For use with Pipeline Quad and HD Dual only. Uses the timecode provided through the 
Reference Input signal in VBI or VANC. If the timecode is not available, a zero-based timecode is provided. 
Do not select Sync Input if you are connected to a single-channel Pipeline.

Video Input. Uses the timecode provided on the Pipeline’s video input signal in VBI or VANC. If the 
timecode is not available a zero-based timecode is provided.

Pipeline Clock. Uses the timecode provided by the Pipeline itself.

Computer Clock. Uses the timecode provided by the host computer on which Pipeline Control is running.

Pipeline Channel 1. When connected to a Pipeline Quad you can select Channel 1’s timecode. This 
enables multiple channels of a Quad to share a common timecode when an external timecode, either on 
the video input or the Reference input, is not available.

Zero Based . Captures will not necessarily start at 00:00:00:00. The timecode will start at 00:00:00:00 and 
then free run when the document is first activated. The timecode of the capture will be whatever the 
timecode is when the capture is initiated.
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Setting up Handles
The Handles control displays only in Log & Capture and Schedule documents. Enter the value in minutes 
and seconds, up to 5:59 minutes to capture before and after the actual scheduled capture time.

Selecting a Publisher
Click the Publish drop-down menu to select the system that you want to notify for each clip event. 
FlipFactory and Copy publishers automatically send jobs when the file is ready. For details about setting up 
each type of publisher, see Configuring Publishers (page 68).

If you don’t want to directly connect to another system in your workflow to pass the saved media file and 
optional metadata, select None.

CONFIGURING PUBLISHERS

Publishers are methods of notifying a specific system that an event has occurred, or that media is available 
for processing. Methods differ, based on the notification requirements of the system you’ve selected. When 
you select a publisher, you’re prompted to configure it. You can select and use one publisher per schedule.

 Using Vantage Publish within Pipeline Control for Windows (page 68)

 Using Agility Publish within Pipeline Control for Windows (page 71)

 Side Car XML Plugin (page 73)

 Copy File Publisher (page 74)

 Avid MXF Copy File Publisher (page 74)

 FlipFactory Publisher (page 75)

Using Vantage Publish within Pipeline Control for Windows
Set up and use the Vantage publisher in Pipeline Control when you want to submit media and metadata 
directly into an active Vantage Workflow.

Pipeline Vantage Publish can speed your jobs to near real-time by starting Vantage Workflow processes as 
soon as your capture begins. To do this select TIFO as the wrapper type. When capturing media into a 
TIFO container Vantage is notified as soon as the file is created, allowing the Workflow to begin processing 
media and metadata immediately, thus shortening the total processing time. When capturing media in any 
other file format, Vantage is notified when capture is complete and the file is closed.

There are two simple steps to configuring a Pipeline Control for use with the Vantage Publish:

1. Select the folder location where Pipeline Control will be writing the captured media file to. This is done 
from within the wrapper dialog (QuickTime, MXF OP1a or TIFO). The location must be accessible from 
the Vantage system and should be a network UNC path.

2. Select the Vantage Domain and Workflow you wish to drive from within the Vantage Publish plug-in 
dialog. 

The workflow

Pipeline Control captures and writes a media file to a media storage location and submits a job to a 
selected Vantage Workflow. The job request includes the Workflow name, any metadata required by the 
Workflow and the location where Vantage can find the captured media file. Vantage will start the job and 
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processes it through the respective Workflow using the captured media file and metadata at the location 
given to it by Pipeline Control's Vantage Publish.

Figure 6–7. Vantage Workflow.

Creating a Vantage Workflow

You can submit a job to any active Vantage workflow. If you wish to pass metadata from Pipeline Control to 
a Vantage workflow then your Workflow design must begin with a Receive Action containing at least one 
metadata label.

Any metadata label contained in the Receive Action will be pushed forward to the Pipeline Control's Label 
interface allowing the user to enter the appropriate data.

Figure 6–8. Vantage Design Workflow.

Selecting the Pipeline Control storage location

Create and configure the Pipeline Control document (Schedule, Log&Capture or Trigger) you plan to use 
for this workflow, including the wrapper and media format, and the storage location you plan to use. In the 
Wrapper dialog, specify the storage location (see Selecting a Wrapper section in Chapter 8 of the Pipeline 
User Guide) on a network share, or a share directly on the Vantage server (recommended specifically for 
TIFO files, processed in real time). This storage location will be referenced by the Vantage Publish as 
described below.

Setting up Vantage Publish

Follow these steps to configure Pipeline Control's Vantage Publish:
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1. Open the appropriate Pipeline Control document.

2. Select Vantage as a publisher by selecting Publish > Vantage. 

3. From the Vantage Publish setup dialog enter the target Vantage serve name or IP address. The Port 
number defaults to 8676 and should be changed only if this has been modified when your Vantage 
server was installed.

4. Press the Connect button to display all of the Workflows on your Vantage system.

5. Select a Workflow from the list that appears. Note that the Workflow list indicates the current Status of 
the Workflow (Active, Editing or Idle) and number of Labels that are available to Pipeline. If the 
workflow's Status is Idle it can be activated by selecting the Activate button under the workflow 
selection panel. Workflows with a Status of Editing cannot be used until they are in the Idle or Active 
status mode.

6. Select OK to close the Vantage Publish dialog.

7. If you have not already done so configure all other Pipeline Control parameters. Pay particular 
attention when selecting the location where Pipeline Control will be writing the media file. Make sure 
that the location where Pipeline Control is writing the file is equivalent to the location where Vantage 
will be looking for it.

Figure 6–9. Vantage Publish Setup

8. In the Vantage window, enter the host machine name, the port address, and click Connect. Select a 
Vantage workflow, and (optionally) browse to a file location. If no location is defined, the file location 
defined in the Wrapper menu is used (hover over Wrapper Settings to see a visual of this menu).

Select Vantage
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Figure 6–10. Vantage Window

Vantage Metadata Labels

If there were any metadata labels as part of the Workflow they will appear in the Pipeline Control Label UI. 
Their names will be [<Vantage Workflow name> - <Label name>]. 

Figure 6–11. Vantage Metadata Labels

Using Agility Publish within Pipeline Control for Windows
Set up and use the Agility publisher in Pipeline Control when you want to submit media directly into an 
Agility Job Profile.

There are two simple steps to configuring a Pipeline Control for use with the Agility Publish:

1. Select the folder location where Pipeline Control will be writing the captured media file to. This is done 
from within the wrapper dialog (QuickTime or MXF OP1a). The location must be accessible from the 
Agility system as a network UNC path.

2. Select the Agility Node and Job Profile from within the Agility Publish plug-in dialog. 

The workflow 

Pipeline Control captures and writes a media file to a media storage location and submits a job to a 
selected Agility Job Profile. The job request includes the Job Profile name and the location where Agility 

Enter host, port, 
and click Connect

Browse to file 
location

Hover to see 
menu visual
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can find the captured media file. Agility will start the job and processes it through the respective Profile 
using the captured media file at the location given to it by Pipeline Control's Agility Publish.

Figure 6–12. Agility Workflow.

Selecting the Pipeline Control storage location

Create and configure the Pipeline Control document (Schedule, Log&Capture or Trigger) you plan to use 
for this job, including the wrapper and media format, and the storage location you plan to use. In the 
Wrapper dialog, specify the storage location (see Selecting a Wrapper section in Chapter 8 of the Pipeline 
User Guide on a network share, or a share directly on the Agility server (recommended). This storage 
location will be referenced by the Agility Publish as described below.

Setting up Agility Publish

Follow these steps to configure Pipeline Control's Agility Publish:

1. Open the appropriate Pipeline Control document.

2. Select Agility as a publisher by selecting Publish > Agility. 

3. From the Agility Publish setup dialog enter the target Agility serve name or IP address. The Port 
number defaults to 80 and should be changed only if this has been modified when your Agility server 
was installed.

4. Press the Connect button to display all of the Job Profiles on your Agility system.

5. Select a Job Profile from the list that appears. 

6. Now you must select the location where Agility can find the captured media file that Pipeline Control 
will create. The File Location field needs to be entered from the perspective of the Agility Server and 
must be the same location that was entered in the Wrapper dialog. Complete the File Location field by 
following the instructions below based on where Pipeline Control will be writing the media file.

7. Select OK to close the Agility Publish dialog.

8. If you have not already done so configure all other Pipeline Control parameters. Pay particular 
attention when selecting the location where Pipeline Control will be writing the media file. Make sure 
that the location where Pipeline Control is writing the file is equivalent to the location where Agility will 
be looking for it.
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Figure 6–13. Agility Publish Setup

9. In the Agility window, enter the host machine name, the port address, and click Connect. Select a 
profile space and a job profile, and (optionally) browse to a file location. If no location is defined, the file 
location defined in the Wrapper menu is used (hover over Wrapper Settings to see a visual of this 
menu).

Figure 6–14. Agility Window

Side Car XML Plugin
The Side Car XML publishing plugin will take any populated metadata label, create a XML file, and deliver 
it to a specified location. The file can be delivered upon file creation or when the file is completely captured.

Note

If you make a call to retrieve the list of profile spaces (at http://<some_url>/AgilityRest/
profilespaces), the user defined space is always returned even if the Use System 
Default option in the Web UI is checked.

Select Agility

Enter host, port, 
and click Connect

Hover to see 
menu visual

Browse to file 
location

Select a profile space 
and a job profile
178027



Chapter 6
Using Pipeline Control

74
Figure 6–15. Side Car XML allows publishing of metadata labels.

Use the Side Car XML plugin for workflows that require XML metadata in conjunction with a media file. 
Custom metadata labels can be created by using the Pipeline Control's Label Editor.

Copy File Publisher
The Copy File publisher is used to copy a captured clip to another local folder or network share. To select 
Copy File as a publisher, select Publish > Copy File. The following edit panel displays.

Figure 6–16. Copy File publisher allows you to duplicate just-completed clips.

Complete the panel and click OK. Save the document to save these settings. Make sure you test your 
configuration before putting the document into production.

Copy File To. Click to display the File System dialog, and select the folder where you want to copy the file.

If File Already Exists. Select the action to take if there is already a file of the same name in this folder: 
Replace the existing file, save the new file with a unique name, or don’t copy the new file.

Append date and time to file name. The date and time is appended, in the format YYYY-MM-DD HH-
MM-SS. For example, if the file Pipeline10.MOV was created on December 5, 2008 at 13:15 when copied, 
it would be named Pipeline10 2008-12-05 13-15-00.MOV.

Avid MXF Copy File Publisher
The Avid MXF Copy File publisher is used to copy a captured clip to another local folder or network share. 
To select this as a publisher, select Publish > Avid MXF Copy File. The following edit panel displays.

Figure 6–17. Avid MXF Copy File publisher allows you to duplicate just-completed clips.

Complete the panel and click OK. Save the document to save these settings. Make sure you test your 
configuration before putting the document into production.
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Copy AAF Files To. Click to display the File System dialog, and select the folder where you want to copy 
the AAF files.

Copy MXF Files To. Click to display the File System dialog, and select the folder where you want to copy 
the MXF files.

If File Already Exists. Select the action to take if there is already a file of the same name in this folder: 
Replace the existing file, save the new file with a unique name, or don’t copy the new file.

Append date and time to file name. The date and time is appended, in the format YYYY-MM-DD HH-
MM-SS. For example, if the file Pipeline10.MOV was created on December 5, 2008 at 13:15 when copied, 
it would be named Pipeline10 2008-12-05 13-15-00.MOV.

FlipFactory Publisher
Set up and use the FlipFactory publisher in Pipeline Control when you want to implement Pipeline Control 
> FlipFactory workflows that automatically submit media to a factory for processing. Optionally, you can 
implement submit metadata on a per-job basis.

Factories used by FlipFactory publishers should not have a monitor enabled. The FlipFactory publisher 
submits job messages directly to the Flip Engine server, eliminating the requirement for a monitor. 
Alternatively, you can configure a factory with a monitor that monitors the storage location specified in your 
wrapper format, and do not implement a FlipFactory publisher in your Pipeline Control document.

The FlipFactory publisher can integrate with the factory you've specified in Pipeline Control using any file 
format and wrapper (except for Avid AAF+MXF) you need for your workflow requirements. To speed your 
workflow to near real-time by starting transcoding as soon as capture starts, select TIFO as the file type. 

Using TIFO files, FlipFactory is notified as soon as the file is created and transcoding occurs as soon as it 
is available, thus shortening total processing time. When capturing media in QuickTime files or other 
wrappers, FlipFactory is notified when the operation is complete and the file is closed.

Design your Pipeline Control > FlipFactory Workflow

Set up your FlipFactory Factory. Configure a factory to produce the media and optionally process 
metadata per your workflow requirements. Do not enable a monitor – the FlipFactory publisher submits 
jobs automatically.

Note
Telestream recommends installing Pipeline Control on a computer that is not hosting 
FlipFactory or other media processing applications: intense disk and CPU consumption 
can interfere with proper operation of both applications.

FlipFactory publisher requires FlipFactory version 6.0 (with update packs 1-4 installed), 
or greater. (See FlipFactory support Web page at www.telestream.net for updates.)

When submitting jobs with TIFO files, it is important to save the file directly on the 
FlipFactory or Episode Engine server for efficient processing by FlipFactory or 
Episode. 

Refer to General Pipeline System Setup Information (page 27) when writing media files 
to a shared storage location.
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Set up your Pipeline Control Document. Create and configure a Pipeline Control document for this 
workflow, including the wrapper and media format, and the storage location for captured clip files. In the 
Wrapper dialog, specify the storage location: local on your Pipeline Control host system, on a network 
share, or a share directly on the FlipFactory server (recommended specifically for TIFO files, processed in 
real time).

Enable and configure the FlipFactory publisher to automatically submit media files you’ve captured in your 
document to a specific location, and a specific FlipFactory factory for processing.

The FlipFactory publisher implements automatic file integration by instructing your factory to ingest media 
from the server (local, network share, or FlipFactory) where you have configured the Pipeline Control 
document to write clip files, using the Wrapper dialog.

To select FlipFactory as a publisher, select Publish > FlipFactory. The following panel displays:

Figure 6–18. FlipFactory publisher panel allows you to submit media to a specific factory.

FlipFactory Server. Select the target FlipFactory from the list.

Address. Displays the selected FlipFactory server; allows you to enter it manually – enter its IP address or 
server name and port number in the form <IP address|ServerName>.local:<Port Number (default 9000)>.

If you’re submitting jobs to a FactoryArray, enter the FactoryArray’s virtual IP Address in the Address field. 
After selecting or entering the FlipFactory server’s ID, the FlipFactory Publisher will connect to the 
FlipFactory database to obtain the accounts and associated factories and display them.

Account. Select the account on the selected FlipFactory from the popup menu. When you select an 
account, Pipeline Control queries FlipFactory for a list of factories in the account, and takes a few seconds.

Select the factory from the list of factories in the selected account. If this factory has metadata labels, they 
will be displayed so that you can provide metadata values to submit to the factory.

File Location. When selecting a directory from the File location list, note that the path is formed from the 
perspective of the FlipFactory server.

If the Pipeline Control wrapper Location has been configured to write files to a shared network folder 
(either directly on the Pipeline Control host system or other network file server), manually enter a path to 

Note

The servers, drives, and folders are local to the FlipFactory server. Only select a local 
drive/folder when Pipeline Control is configured in the Wrapper to write clip files directly 
to a FlipFactory server share.

All metadata labels associated with the selected account are displayed in Pipeline 
Control for data entry.
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the file in UNC format. If the Pipeline Control wrapper Location has been configured to write files to a 
shared network folder directly on the FlipFactory server, click Browse to navigate and select the local 
directory in drive-letter format.

Figure 6–19. Pipeline Control – FlipFactory file sharing options.

Use this table to determine how to specify the Pipeline Control file read and write directory in Pipeline 
Controls’ Wrapper dialog and FlipFactory publisher dialog:
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Table 6–1. Configuring clip file paths for Pipeline Control and FlipFactory access.l

Configure the settings in the panel and click OK. Make sure you test before putting the document into 
production.

USING THE PIPELINE STATE PANEL

The topmost panel on the left side of Pipeline Control is the Pipeline State panel. Use the Pipeline State 
panel to determine the current state of the Pipeline you’re connected to. The Pipeline State panel cannot 
be closed – it remains open and active at all times.

Figure 6–20. The status window displays current Pipeline activity.

The Pipeline State panel displays the current Pipeline activity: idle, closing connection, establishing a 
connection, previewing, capturing, preparing, playing out, etc. The status bar pulses red when writing a file 
to disk.

Pipeline Control File Write Directory FlipFactory File Read Directory

Pipeline Control Local Directory. In the 
Wrapper dialog, browse and select a letter-
drive directory on this computer. The directory 
must be configured as a share for FlipFactory 
and the user name Flip Engine service 
operates under must have Read permission.
Syntax: <Drive>\<directory>\...
Example: C:\PipelineControl\ScheduleClips

Pipeline Control Local Directory. In the 
FlipFactory Publisher dialog, browse and select the 
share on the Pipeline Control host system.
Syntax: \\<PipelineControl Host>\<ShareName
Example: \\PipelineControl\ScheduleClips

Network Share. In the Wrapper dialog, 
browse and select the share on the network 
file server. The user names Pipeline Control 
operates under must have Full Control 
permission and Flip Engine service operates 
under must have Read permission.
Syntax: \\<Network File Server>\<ShareName
Example: \\NetServer007\ScheduleClips

Network Share. In the FlipFactory Publisher dialog, 
browse and select the same Share on the target 
network file server.
Syntax: \\<Network File Server>\<ShareName
Example: \\NetServer007\ScheduleClips

FlipFactory Server Local Directory. In the 
Wrapper dialog, browse and select a Share on 
the FlipFactory server.
Syntax: \\<FlipFactory Server>\<ShareName
Example: \\FlipFactory001\ScheduleClips

FlipFactory Server Local Directory. In the 
FlipFactory Publisher dialog, browse to select the 
directory directly on the FlipFactory server. The 
directory must be set up as a share for Pipeline 
Control and the user name Pipeline Control 
operates under must have Full Control permissions.
Syntax: <Drive>\<directory>\...
Example: C:\FFStores\ScheduleClips

Status. Displays status messages in preview, idle, and 
capture modes.
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USING THE VIDEO PREVIEW PANEL

The Video Preview panel displays video during preview, capture, and playout operations with the current 
timecode in HH:MM:SS:FF format. VTR controls are directly below.

To open or close the Video Preview panel, click the expand/collapse arrow (top left corner of the panel).

Disable preview by closing the panel to decrease CPU load during capture.

You can also play local clip files (clips that have already been captured) in the document. Hover over the 
clip and select Play.

Figure 6–21. Use the Video Preview panel to view the incoming video stream.

When video is being encoded and streamed from the Pipeline, you can preview the media.

Deck Controls

Use the VTR controls to preview video from the deck, connected via RS-422. The exact performance 
depends on the implementation of the commands on the deck itself. For example, Fast Forward on one 
deck may advance the tape at a different speed than Fast Forward on another deck.

Note

These controls are only enabled when the Pipeline channel is connected to a device 
via RS-422 and that device is in Remote mode. They are also enabled when reviewing 
a captured clip. However they control the playback of the local clip and not a deck.

Video. Displays video during 
preview, capture or playout.

Timecode/Deck Status. 
Displays timecode in HH:MM:SS:FF format.

Deck Controls When reviewing a clip these 
controls manipulate the locally playing clip.

Jog Wheel
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Figure 6–22. Use VTR controls to preview video from your attached deck or to control playback of 
captured clips.

Fast Reverse. Click to roll tape backward.

Stop. Click to stop the deck.

Play. Click to play video at normal forward speed.

Fast Forward. Click to roll tape forward.

Jog/Shuttle Wheel

Jog. Click and hold the mouse button as you move the mouse in a circular motion to roll the tape forward 
or reverse, frame by frame.

Shuttle. Advance or Rewind the tape using the Shuttle mode. Range +3.0 to -3.0.

Cue. Enter a time code to cue the deck. 
The current time code can be marked using the button:

Go. Click Go, to cue the deck.

USING THE AUDIO PREVIEW PANEL

Use the Audio Preview panel when playing video to see the decibel output of up to 16 channels of audio.

To open or close the Audio Preview panel, click the expand/collapse arrow at the top left corner of the 
panel.

Figure 6–23. The Audio Preview panel displays decibels in real time for each audio channel.

The scale of the meter is -72 dBFS to 0S dBFs.

Note

When playing back captured clips a pause button is also displayed.

Stop 

Fast Reverse Fast Forward

Play
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Disable preview by closing the panel to decrease CPU load during capture.

LOADING AND SAVING CLIP LIST FILES

In all capture documents, Pipeline Control enables you to load the clip list from an EDL or a Final Cut Pro 
XML Interchange file. You can also save a clip list you’ve made, in XML and EDL formats. Loading and 
saving clip lists via files promotes interchange between applications and systems, without manually re-
creating them. These interchange files can be used for time-shifting your work, to avoid performing the 
same actions multiple times, or to participate in workflow tasks with others.

For example, one person can define a list of clips, save the list as an XML file, and then pass the file on to 
someone else on the network who performs the actual capture.

To load a clip list, use one of the following menu items:

File > Import GVG 4 EDL. Select to populate the clip list with entries from a Pipeline EDL file (or other 
GVG 4 compatible files such as those found in Final Cut Pro or Avid Media Composer). Make sure your 
Pipeline configurations are set prior to importing your EDL.

File > Export GVG 4 EDL. Select to save a clip list with entries to a Pipeline EDL file (or other GVG 4 
compatible files such as those found in Final Cut Pro or Avid Media Composer).

File > Import Final Cut Pro XML. Select to populate the clip list with entries from an EDL file in Final Cut 
Pro XML Interchange Format.

Pipeline Control displays an open dialog. Navigate to the location where the file you want to open is stored, 
select it, and click Open to load the clip list.

You can also save clip list entries as a file in GVG 4 EDL or Final Cut Pro XML Interchange Format.

File > Export Final Cut Pro XML. Select to save the clip list in Final Cut Pro XML Interchange Format.

Pipeline Control displays a Save dialog. Enter the name of the file to save, and select the location where 
you want to save the file. Click Save to save the clip list in XML Interchange Format.

XML Interchange Format can be generated from Final Cut Pro, or any other application that supports this 
format. XML Interchange Format is the file format that Pipeline import/export or capture/playout documents 
load from and save in, in order to promote interoperability with other applications. Clip list files can also be 
generated and edited manually.

For further details, refer to Apple’s documentation on XML Interchange Format:

http://developer.apple.com/documentation/AppleApplications/Reference/FinalCutPro_XML/AboutThisDoc/
chapter_1_section_1.html

SETTING UP PIPELINE CONTROL OPTIONS

Select Tools > Options to set up Pipeline Control the way you want to use it.
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Capture Tab
Figure 6–24. Capture Options

Default File Naming Conventions. Enter a phrase to use as the base name for new video files and any 
token types. Token types can be Date, Time, Mark In (inclusive First Frame TC), Mark Out (exclusive Last 
Frame TC), Counter (increments by 1), Pipeline (name), Tape (name), Codec, Frame Rate, and External. 
Only the counter token ensures unique names.

,

Offset. Set the offset size (number of frames): minimum is -16 frames, maximum is +16 frames, default is 
0 frames. Since frames can occur early or late, depending on the deck used, this adjustment offsets the 
capture based on the number of frames chosen and then compensates for decks that are not 100% frame 

Note

Naming Tokens are applied when a clip is added to the clip list. The tokens Mark-In, 
Mark-Out, Date and Time are applied to the name based on the values known at the 
time they were added. If the start or end times are modified (through CalDav or the 
Web Service API), the new start and end values will not be reflected in the clip's name 
at the time of capture.
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accurate (or for systems with routing latency compared to the timecode). This adjustment must be made 
by a process of trial and error.,

Ignore Lost Frames. When checked, a capture session continues even if frames have been lost. If 
unchecked, the capture session aborts when any lost frames occur.

Ignore frames when servo is not locked. When checked, frames are ignored when the servo is not 
locked.

Alert User to Errors. Check to cause a warning message to display if any frame compression errors are 
detected when decompressing the video for preview.

Automatically Eject Tapes. When checked, Pipeline Control ejects the tape when capture is complete. 
The VTR must be in remote mode and connected to the Pipeline via RS-422.

Default Clip Duration. Sets the schedule’s default clip duration when they are added to the schedule 
using the plus (+) button.

Use Duration as frame count. This option applies to files captured by the Trigger document. It is used 
when you want the captured file to contain a certain amount of frames that add up to the duration entered 
into the Duration field. If you know that there will be time code jumps in the incoming media stream, using 
this option will allow your file to have a total duration that includes the time code jumps.

,

Trigger History Size. Use slider bar to limit the number of events that are stored in trigger history from 1 to 
100. Default is 100 events.

Advanced File Flags. Select Write Through to provide caching only when reading from the disk. Select 
None to use caching for disk reading and writing. Select No Buffering to eliminate all read and write 
caching. The default is None.

Note

The frame offset is only applied when a connection with Pipeline is established. To 
apply a new frame offset setting, disconnect, then re-connect with Pipeline.

Note

Capturing with this option enabled will result in files that contain a frame count that 
equals the duration entered into the Duration field. Scheduled events or other captured 
events may continue beyond the original time code represented by the OUT time code. 
Do not use this option if a specific OUT time code is to be used as the stop point. 
Additionally, calendar trigger captures will fail to update if the calendar event is edited, 
and the end parameter will not work for Web service captures.

Note

These options control the flag sent to the native operating system where the Pipeline 
files will be written. They should only be used by advance users who have a full 
understanding of their system and what is required for efficient file writing
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Application Tab
Figure 6–25. Application Options

Default Storage Path. Specifies the default storage path for any container when it is opened. To set, click 
Browse and navigate to the desired storage location.

Web Service Port. The Web Service Port is the TCP port used to communicated to the Master Web API. 
This API allow automated control of the Pipeline Control applications. It also enables the user to add or 
remove Pipeline documents, to activate or deactivate documents, and to get document status. The full API 
command documentation can be listed by entering the URL http://localhost:[port number] into a browser on 
the Pipeline Control computer.

Device Tab
Figure 6–26. Device Options

Preroll Duration. Specify the seconds to preroll video from start timecode during import operations.

Postroll Duration. Specify the seconds to postroll video from end timecode during import operations.

Note

The above settings affect log and capture for capture operations, and insert and 
assemble for playout operations.
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Play Out Tab
Figure 6–27. Play Out Options

 

Buffer Size. Set the buffer size (number of frames) -- minimum 8 frames, maximum 22 frames. The default 
is set at 22 frames to provide maximum reliability.

During playout, the Pipeline queues frames in memory to compensate for network latencies. If the buffer 
size is set for a large number, it can ‘ride out’ higher transient latencies. However, a large number also 
introduces a longer delay between the time the frame is emitted on the network and the time that the frame 
appears on the SDI connection (about 1/4 second for 8 frames, up to about 3/4 second for 22 frames).

If you are concerned with latency between the time video is exported from the computer and the time it is 
sent out the Pipeline, you should adjust the value lower. However, lowering this value makes the 
connection more susceptible to errors due to insufficient CPU power or network bandwidth.

Offset. Set the offset size (number of frames). The minimum is -16 frames and the maximum is +16 
frames. The default is 0 frames.

Frames can occur early or late depending on the deck used. This adjustment offsets the playout based on 
the number of frames chosen and compensates for decks that are not 100% frame accurate to the 
timecode provided. This adjustment is made by a process of trial and error.

Ignore lost frames. Check this option to force Pipeline to ignore all lost frames. When unchecked (normal 
mode) Pipeline halts and alerts the user when a frame is lost.

Preroll Skip. Preroll skip is used when the Controlled Playout document is controlled through RS422 and 
is commanded to preroll back to a timecode prior to the first frame of the clip. This setting should be set to 
a value greater or equal to the value set for Buffer Size in the General section above. Adjust this setting if 
needed to insure frame accurate RS422 playout.

Note

Only applicable when time base is RS422.
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Update Tab
Figure 6–28. Update Options

The Update panel enables you to determine which version of Pipeline Control is installed, when it was last 
checked, and when to check for updates from the Telestream Web site.

Check for Updates. Select Daily, Weekly, Monthly, or Never, to check for application updates.

Check Now. Click Check Now to check Telestream’s Web site for application updates right now, and let 
you know if Pipeline is up to date or updates are available.

Discovery Tab
Figure 6–29. Discovery Options

Use Bonjour for Discovery. Check when you want to automatically discover a list of Pipelines, which you 
can view when you browse, by clicking the Pipeline drop-down list in the Pipeline panel.

Link Local Interface. In most circumstances, auto discovery utilizes the correct link local interface from 
the NIC card on your computer. If you have more than one NIC card or active interface, you may have to 
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select the correct interface. Auto discovery does not operate over routers and gateways, so this feature 
does not enable you to access Pipelines beyond the link local interface – over a VPN, for example. 

Static IP Addresses. If you have Pipelines that you must access and they are not accessible via auto 
discovery, you can add them manually. To add a new Pipeline to the Pipeline drop-down list, enter the IP 
address of the Pipeline in the text field at the bottom left, then click Add. To remove a Pipeline from the list, 
select it and click Remove. Click OK to update the list and close the Options window.

When you click the Pipeline drop-down list in the Pipeline panel, it will display the Pipelines you added 
manually. Capture performance may be poor when connecting to Pipelines via routers and gateways.

Security Tab
Figure 6–30. Security Options

Prevent Configuration Changes. Check to prevent users from altering Pipeline settings without knowing 
the password. Pipeline Control prompts for a password. When you open a document, you can use it and 
make changes to the document itself, but you can’t change Pipeline settings. To turn this security feature 
off, uncheck Prevent Configuration Settings, supply the appropriate password, and click OK.

Licensing Tab
Figure 6–31. Licensing Options

If a Pipeline feature requires a licence, it can be obtained by contacting Telestream, who will need the 
MAC address of the computer running the Pipeline Control software. Once you obtain the license file, 
click Import to navigate to the location of the license file on your computer, then select it and click Open.

After you install a license you will see the message This machine is licensed displayed in the Licensing 
tab window.
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USING THE VIDEO WALL

Select Tools > Video Wall to display the Video Wall. The Video Wall enables you to view multiple video 
sources in one panel and display any channel configured as part of Pipeline Control. Each display 
provides: channel name, status, time code, and audio meters.

To add a new video source to the Video Wall, save the document with a unique name then click and drag  
the Video Preview panel onto the Video Wall, or right-click and select Add to Video Wall. The new source is 
displayed in the upper left hand corner. Additional sources can be added in the same way or by clicking in 
the Open icon at the top of the Video Wall and navigating to the location of the desired source.

When all document displays have been added you can rearrange them by selecting and dragging them to 
a new location. Click the Save icon at the top to save the Video Wall settings. The Activate All switch 
activates all video clips displayed on the wall. Auto Activate, when checked, causes saved video clips to 
activate when Video Wall is re-opened. The slider resizes all video clips in the video wall. They cannot be 
resized individually.

Figure 6–32. Video Wall Display

Note

The Calendar control requires a license. Without a license, the Calendar checkbox is 
greyed out and the message Calendar Trigger is not Licensed is displayed in red.

Open icon

Save icon

Activate All switch

Auto Activate checkbox

Video Size slider

Start All

Stop All
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All Preview displays are framed in a color border. The border color indicates it’s current state: a Yellow 
border indicates a waiting state, green indicates the playout state, red indicates the capturing state, and 
white indicates the previewing state. No border indicates an idle state.

Figure 6–33. Video Wall Display Borders

If capturing into a TIFO container and a MARK-Out Web API command has been issued (see Pipeline 
Web Service API Reference for Mark-IN/Out description) OUT will be displayed in the upper right hand 
corner of the channel's display. The OUT overlay is cleared when a MARK-In command is issued or when 
the capture is complete or stops.

Yellow border - waiting Green border - playout

Red - capturing White - previewing

TIFO Frame State
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Selecting a preview display will automatically highlight the associated channel tab on the Main application 
window.

Figure 6–34. Associated Channel Tab Activation

Each display on the video wall has a right click menu containing: Activate/Deactivate video, Start/Stop 
Capture, and Properties:

Figure 6–35. Right-click Menu

When Properties is selected, a properties window is displayed:

Preview display selected

Associated channel tab activated

Activate/Deactivate video

Start/Stop Capture

Properties
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Figure 6–36. Properties Window Menu

USING THE LABEL EDITOR

The Label Editor enables you to make your own metadata labels. Select Tools > Label Editor to display the 
Label Editor window. 

To create a new label, click the plus (+) button located under Label Files on the left side of the panel. When 
a new label displays, double-click in the name field, enter a new label name, and press Enter. Click the 
minus (-) button to delete labels.

Double-click on the new parameter name displayed and rename. Using the drop-down menu on the right 
side of the window, set the parameter type to Text or True/False. Additional parameters are added by 
clicking the Add button. Parameters are deleted by clicking the Delete button.
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Figure 6–37. Label Editor Window

Labels are used throughout Pipeline Control as metadata that can be attached to clips. In the clip panel 
use the Labels applied to new clips drop-down menu to select a label to be used. Configure or set up the 
label as desired by checking any check boxes and entering parameter metadata. 

Figure 6–38. Applied Labels Window

.

USING THE DIAGNOSTICS PANEL

The diagnostics panel provides easy access to a Pipeline device’s diagnostic and administration interfaces 
for trouble shooting and technical support. The diagnostic panel provides debugging information about 
Pipeline hardware and Pipeline Control that may be useful to Telestream Customer Service (Obtaining 
Pipeline Support | Information | Assistance (page i)).

For more details on troubleshooting, see Gathering Information for Troubleshooting (page 151).

Note

The Reel field in the Log Data label has special properties. Data entered into this field 
will be automatically embedded in QuickTime and Avid MXF OP-Atom files as the Tape 
Name.

Click +  to 
add a label

Click  -  to 
delete a label

Click Add to add a 
parameter

Click Delete to 
delete a parameter

Select Text or 
True/False
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To display or hide the diagnostics panel, click the collapse/expand arrow in the Diagnostics Panel title bar 
located in the lower left-hand corner of the Pipeline system window. (You may need to scroll down to bring 
the Diagnostics Panel into view).

Figure 6–39. Diagnostics window provides advanced information.

Host Memory. .This meter indicates fullness of the frame buffer on the host computer during capture 
operations.

Disk Buffer. This meter indicates how many frames are in the buffer but have not been written to the 
destination.

Pipeline Buffer. This meter indicates fullness of the frame buffer in the Pipeline system.

Pipeline Heap. This meter indicates how much memory in Pipeline is being used and will expose memory 
leaks when it gradually moves toward maximum.

Lost Video, Lost Audio, Lost Status. These fields display the number of lost frame packets of each type 
(if any). The display also shows the name of the Network interface the Pipeline channel is using and the 
connected data rate (100Mb, 1000Mb, etc.).

Telnet. Click Telnet to display a Telnet session window providing access to the Pipeline that is connected. 
This information can be used to diagnose problems.

Log. Click Log to display information recorded during a Pipeline system crash.

Administrator. Click Administer to launch Pipeline Administrator in your Web browser.

During capture operations, low Host Memory meter readings are better; during playout operations, higher 
readings are better. The memory meters display the percentage of the video or audio (whichever is more 
full) frame buffer that is currently full.

During normal operations, the meter displays green. If the meter displays yellow, marginal conditions exist; 
red indicates that Pipeline Control is likely to underflow/overflow the buffer, which will cause the current 
operation to abort.

If disk buffering is enabled (available for certain wrapper formats), the Disk meter displays how much data 
is remaining to be transferred to its final destination (see Disk Buffering, below). When this grows, it 
indicates that Pipeline Control is no longer able to write to the final destination at the same speed it is 
receiving the data, which is usually caused by a network or I/O issue.

FILE FORMATS/WRAPPERS

Format Wrappers
Pipeline Control supports several industry-standard and proprietary wrappers: Avid AAF+MXF (OP-Atom), 
MXF (OP-1a), generic MXF (OP-Atom), QuickTime and TIFO (Telestream Intermediary Format). Pipeline 
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also supports many codecs to meet your compression needs: DV/DVCPro, DVCProHD, IMX, ProRes 422, 
DNxHD, Motion JPEG A (proxy format), MPEG-2 50Mbps I-Frame SD and Uncompressed 8 bit SD.

Avid AAF+MXF (OP-Atom)
Avid AAF+MXF produces MXF Operational Pattern Atom (OP-Atom) files compatible with Avid 
professional edit systems. It can be used with DV25, DVCPro HD, IMX or DNxHD (VC-3) video essences. 
Avid AAF+MXF creates a unique set of files consisting of an AAF master clip file and individual MXF files 
for video and audio.

Workflow Considerations

The AAF file and associated media files can be delivered to separate folders that are specified in the Avid 
AAF+MXF selection dialog. Avid AAF+MXF files cannot be opened while they are being captured. Use 
Avid AAF+MXF when your workflow requires compatibility with Avid edit systems.

Output file naming:

• AAF/XML - <Filename>.AAF and <Filename>.XML, 
(These files are used when importing into Avid edit software.)

• Video – Filename is generated by Avid Media Toolkit

• Audio – Filename is generated by Avid Media Toolkit
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Table 6–2. Avid AAF+MXF Format Summary

Table 6–3. Avid AAF+MXF Applicable Standards

Usage Considerations

The Avid AAF+MXF file wrapper can't be used in conjunction with Pipeline Control's Disk Buffer feature. 
Take extra care when writing Avid AAF+MXF files to shared disk subsystems. 

The maximum length of an Avid AAF+MXF file captured in Pipeline Control is 9 hours. When using a 
Scheduled Capture document, no event can exceed 9 hours. Capturing an Avid AAF+MXF file in a Trigger 
document without first specifying a duration results in a file that reports the exact duration of the recorded 
event.

When you select Avid AAF+MXF format, Pipeline Control displays this configuration dialog:

Video DV, DVCPro, DVCProHD, IMX, DNxHD

Audio 16 channels, 16/24 bit, 48 kHz, PCM/Dolby E

Timecode SMPTE 377M timecode track

Closed captions Essence storage only

Ancillary data SMPTE 436M ANC track/atom

Standard Title Notes

SMPTE 377M-2004 Material Exchange Format (MXF)

SMPTE 390M-2004 MXF Operational Pattern Atom

SMPTE 382M-2007 Mapping AES3 and Broadcast 
Wave Audio into the MXF Generic 
Container.

Each channel contained in a separate 
AES3 track/atom.

SMPTE 383M-2008 Mapping DV-DIF Data into the 
MXF Generic Container

Defines clip-wrapped DV-DIF 
essence.

SMPTE 386M-2004 Mapping Type D-10 Essence 
Data to the MXF Generic Con-
tainer

Clip-wrapped D-10 is not defined 
(Avid is 2KB KAG padded, Apple is 
512B KLV filled).

SMPTE 436M-2006 MXF Mappings for VBI Lines and 
Ancillary Data Packets

SMPTE 2019-4-
2008

Mapping VC-3 Coding Units into 
the MXF Generic Container

Defines clip-wrapped VC-3 essence.
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Figure 6–40. Avid AAF+MXF Dialog Box

AAF File Location. Click Browse to navigate to the desired storage location for the Avid AAF file. This file 
must be saved to a local destination on the Pipeline host. Though the AAF file is not used when registering 
assets via Interplay, Pipeline Control still requires a local path.

MXF Media File Location. Click Browse to navigate to a media directory for the MXF audio and video files 
associated with this clip. Typically, this is the AvidMediafiles/MXF/1 folder used by the Avid edit system. 
This folder can be local or shared storage.

Interplay Settings. Interplay is a production asset management system from Avid. With Interplay media 
assets can be instantly checked into the asset management database and made available to Interplay 
clients for immediate access, even while they are still being captured.

Requirements for using Pipeline with Interplay asset check-in

In order to check-in Pipeline Control captured media assets into an Interplay Production Asset 
Management system you must first have an Interplay system, version 2.2 or later, with all the appropriate 
Avid processes to support Interplay access to indexed media assets.

In addition to a working Interplay system you will also need to have Interplay Web Services installed on 
your Interplay system. Interplay Web Services are not installed or distributed by default. Your Interplay 

Note 

Avid Frame Chase editing (edit while capture) can be performed on assets checked 
into Interplay by Pipeline Control. The assets Video track is updated automatically 
every 600 frames. However, Audio tracks must be updated manually by selecting 
“Update from Interplay” within Avid Media Composer.
December 2015



File Formats/Wrappers
Pipeline User Guide

97
administrator will need to acquire, install and configure Interplay Web Services before Pipeline with 
Interplay asset check-in can be used.

Interplay Web Services must be configured to run using an open port on the Interplay server or servers. 
Your Interplay administrator should install and configure Interplay Web Services on an appropriate server 
using any available port.

The Pipeline host system (running Pipeline Control software) must be a client of the Avid storage system 
allowing it to write media files to the Avid Interplay workspace.

Configuring the Pipeline Avid AAF+MXF with Interplay Settings

AAF File location The AAF file must be saved to a local destination on the Pipeline host. Though the AAF 
file is not used when registering assets via Interplay, Pipeline Control still requires it to be written to a local 
path.

MXF Media file location When checking captured media assets into Interplay this location must be an 
Avid storage workspace being indexed by Interplay.

Web Services Host This is the Interplay Web Service host name or IP Address.

Web Service Port This is the port to which the Interplay Web Service is set. 

Interplay URI Interplay Web Services uses a string referred to as the Interplay URI to reference media 
assets. This URI can have several forms, but it always begins with interplay://<workgroup>  where 
<workgroup> is the workgroup name configured to point to the Interplay Engine. The workgroup setting 
should follow the location of the project folder where captured media assets are referenced.

You can either enter the URI directly, in the form of: interplay://<workgroup>/<project folder>, or you can 
click Browse and navigate to the URI location.

Username and Password These are the Username and Password required to log into the Interplay 
Server.

Testing your Interplay settings When all Interplay information is entered, select Verify Interplay Settings 
to verify that all setting are entered correctly.

MXF (OP-1a)

Workflow Considerations

Opened Open MXF produces an MXF Operational Pattern 1a (OP-1a, SMPTE 379M-2004) file with a 
generic container mapped to DV, DVCPro, DVCPro HD, IMX or DNxHD (VC-3) video essence.

Note

Avid recommends that: 

• Interplay Web Services are installed on a completely separate machine to the Inter-
play database.

• No more than 5 consecutive connections can be triggered at the same time on an 
Avid Web service machine. If capturing multi-feeds the first 5 can start simultaneous 
with the start of the 6th or more staggered by 1 second or more.

Always connect to Interplay and Web Services using a fully qualifies DNS name. 
(Register with Forward and Reversed look up tables in the DNS.).
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Use Open MXF when your workflow requires the video and audio essence to be wrapped in a single file 
meeting the SMPTE 379M-2004 generic MXF specification. To produce an MXF D-10 file use Open MXF 
in conjunction with the IMX video codec.

Closed Produces an MXF Operational Pattern 1a (OP-1a) file compatible with Sony XDCAM with essence 
containers mapped to DV, DVCPro, DVCProHD, IMX or DNxHD (VC-3). These files can't be opened while 
they are being captured. 

Use 'Closed' when your workflow requires the video and audio essence to be wrapped in a single file 
compatible with Sony XDCAM MXF or when capturing MXF (OP-1a) clips to be imported into an Avid 
system.
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Table 6–4. Generic MXF Format Summary

Table 6–5. MXF Applicable Standards

The resulting MXF (OP-1a) file can contain VANC data (SMPTE 436M) if present within the incoming SDI 
stream.

Usage Considerations

Due to the structure of an MXF OP1a Closed file container these files cannot be used in conjunction with 
Pipeline Control's Disk Buffer feature. Take extra care when writing MXF (OP-1a) Closed files to network 
disk subsystems.

The maximum length of an MXF (OP-1a), Open or Closed file, captured with Pipeline Control is 9 hours.

Video DV, DVCPro, 
DVCProHD

IMX DNxHD

Audio 16/24 bit, 48 kHz

16 channels 8 channels 16 channels

PCM/Dolby E PCM/DolbyE PCM/Dolby E 

Timecode SMPTE 377M Timecode track

SMPTE 385M System item SMPTE 405M System item

Standard Description Notes

SMPTE 331M-2004 Elements and Metadata Definitions for SDTI-CP

SMPTE 377M-2004 Material Exchange Format (MXF)

SMPTE 378M-2004 MXF Operational Pattern 1a

SMPTE 379M-2004 MXF Generic Container

SMPTE 382M-2007 Mapping AES3 and Broadcast Wave Audio into 
MXF Generic Container

DV (AES3), DNxHD 
(BWF)

SMPTE 383M-2008 Mapping DV-DIF Data into MXF Generic Con-
tainer

DV

SMPTE 385M-2004 Mapping SDTI-CP Essence and Metadata into 
MXF Generic Container

DV, IMX

SMPTE 386M-2004 Mapping Type D-10 Essence Data to MXF 
Generic Container

IMX

SMPTE 394M-2006 System Scheme 1 for MXF Generic Container DNxHD

SMPTE 405M-2006 Elements and Individual Data Items for MXF 
Generic Container System Scheme 1

DNxHD

SMPTE 436M-2006 MXF Mappings for VBI Lines and Ancillary Data 
Packets.

SMPTE 2019-4-
2008

Mapping VC-3 Coding Units into MXF Generic 
Container

DNxHD

SMPTE RDD03 eVTR MXF Interoperability Specification DV, IMX
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Pipeline system’s MXF OP-1a Closed files always results in an MXF file that reports the exact duration of 
the recorded event, even if stopped prior to reaching its initial duration. In contrast when capturing MXF 
OP1a Open the duration contained in the file will report the initial duration even if stopped prior to reaching 
that duration. If no duration is specified MXF OP1a Open files will report a duration of 9 hours.

These files can be added to Final Cut Pro systems by using Flip4Mac MXF or MXF4Mac components, and 
to Avid Media Composer systems utilizing the Avid AMA MXF plug-in.

When you select MXF (OP1a) format, Pipeline Control displays this configuration dialog:

Figure 6–41. MXF OP-1a Dialog Box

File Location. Click Browse to navigate to a storage directory for your media files.

Format – Open. MXF OP1a produces an MXF Operational Pattern 1a (OP1a, SMPTE 379M-2004) file 
with a generic container mapped to DV, DVCPRO, DVCPRO HD, IMX or DNxHD (VC-3) video essence.

Use Open MXF when your workflow requires the video and audio essence to be wrapped in a single file 
meeting the SMPTE 379M-2004 generic MXF specification. To produce an MXF D-10 file use the IMX 
video codec.

Format – Closed. MXF OP1a produces an MXF Operational Pattern 1a (OP1a) file compatible with Sony 
XDCAM with essence containers mapped to DV, DVCPRO, DVCPRO HD, IMX or DNxHD (VC-3). These 
files cannot be opened while they are being captured. 

Use Closed when your workflow requires the video and audio essence to be wrapped in a single file 
compatible with Sony XDCAM MXF or when capturing MXF OP1a clips to be imported into an Avid 
system.

Settings. Within the Settings section you can choose None, Insert HD VANC track, or Insert 
Uncompressed VBI track. These settings are only applicable when capturing from a Pipeline HD Dual 
channel.

Note

MXF OP1a files created for ingest into Avid Media Composer via AMA cannot contain a 
VANC track. This is a limitation of the currently release of Avid Media Composer.
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Select None if you do not require SMPTE 436M data.

Select Insert HD VANC track if you require HD VANC data to be inserted in accordance with SMPTE 436M 
standard. Use the slide bar to set VANC data size from 64 to 65K.

Select Insert Uncompressed VBI track if you require SD Uncompressed VBI data to be inserted in 
accordance with SMPTE 436M standards. Use the VBI Line slide bar to select the first VBI line. Use the 
Count slide bar to select the number of lines. When inserting Uncompressed VBI you must also set the 
firmware option Capture uncompressed VBI lines (HD units only) for SD codecs only.

Advanced. Select if Data Disk Buffering will be used. Browse to the local disk buffering disk location. See 
Disk Buffering Details (page 36) for details.

Generic MXF (OP-Atom)

Workflow Considerations

MXF (OP-Atom) produces MXF Operational Pattern Atom (OP-Atom) files compatible with professional 
edit systems. MXF (OP-Atom) can be used with DV/DVCPro, DVCProHD, IMX or DNxHD (VC-3) video 
essences. MXF (OP-Atom) creates a unique set of files consisting of individual MXF files for video, audio 
and Data. A separate MXF file will be created that contains any VANC data present within the incoming 
SDI stream.

Output file naming:

• Video - <Filename>.MXF

• Audio - <Filename>nn.MXF, where 'nn' is a number between 00 and 15

• Data - Filename>D.MXF 

Pipeline's MXF (OP-Atom) files are not intended to be used with Avid Media Composer MXF AMA plug-in. 
Use Avid Media Tool directly or Interplay to add them to your media database. 

Table 6–6. MXF OP-Atom Format Summary

Table 6–7. MXF OP-Atom Applicable Standards

Video DV, DVCPro, DVCProHD, IMX, DNxHD

Audio 16 channels, 16/24 bit, 48 kHz, PCM/Dolby E

Timecode SMPTE 377M timecode track

Closed captions Essence storage only

Ancillary data SMPTE 436M ANC track/atom

Standard Title Notes

SMPTE 377M-2004 Material Exchange Format (MXF)

SMPTE 390M-2004 MXF Operational Pattern Atom

SMPTE 382M-2007 Mapping AES3 and Broadcast 
Wave Audio into the MXF Generic 
Container.

Each channel contained in a separate 
AES3 track/atom.

SMPTE 383M-2008 Mapping DV-DIF Data into the 
MXF Generic Container

Defines clip-wrapped DV-DIF 
essence.
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Usage Considerations

The MXF (OP-Atom) file wrapper can be used in conjunction with Pipeline Control's Disk Buffer feature.

The maximum length of an MXF (OP-Atom) file captured in Pipeline Control is 9 hours. When using a 
Scheduled Capture document, no event can exceed 9 hours. Capturing an MXF (OP-Atom) file in a Trigger 
document without first specifying a duration results in an file that reports the exact duration of the recorded 
event.

When you select MXF (OP-Atom) format, Pipeline Control displays this configuration dialog.

Figure 6–42. MXF OP-Atom Dialog Box

File Location. Click Browse to navigate to a storage directory for your media files.

Format – Open. Open pre-allocates a fixed file size. Use Open MXF OP-Atom when your storage system 
requires that you pre-allocate all the space you will need up front.

.

Format – Closed. Closed allocates the file size as the video is ingested. This is the default method of 
creating MXF OP-Atom. 

SMPTE 386M-2004 Mapping Type D-10 Essence 
Data to the MXF Generic Con-
tainer

Clip-wrapped D-10 is not defined 
(Avid is 2KB KAG padded, Apple is 
512B KLV filled).

SMPTE 436M-2006 MXF Mappings for VBI Lines and 
Ancillary Data Packets

SMPTE 2019-4-
2008

Mapping VC-3 Coding Units into 
the MXF Generic Container

Defines clip-wrapped VC-3 essence.

Note

Open MXF OP-Atom files can only be written to the local attached storage folders, 
shared Windows-based file system folders, or Windows-based file system NAS folders.
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Settings Insert VANC. VANC data can be inserted in accordance with SMPTE 436M standard. Use slide 
bar to set VANC data size from 64 to 65K.

Advanced. Not applicable for this wrapper type.

QuickTime
QuickTime 'Open' files created by Pipeline Control can be edited in Final Cut Pro (and other media edit 
applications) as they are being captured. Use the 'Open' or 'Open+Ref' file format if you will be editing or 
reviewing (playing out in QuickTime player) while capturing. Because of this unique characteristic 
Pipeline's 'Open' QuickTime files initially set the header with the duration entered or if an overall duration is 
not specified with the maximum duration of 9 hours. In most circumstances the actual final duration is 
updated after the capture is complete. The one exception is when Disk Buffering is employed. In this case 
the duration will be that which was initially updated or the maximum duration of 9 hours. 

Workflow Considerations

Be aware of the disk I/O implications of an edit while capture workflow by reading Typical Pipeline Systems 
and Considerations in the Pipeline Control User Guide.

QuickTime 'Closed' files are traditional QuickTime files that can't be opened while they are being captured. 
Use 'Closed' files if you will not be editing or reviewing (playing out in QuickTime player) while capturing.

Table 6–8. QuickTime Open Format Summary

Table 6–9. QuickTime Open Applicable Standards

Usage Considerations

The maximum length of an open QuickTime file captured in Pipeline Control is 9 hours. 

If closed captions are available in the source during capture, they are automatically embedded into a

Note

When writing files to a shared folder on a Windows computer, the security settings 
must allow full read/write for the user accessing the file for edit.

Video SD, Motion JPEG-A, DV, DVCPro, IMX, MPEG2-I, DVCProHD, ProRes, 
DNxHD

Audio 16 channels, 16/24 bit, 48 kHz, 1/2 channels per track

Timecode Timecode ('tmcd') track

Closed captions Closed caption ('clcp') track, EIA-608 caption data

Ancillary data Essence storage only

Standard Title

IEC 14496-14 MP4 File Format

QuickTime File Format Specification
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QuickTime closed caption track. When played in QuickTime Player, the closed caption data is overlaid on 
the video by selecting View > Show Closed Captioning.

These files can be added to Final Cut Pro systems directly or to Avid Media Composer v5 systems utilizing 
the Avid AMA QuickTime plug-in.

When you select QuickTime format, Pipeline Control displays this configuration dialog.

Figure 6–43. QuickTime Dialog Box

File Paths Storage. Click Browse to navigate to a storage directory for your media files.

Format Open/Closed. Select Open or Closed QuickTime format.

Format Open/Closed/Open+Ref. Select the desired QuickTime format:  Open, Closed or Open + Ref

• Open: Open files are written in a way that allows some application to read it while capture is still in prog-
ress. These files are pre-indexed and will be larger than traditional QuickTime files.

• Closed:  Closed QuickTime files are created in a traditional way and cannot be opened while they are 
being written to.

• Open + Ref:  If selected an Open and QuickTime reference file are created concurrently to the selected 
file location. The reference file will be named [FILENAME].ref.MOV.

Settings - Insert Caption Track. Check Insert Caption Track to insert a track for captioning. 

Settings - Open File Timecode Coherence. Check Open File Timecode Coherence to cause the 
QuickTime file writer to lay down incoming frames at the correct position in the QuickTime movie. When 
input discontinuities occur, empty frames are inserted so that the timecode stays in sync. If input 
discontinuities are ignored, empty frames in the middle of the movie will result, but the timecode will be 
correct for all good frames.

Advanced. Select if Data Disk Buffering will be used. Browse to the local disk buffering disk location. See 
Disk Buffering Details (page 36) for details.

Telestream Intermediary Format (TIFO)
Telestream Intermediary Format (TIFO) is an intermediate media wrapper format designed by Telestream 
as a uniform, interchangeable file format to ensure inter-operability among Telestream's media processing 
solutions, including FlipFactory, Vantage, Wirecast, Episode, and Pipeline. TIFO provides a lightweight, 
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low-overhead wrapper that is essence-agnostic, with out-of-band metadata, timecode, and closed caption 
support.

Using TIFO improves the ability to move media files between Telestream's media processing solutions with 
all media essence elements and metadata intact, preserving the widest range of transcoding options.

Workflow Considerations

TIFO format should be used when you are encoding your files for use with FlipFactory, Vantage or 
Episode. TIFO files are unique, in that they can be transcoded as they are being captured in FlipFactory, 
Vantage, Episode 6 and Episode Engine, enabling you to create multiple output files in real-time. TIFO files 
can also contain metadata such as closed captions, ancillary data and timecode, which can be processed 
by FlipFactory, Vantage or Episode for processing in workflows that retain this data.

Table 6–10. TIFO Format Summary

When you select TIFO format, Pipeline Control displays this configuration dialog:

Figure 6–44. TIFO Dialog Box

File Location. Click Browse to navigate to a storage directory for your files.

Estimate Duration in header. Check this box if you are writing files to be processed by Episode. TIFO 
version 4 adds an anticipated duration to the file header which allows applications using TIFO to display an 
accurate progress bar while processing these files.

Advanced. Select if Data Disk Buffering will be used. Browse to the local disk buffering disk location. See 
Disk Buffering Details (page 36) for details.

Video SD, Motion JPEG-A, DV, DVCPro, IMX, MPEG2-I, DVCProHD, ProRes, 
DNxHD

Audio 16 channels, 16/24 bit, 48 kHz

Timecode Video sample header

Closed captions Video sample parameter (“ATOM”)

Ancillary data Video sample parameter (“ATOM”)
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C H A P T E R 7

U s i n g  S c h e d u l e d
C a p t u r e  D o c u m e n ts
Chapter 7, Using Scheduled Capture Documents

Use this chapter to learn how to use Pipeline Control to create schedules for capturing media from 
Pipeline. Capturing media on a schedule is achieved using the Scheduled Capture document in Pipeline 
Control. 

Topics

 Using The Scheduled Capture Document (page 108)

 About Schedules (page 108)

 Creating Capture Schedules (page 109)

 Using the Schedule Panel (page 110)

Note

You can only play out schedule documents in Pipeline Control on Mac OS X. Use the 
Controlled Playout document for similar results on Windows OS.
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USING THE SCHEDULED CAPTURE DOCUMENT

The Scheduled Capture (schedule, for short) document is designed to facilitate the creation of clip capture 
schedules.

Figure 7–1. Schedule window panels and toolbars.

Pipeline Control displays several panels and toolbars to help you perform the tasks the document was 
designed to facilitate.

The schedule document is composed of a 24-hour schedule panel (on the right), with Pipeline Status, 
Video Preview, Audio Preview, and Diagnostics panels on the left. You can open multiple documents at a 
time – each is displayed in its own tab.

ABOUT SCHEDULES

A schedule is a list of one or more clip events to be processed in a recurring 24-hour period. Each 
schedule also has information about Pipeline selection and settings, and optional publisher specifications. 
Each schedule document is displayed in a different tab. Because Pipeline Control is a multi-document 
application, you can open, edit, and execute several schedules (or other documents) at the same time. 

Status Panel. 
Displays status. 

Video Panel. 
Displays video.

Timecode. 
Displays when 
connected.

VTR Controls. 
Use to play video.

Schedule 
panel. 
Displays 
all clips in 
a timeline.

Audio Panel. 
Displays volume 
by channel.

Clips. Add these clips to capture on 
schedule.

Settings Panel. Use to configure Pipeline 
for use in this schedule.

Schedule Details. Displays number of clips, total 
capture hours, and approx. space required.

Schedule Toolbar. Provides buttons 
for frequently used functions.

Schedule/List 
View buttons.

Activation 
Slider.

Diagnostics 
Panel.

Event 
Timer. 
Indicates 
current time 
in schedule.
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The number of media files you can capture or play out simultaneously is based on the power of the CPU 
and disk write speed in your computer and your network bandwidth (Disk and Network Requirement by 
Media Format on page 38).

Creating Schedules. To create a schedule, select File > New Schedule to display a new schedule 
document. To save a schedule, select File > Save or Save as, name the document and select a folder to 
save it in. When you save a schedule, it is saved as a document. You can copy Pipeline Control 
documents and move them to other folders or other computers. You can work with Pipeline Control 
documents just like you do any other document.

When you close a schedule window, if it hasn’t been saved before, you’ll be asked to name it. If you’ve 
changed it, you’ll be asked if you want to save changes 

Each schedule contains several groups of information: the selected Pipeline and its settings, plus a list of 
one or more clips arranged in a 24-hour time line, their name and optional metadata, and publishers, if any. 
Pipeline Control uses the schedule information to execute each clip event (at the correct time) to either 
capture or playout the clip (playout is available on Mac OS X only).

Schedules are Symmetrical. That is, if you capture a given schedule, Pipeline Control runs the schedule 
and ingests encoded media from a specific Pipeline’s SDI port based on the clip events you’ve created in 
the schedule, and saves it as a specific type of file, based on your settings. On Mac OS X, you can also 
play out the same schedule and the reverse occurs: each file you specify with a clip event is opened at the 
correct time and the media is played out to the specified Pipeline for decoding and playout as SDI.

You can create and configure as many schedules as you need to organize your Pipelines, workflows, and 
tasks efficiently. You might create schedules for each Pipeline you’re using, or you might create schedules 
for a specific set of clips you need to capture or play out each day (or work shift). Or, you can create 
schedules based on how you want the media encoded, for use in an edit system, for example.

Pipeline Control will automatically reconnect a schedule document if network connectivity or video signal is 
lost, and continue processing events. If an event is being recorded or played out, the file (or output of the 
file) is invalid.

CREATING CAPTURE SCHEDULES

A capture schedule is a schedule with one or more clips, which you use to capture SDI video in real time. 
The SDI video is converted to a specific media format, depending on the codec you specify in the Pipeline, 
and saved as a digital media QuickTime or TIFO file by Pipeline Control.

Here are the steps you’ll take to create and use a capture schedule:

1. If Pipeline Control isn’t running, start it now (Starting Pipeline Control on page 59).

2. Create a new, untitled Scheduled capture document (Select File > New Schedule) if one isn’t open.

3. Select the Pipeline device which is supplying the video feed you want to capture (Selecting a Pipeline 
(page 65)).

4. Select the video codec and configure it to meet your video encoding requirements (Selecting and 
Configuring a Video Codec (page 66)).

Note

Active schedules must first be deactivated to close them. You may be interrupting a clip 
capture — so check first.
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5. Likewise, configure the audio codec to meet your audio encoding requirements (Configuring the Audio 
Codec (page 67)).

6. Specify your timecode clock source (Selecting a Timecode Clock Source (page 67)).

7. Select your wrapper (file) format (Selecting and Configuring Codecs (page 65)), configure it, and 
specify the storage location where you want your media clips saved.

8. Set up handles as necessary (Setting up Handles (page 68)).

9. Optionally, select and configure a publisher to perform additional actions as part of a workflow 
(Selecting a Publisher (page 68)).

10. Save your schedule and name it, then continue.

11. Add one or more clip events to the schedule (Creating Clip Events (page 112)).

12. For each clip, enter a file name if you want it to be different than the default, and optionally, select a 
metadata label and enter metadata (Editing a Clip Event’s Property Sheet (page 114)).

13. Save the schedule.

14. Click Capture to place the schedule into capture mode.

Pipeline Control displays the incoming video stream – verify the stream is what you expect. Pipeline 
Control waits for each clip event, and saves each clip as a file using the settings you specified.

USING THE SCHEDULE PANEL

The schedule panel (on the right side of the window) is a vertically-oriented view of a 24-hour period. A 
time scale displays on the left, with space on the right to add clip events. The time is controlled by the 
timecode clock source you specify.

Figure 7–2. The schedule panel allows you to create clip events.

At the far left is a toolbar with buttons for frequently used functions. Above the event area is a Schedule/
List view button that enables you to display the complete schedule or just a table of events. 

Event Timer. Indicates current time 
in schedule.

Clip Event. Click and drag to 
create a new event.

Schedule/List View. Click to display the full event list 
in schedule view or just display the list of clip events. 

Schedule Toolbar. 
Provides buttons for 
frequently used 
functions. 

Activation Slider. Indicates current 
state; slide to activate/deactivate.
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Activation Slider. Click to activate (place the schedule in active mode) the schedule, when connected to a 
Pipeline. Clip events are captured as files as they occur in the schedule. In this mode, locks display on 
clips and you can’t edit the schedule (add, edit, delete or play clips) or change your settings. When a clip 
event is executed, the current settings in the Pipeline Settings panel are used, even if they are not saved. 
Pipeline Control does not automatically save settings. To save settings, select File > Save.

When you activate a schedule, Pipeline Control checks to make sure you have enough space for the clip 
events on your schedule.

For a schedule to remain active, the Pipeline Control application must be open and the Schedule 
document must also be open. If the Pipeline Control application or the Schedule document is closed, clip 
events aren’t executed.

Clip Events

You add clip events by clicking and dragging the mouse in the schedule panel.

Figure 7–3. Clip events in your schedule provide details about the clip.

When you add a new clip event by clicking the Add Clip button, it is created on the nearest half hour. You 
can resize a clip (up to 9 hours long) by dragging either the top or bottom and resizing it. You can also snap 
to present lengths at half the displayed timescale. For example, with the timescale displaying 1 minute 
increments, snap to 30 second increments by pressing the control key while resizing the clip. To snap the 
top time, control-click and drag the top of the event. 

You can zoom in to increase your view of the schedule with greater detail, and create smaller clip lengths. 
You can also edit the time down to the second by right-clicking the clip event and selecting Edit (or select 
the clip then select Clip > Edit) to display its property sheet.

Preview Thumbnail. Assigned when you created the mark-in point.

Status Badge. Status badge (Table 7–1 on page 112) to indicate the state of this clip.

Progress Bar. When capturing, colored yellow for captured and green for written to disk, indicating 
progress toward completion.

Review Controls. When file has been captured and closed, use these controls to view your clip locally.

Clip Status Badges

Each clip is marked with status badges to help you identify the state of each clip at a glance.

Thumbnail. 
Displays thumbnail 
of clip.

Progress Bar. Helps you 
track capture progress.

Review Controls. For local clip playback.

Status Badge. Indicates capture status.

Details. Start and stop time code, event name.
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Table 7–1. Status badges and their descriptions.

Schedule Panel Keyboard Shortcuts

You can work with clips in your schedule using the following keyboard shortcuts:

Delete | Backspace. Deletes the selected clip event

Page Up. Select the previous clip event

Home. Select the first clip event

Page Down. Select the next clip event

End. Select the last clip event

Up Arrow. Move the selected clip up the schedule by the current block size (half hour, quarter hour, 
minute, thirty seconds, etc.), based on your current zoom increment.

Down Arrow. Moves the selected clip event down by the current block size.

Creating Clip Events

To add a clip event to a schedule, choose one of two actions:

• Move your cursor into the schedule panel and position it at the approximate start time. Now, click and 
drag downward for a maximum of 9 hours or until the end of the clip event (you can adjust the time 
accurately later) and release the button.

OR

Status Badge Description

Pipeline Control attempted to capture the clip, but failed. This may be due to lack 
of storage, network or Pipeline problems, or excessive pre-roll at the beginning of 
a tape, for example. Resolve the problem and retry. Using the mouse, hover over 
the icon to display additional information.

This clip is being closed. All media has been captured, but it has not been com-
pletely written to the file yet – possibly due to use of buffering.

This clip event has not been captured yet.

This clip is currently being opened/created, but no media has been captured yet.

This clip is in the process of being captured.

This clip has been successfully captured and the file has been closed.
December 2015



Using the Schedule Panel
Pipeline User Guide

113
• Click the Add Clip icon (the plus sign icon) at the top of the schedule toolbar or select Clip > Add.

Once a clip has been added to the schedule, you can drag it up and down the timeline to change the start/
stop time. Or, open the property sheet (right-click and select Edit or select the clip then select Clip > Edit) 
and adjust the start and stop time. You can’t create a single clip event lasting longer than 9 hours.

When clips are captured, they are saved in the folder specified by the storage location in your wrapper.

You can move a clip by clicking in the clip event and dragging it up or down. This avoids the necessity of 
moving a clip by adjusting both the start and stop times correctly. You can’t overlap clip events on a 
schedule.

To play a clip that has been captured, use the review controls.

Deleting Clip Events.

To delete a clip event you’ve selected, choose one of these actions:

• Press the Delete key or the Backspace key. 

• Click the X icon to the left of the schedule

• Right-click and select Clear from the context menu.

Once a clip has been placed on the schedule, you can drag it around to change their times. Or, you can 
open the property sheet and adjust their start and stop time. You can’t create a single clip event lasting 
longer than 9 hours.

Showing Media on Your Desktop

When an event is connected to a local file, you can open the folder that contains the file directly.

Note

This will not delete the captured clip, just the event.
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Pipeline Control sends a command to the operating system to display the clip in the enclosing folder:

Figure 7–4. Pipeline Control displays the video clip’s folder.

Editing a Clip Event’s Property Sheet

Each clip event has its own property sheet. To display a clip event’s property sheet:

• Select the event and select Clip > Edit

• Select the clip and click the i icon in the toolbar to the left of the timeline

• Right-click to display the context menu and select Edit. 

Properties are displayed in General and Embedded tabs, and other metadata tabs based on publishers.

Viewing and Updating General Properties

To view or update the general properties of an event, select the clip, then select Clip > Edit. Click the 
General tab to display this sheet. Alternatively, hover over the event and right-click to select Edit on the 
context menu.

Figure 7–5. Clip event general properties.

Start and End Time. Edit the digital clock to adjust the start and end times of the clip event.

Lock. Click the lock (to display the locked icon) to cause Pipeline Control to adjust the start or end time 
while maintaining the duration. Click again (to display the unlocked icon) to modify the duration.
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Name. Enter a name for the clip in the text field and, optionally, select naming tokens..

Color. Select a color to use when displaying this clip event in the schedule panel.

Click OK to save your changes or click Cancel to leave them unchanged.

Viewing and Updating Metadata Labels

To view or update the label values of a clip event, edit the clip. Then, to display this sheet, click the Labels 
tab you want to edit (there may be more than one metadata label). The Embedded label is always 
available. Other labels (including FlipFactory labels, Final Cut Pro, and QuickTime) are displayed 
appropriately.

Values you enter in the Embedded label are stored directly in the file that is created.

Figure 7–6. Clip event label values.

Click OK to save these values or click Cancel to leave them unchanged.

Log Data.

At any time when a clip list is displayed, you can view or edit metadata. To view or edit metadata, click the 
Log Data tab to display the log data:

Figure 7–7. Log Data.

Edit the values for each metadata tag, Click OK to close the window and save the metadata.

Note

If you want the video files to be overwritten on a 24-hour basis you can use the mark-in 
token.

Enter metadata values.
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Using the Schedule Toolbar

The schedule toolbar displays vertically, on the left of the schedule panel. It provides easy access to 
various schedule commands you use to create and manage clip events.

Figure 7–8. Schedule Toolbar.

Add Clip. Use to add a new clip event. Each time you add an event, it is added as early in the schedule as 
possible, where space is available. The newly-created clip is automatically selected so that you can 
immediately display its properties and add metadata, or adjust start and stop times.

Information. Click to display the property sheet for the selected clip.

Review. Play the local clip (after its been captured) of the selected event in the Video Preview panel.

Delete. Click to remove the selected clip event from the schedule. When you remove a clip event, the 
actual file that it references (if present) is left intact – it is not deleted.

Zoom. When you zoom out all the way, on most monitors you can view the entire schedule from an hourly 
perspective. As you zoom in closer and closer, you can view half and quarter hours, 5 minutes, one 
minute. Zoom to the magnification that is best for the size of clips you’re working with.

You can also zoom the schedule by repeatedly clicking the left arrow (to zoom out) or right arrow key (to 
zoom in).

Select and show the first event. Click to select and zoom in on the first event in the schedule.

Select and show the previous event. Click to select and zoom in on the event immediately prior to the 
currently-selected clip.

Go to Current Time. With the time source (Auto, RS-422, etc.) and Pipeline selected, click to scroll the 
schedule so that the current time is as close to the center of the schedule as possible, so that it is visible. If 
you are not connected to a Pipeline device, Pipeline Control displays the schedule beginning at midnight.

Select and show the next event. Click to select and zoom in on the next event after the selected clip.

Select and show the last event. Click to select and zoom in on the last event in the schedule.

Add a new clip event

Display properties of the selected event
Review local clips
Delete the selected event

Select previous event

Select first event

Select next event

Zoom Slider

Select last event

Go to the current time
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Chapter 8, Using Log & Capture Documents

You can use Log & Capture documents in Pipeline Control to create and save clip lists, and capture media 
defined by the clips in various formats via Pipeline, independently of your video editing/encoding software.

You can capture and encode clips in any supported SD or HD essence and file format/wrapper.

Topics

 Creating Clip Lists for Log and Capture (page 117)

 Using the Log & Capture Document (page 118)

 Using Log & Capture Controls in the Preview Panel (page 119)

 Using the Clip List Panel (page 120)

CREATING CLIP LISTS FOR LOG AND CAPTURE

To encode and capture media clips from a VTR, follow these steps:

1. Create New Log & Capture Document. If a Log & Capture document isn’t open, select File > New 
Log & Capture to create a new, untitled Log & Capture document or open an existing Log & Capture 
document.

The Clip List panel, on the right, includes the General Tab for mark-in and mark-out points, metadata 
tabs, plus the clip list at the bottom. For details, see Using the Clip List Panel (page 120).

2. Select and Configure your Pipeline. If you haven’t already selected and configured Pipeline for this 
task, do so now. After configuring Pipeline for your workflow requirements, save the file. For details, 
see (Using The Pipeline Settings Panel (page 64)).

3. Preview your Media Stream. When you connect, streaming media (if present) displays in the video 
panel. If you’re connected to a VTR and it is in Remote mode, you can control your video using the 
VTR controls directly in Pipeline Control.

Note

When capturing media from Pipeline Quad, you can perform confidence monitoring to 
qualify your video. See Confidence Monitoring (page 51).
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4. Create a Clip List. Insert tapes in your VTR, then use the VTR controls to scrub media, create mark in 
and mark out points (General Tab), add metadata as necessary, then click the Log button to create the 
clip and add it to the list.

If you want to capture clips from multiple tapes, enter the name of the tape (or category) in the 
General > Tape field for the clip you’re creating. Before capturing clips, select the tape (or category) 
from the clip list on the left, to display the clips you want to capture. You can use the tape name to filter 
your list. Alternatively, import an EDL to automatically create your clip list. (See Loading and Saving Clip 
List Files (page 81) for details.)

5. Capture the Clips. Click the Activation slider (top right) to activate the document and capture the clips 
displayed in the clip list and save each one as a file. To capture clips from multiple tapes in one session, 
select All Tapes (Click the word All) before activating the document to capture your clips. You will be 
prompted to insert the correct tape when necessary and (if selected in preferences) the previous tape 
will be ejected.

USING THE LOG & CAPTURE DOCUMENT

The Log & Capture document is designed to facilitate logging and capturing clips.

Note

Generally, Log and Capture will be performed using a VTR controlled by an RS422 
interface. However, as a convenience to our customers, the Pipeline Log and Capture 
interface allows clips to be logged and captured in workflows that are not being 
controlled using RS422. In these cases a warning is displayed indicating the lack of 
RS422 control. This allows the user to continue operation using manual control of the 
incoming signal.
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Figure 8–1. Use the Log & Capture document to create clip lists and capture media from Pipeline.

Pipeline Control displays several panels and toolbars to help you perform the tasks the document was 
designed to facilitate. Each panel, toolbar, and feature is described below.

For details on how to use the Pipeline Settings panel and all panels and controls on the left, see Chapter 6, 
Using Pipeline Control (page 57). 

The log and capture document is composed of data entry tabs and a clip list (on the right), including tape 
names when logging clips from multiple tapes, with Pipeline State, Video Preview, Audio Preview, and 
Diagnostics panels on the left. You can open multiple document at a time – each is displayed in its own tab.

USING LOG & CAPTURE CONTROLS IN THE PREVIEW PANEL

In addition to the panels and controls described in (Using The Video Preview Panel on page 79), the 
Preview panel in Log & Capture window has additional controls to support log and capture activities.

Figure 8–2. Timecode, VTR, jog wheel & control status indicators in the Log & Capture window.

Clip List Panel

Mark In Button

Mark Out Button

Log. Click to add a clip 
to the clip list.

Click to begin 
capturing clips.

Activation Slider

Document Details. Displays number of clips, total capture hours, and approx. space required.

VTR Tape Status 
Indicator

Deck RS-422 Control 
Status Indicator

VTR Remote 
Status Indicator

Alarm Status

Jog Wheel/Shuttle
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VTR Tape Status 

Tape In. Displays when a tape is in the attached VTR.

Tape Out. Displays when a tape is not in the attached VTR.

Deck RS-422 Control Status

NO RS-422. Displays when Pipeline does not have control over the attached VTR.

RS-422. Displays when Pipeline has control over the attached VTR.

Alarm Status

ALARM. Displays when the deck has an outstanding alarm.

<blank>. Displays when there is no outstanding alarm.

USING THE CLIP LIST PANEL

The Clip List panel displays on the bottom of the Log & Capture window – it includes the clip list. Each of 
the tabs holds metadata for the selected clip.

Figure 8–3. The Clip List panel allows you to work with and capture clips.

Replace the current 
preview thumbnail 
with the frame 
currently displayed 
in the Preview 
panel.

You can create clips 
from multiple tapes, 
identified by tape 
name. Select the tape 
you want to capture 
from (or All Tapes) 
before clicking the 
active slider above

General & other 
metadata tabs.

Click to add a new 
clip to the clip list.

Click a clip to select it; 
double-click to edit its 
values.

Click to activate this document and capture each clip 
from the selected tape (or all tapes).

Remove the current 
preview thumbnail.

Current preview thumbnail.

Remove all clips from 
the selected batch list.

Mark in & out controls.

Clip name & tape ID

Click to enable 
timecode break 
detection.
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General Controls and Detail Fields

The following controls in the General tab perform certain functions or contain details about the clip:

Clip Status Badges

Each clip is marked with status badges to help you identify the state of each clip at a glance.

Control Description

Located at upper right, slide the activation slider to the right (to activate the 
document) when you’re done creating or modifying your clip list. Activate your 
document to capture the clips for the selected tape or all tapes and save the files. 
Slide to the left to deactivate the document – stopping any capture in progress – 
when you want to edit the document or close it.

Pipeline Control captures clips by controlling the VTR via the Pipeline to encode 
the clip and stream each clip’s media to Pipeline Control, which writes the media 
out to a file, and saves each file in the destination folder.

When the capture process completes, Pipeline Control disconnects from the 
Pipeline.

Located directly under the thumbnail frame, click to replace the current thumbnail 
frame with the frame currently displayed in the Video Preview panel.

Located directly under the thumbnail frame, click to remove the current thumbnail 
frame.

Located below the thumbnail frame, directly above the clip list, just right of the 
Clear button. Click to add the new clip to the clip list along with clip values and 
metadata. Make sure to use the correct tape name, if you’re using multiple tapes.

Located between Log and Clear buttons. Check to create a new clip (between 
Mark In and Mark Out times) for every timecode break found.

Located below Timecode Break checkbox. Defines the number of missed frames 
required to constitute a timecode break, Range is 1 to 32 frames. Default is 1.

Located below the thumbnail frame, directly above the clip list. Click to clear all 
clips from the selected tape.

Located below the thumbnail frame, directly above the clip list. Click to switch 
between a clip view and a list view, depending on the task at hand.

Status Badge Description

Pipeline Control attempted to capture the clip, but failed. This may be due to lack 
of storage, network or Pipeline problems, or excessive pre-roll at the beginning of 
a tape, for example. Resolve the problem and retry. Using the mouse, hover over 
the icon to display additional information.

This clip is being closed. All media has been captured, but it has not been com-
pletely written to the file yet – possibly due to use of buffering.

This clip has not been captured yet.
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General Tab Controls

Use the controls on the General tab to identify your clip, and set its in and out points.

Figure 8–4. Use the General tab to ID your clip/tape & set mark points.

Name. In the Name field, enter a text phrase to name the root file name (not including the suffix). For 
additional files with the same root, Pipeline Control adds a unique number if you specify the counter token. 
File names are entered via the keyboard, but can also contain other parameters (date, codec, etc.) 
selected by using the pull-down menu provided

Tape. Enter the tape name to organize clips by tape, if you’re capturing from multiple tapes. These tape 
names display in the tree just to the left of the clips in the clip list. Tape names are not known by the deck 
or Pipeline Control, they are only used for human identification purposes.

Mark In. Click the arrow to update the Mark In point to the tape’s current timecode for the selected clip. Or, 
manually enter the timecode. To go to the point, click the Go button.

Mark Out. If you’re not using the duration, click to update the Mark Out point to the tape’s current timecode 
for the selected clip. Or, manually enter the timecode. To go to the point, click the Go button.

Duration. Click to disengage the lock (black). The duration is calculated as the end time minus the start 
time. While the lock button is disengaged (black), changes to the start timecode will cause the end 
timecode to remain the same, and the duration timecode to change. Any changes to the end timecode will 
similarly cause the start timecode to remain the same and the duration timecode to change. 

Click again to engage the lock (blue). Duration always stays the same. When the lock button is engaged 
(blue), changes to the start or end timecode leave the duration timecode locked – as is. If you change the 
start timecode, the end timecode will adjust to match the new start time and the locked duration. If you 
change the end timecode, the start timecode will adjust to match the new end timecode and the locked 
duration. 

For example, given a clip at 29.97 fps, if the duration is set to 00:00:30;00 with the In point at 01:00:00;00, 
the Out point will be 01:00:29;29. If the In point is changed to 01:00:10;00 the Out point will change to 
01:00:39;29. Likewise, if the out point is changed from 01:00:39;29 to 01:00:49;29 the In point will change 
to 01:00:20;00.

This clip is currently being opened/created, but no media has been captured yet.

This clip is in the process of being captured.

This clip has been successfully captured and the file has been closed.

Status Badge Description

Click to name or rename clip

Lock to add the duration to the mark out point.

Mark in/out controls

Enter the tape ID
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A blue lock does not mean that the duration fields are locked (not editable). When the lock is blue, the 
duration value can be changed manually by entering a new duration in the duration fields.

Embedded Labels

Figure 8–5. Embedded Labels

To view or update the label values for each clip event, click the embedded tab to display each metadata 
sheet. There may be more than one metadata label. Enter the labels you want to use. The Embedded label 
is always available; others (including FlipFactory labels, Final Cut Pro, and QuickTime) are dynamically 
generated as appropriate.

For Quicktime only, values in the Embedded label are embedded in the file that is created.

Editing Clip Details

Clips can be viewed in clip view or list view – click the Clip or List view button at the top of the list to switch 
views. Click a clip to select it. Double-click a clip to edit it in place.

Figure 8–6. Double-click to edit clip details in the General and Embedded tabs in place.

When you’re done editing click Save to save your updates or Cancel to discard them and return to view-
only.

Performing Other Clip Tasks
There are a variety of actions you can take on a selected clip, when you right-click on it:

Clear. Select to permanently remove the clip from the list. Files associated with the event are not deleted.

Edit. Select to display an editor dialog, so that you can modify the properties of the clip. 

Show in Explorer. After the clip has been recorded, select to display the folder that contains the clip.

The dotted yellow lines indicate you’re 
in edit mode.

When you’re done editing, click Save 
or Cancel.

Drop-Frame Mode Select. 
Click semicolon to toggle drop-frame mode.
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Recapture. After the clip has been recorded, select to re-capture the clip.

Using Clip View

In clip view (shown following), several controls are presented.

Figure 8–7. Use clip controls to review your clip.

Preview Thumbnail. Assigned when you created the mark-in point.

Status Badge. Status badges to indicate the state of this clip.

Progress Bar. When capturing, colored yellow for captured and green for written to disk, indicating 
progress toward completion.

Review Controls. When file has been captured and closed, use these controls to view your clip locally.

Creating a Clip

To create a clip, insert your tape, make sure the Pipeline is connected, and follow these steps:

1. Click the General tab to display mark-in and mark-out controls. 

2. Play/scrub the video using the VTR controls, then click the Mark In button to mark the start timecode 
(at right of Mark In code value field in the General tab of the Clip List panel). 

3. Click the Mark Out button to mark the end timecode (at right of end timecode value field). When you 
have a start and end timecode value (and the start timecode is previous to the end timecode).

4. Optionally, enter a start timecode and a duration – the end timecode will be calculated for you.

5. Optionally, enter metadata on the any of the available metadata tabs.

6. Click Log to create the clip and add it to the list.

When not in edit mode, any data entry or edits you perform in any tab is for the next clip you may create. 

Deleting a Clip

To delete a clip, select it from the clip list and press the Delete key or select Clip > Clear.

Note

This does not delete the clip if it has already been captured.

Preview thumbnail.

Progress bar.

Status badge.

Review Controls
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SETTING UP AND CAPTURING TIMECODE BREAK RECORDING

To set up timecode break recording, which is performed by timecode breaks in the video, insert the tape 
and make sure the Pipeline is configured and connected. After you’ve set up your configuration and logged 
your clips (details below), click Activate to initiate timecode break recording.

Generally these tapes have been recorded using time of day time code. Once activated the Timecode 
Break feature will create separate files when a break in the time code is detected. To accommodate for 
dropped frames when the tape was recorded, a Frame Threshold parameter is available. 

Figure 8–8. Timecode Break Recording settings panel.

Timecode Break Checkbox. Check the Timecode Break checkbox to enable timecode break recording.

Frame Threshold. Defines how many discontinuous timecode frames required to constitute a break. Use 
the slide bar to set the frame threshold from 1 to 32. Default is 1. 

Enter the minimum number of frames between time code breaks that will trigger a new clip to begin. For 
example if the Frame Threshold is set to '3' a new clip will be created when a break of 3 or more frames is 
detected. If a Time code breaks of less than '3' frames is detected it will be ignored and capturing will 
continue until a break of more than 3 frames is detected, the Max Duration is achieved for this clip, the end 
of tape is detected or the document is deactivated.

Check Timecode break

Select Frame Threshold
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Chapter 9, Using Trigger Capture Documents

Pipeline Control’s Trigger document enables you to manually or automatically record media in real time 
from a live source or VTR. You use the Trigger document to record media in real time from a VTR deck or 
live sources. You can perform the recording process in four ways: manually, automatically via Web 
services, by using timecode breaks, or under RS422 control.

You use the Web services by writing an application using the Pipeline Web Services API, in any supported 
SD or HD essence and file/wrapper format, directly from a Pipeline that is attached via Ethernet.

Topics

 Using the Trigger Document (page 128)

 Using the Preview Panel (page 130)

 Setting up and Enabling Automatic Recording (page 130)

 Using CalDav Calendar (page 131)

 Manual & Timecode Break Recording (page 134)

 RS422 (page 135)

 Viewing and Updating Metadata Labels (page 136)

Note

When capturing media from Pipeline Quad, you can perform confidence monitoring to 
qualify your video. See Confidence Monitoring (page 51).
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USING THE TRIGGER DOCUMENT

The Trigger document is designed to facilitate manual and automatic clip recording. Pipeline Control can 
record files of any supported profile in any format/wrapper, up to 9 hours in length. 

Figure 9–1. Use the Trigger window to capture video in real time.

At the top of the window is the Pipeline Settings panel; on the left side is the Preview panel. For details on 
how to use the Pipeline Settings panel and the Preview panel, see Chapter 6, Using Pipeline Control (page 
57). The right side of the window is the Clip panel which is designed to support crash recording and 
automation. The clip panel has settings to enable and configure automatic, calendar, manual, timecode-
break, and RS422 controlled recording.

Pipeline Control will automatically reconnect a Trigger document if network connectivity or video signal is 
lost, but it will not continue processing future events. When your VTR is connected via RS-422 in remote 
mode, the VTR controls allow you to scrub media.

Naming Control

The naming control enables you to enter a text phrase to name the root file (not including the suffix). For 
additional files with the same root, Pipeline Control adds a unique number if the counter token is used. File 
names are entered via the keyboard, but can also contain other parameters (date, codec, etc.) using the 
pull-down menu provided.

The default name is automatically entered based on the parameters set in Preferences. To change the file 
name to be used, modify the basename and any token types desired. Token types can be Date, Time, 
Mark In (inclusive First Frame TC), Mark Out (exclusive Last Frame TC), Counter (increments by 1), 
Pipeline (name), Tape (name), Codec, Frame Rate, and External. The counter token ensures unique 
names.

Tokens are added by selecting them from the pull-down menu and are moved by clicking and dragging 
them to change their order in the filename. 

Web service 

Manual recording

Activate / Deactivate the 
document for recording.

Clip list

RS422 controlled recording

Timecode break recording

Calendar

Naming
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The External token adds a name passed in by an external trigger source (from a CalDav Calendar or Web 
Service command, for example). The name used as a token is taken from the START command argument 
name. If no external name token is added to the Name field, the Event name will be ignored.

In the Web service trigger, the external token gets its value based on the value of the name parameter (if 
specified). In the calendar trigger, the external token gets its value based on the event name in the 
calendar (if specified). If these values are not specified, or if the capture is initiated with a trigger other than 
Web service or calendar, the external token is ignored.

Figure 9–2. Naming Control

Clip Status Badges

Clip thumbnails are marked with status badges to help you identify the state of each clip at a glance.

Note

Naming Tokens are applied when a clip is added to the clip list. The tokens Mark-In, 
Mark-Out, Date and Time are applied to the name based on the values known at the 
time they were added. If the start or end times are modified (through CalDav or the 
Web Service API), the new start and end values will not be reflected in the clip's name 
at the time of capture.

Status Badge Description

Pipeline Control attempted to capture the clip, but failed. This may be due to lack 
of storage, network or Pipeline problems, or excessive pre-roll at the beginning of 
a tape, for example. Resolve the problem and retry. Using the mouse, hover over 
the icon to display additional information.

This clip is being closed. All media has been captured, but it has not been com-
pletely written to the file yet – possibly due to use of buffering.

This clip has not been captured yet.

This clip is currently being opened/created, but no media has been captured yet.

This clip is in the process of being captured.

This clip has been successfully captured and the file has been closed.

Enter filename Select token
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USING THE PREVIEW PANEL

You can use the video and audio preview buttons to enable or disable audio and video preview from the 
video feed.

In addition to the panels and controls described in (Using The Video Preview Panel on page 79), the 
preview panel in the Trigger window has additional controls. If an optional VTR is attached, you can use 
the VTR controls to view VTR status, and in Remote mode, control it.

Figure 9–3. Jog and Shuttle in the Trigger window.

VTR Tape Status

Tape In. Displays when a tape is in the attached VTR.

Tape Out. Displays when a tape is not in the attached VTR.

Deck RS-422 Control Status

NO RS-422. Displays when Pipeline does not have control over the attached VTR.

RS-422. Displays when Pipeline has control over the attached VTR.

VTR Remote Status

LOCAL. Displays when VTR is in Local mode.

REMOTE. Displays when VTR is in Remote mode.

Alarm Status

ALARM. Displays when the deck has an outstanding alarm.

<blank>. Displays when there is no outstanding alarm.

SETTING UP AND ENABLING AUTOMATIC RECORDING

To set up automatic recording, which is performed by using Pipeline Web Services API requests from 
another application, check Web Service. Then, connect the feed or insert your tape, make sure the 
Pipeline is configured and connected. After you’ve set up your configuration (details below), click Activate 
to enable automatic recording.

VTR Tape Status 
Indicator

Deck RS-422 Control 
Status Indicator

VTR Remote 
Status Indicator

Alarm Status

Jog Wheel/Shuttle
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For details on using the Web service, see Pipeline Web Service Application Note..

Web Services and Port Number. Check Web services, and set the port number that the Web service 
should listen for incoming HTTP GET requests on. The port number value must be between 1025 and 
49151, and the TCP port must be open on the host system and not blocked by a firewall.

Figure 9–4. Automatic Recording settings panel.

You can record all formats and file wrappers in this manner, depending on your Pipeline settings. All files 
have a 9 hour maximum clip length.

When the Web service is enabled and the Pipeline document is placed into an active state, the Web 
service begins listening for requests on the specified port. You are warned if the port is in use by another 
Trigger document or by some other service on the host computer.

USING CALDAV CALENDAR

.

The CalDav Calendar option enables you to record based on events on a CalDav compatible calendar 
(such as Google or iCal). The Pipeline Control software checks the calendar every ten seconds for 
changes in existing events and for new events then loads them into the Clip window within a two-hour look-
ahead window of time. If a calendar event has been placed into the Pipeline Control’s Clip window, then 
subsequently removed or changed, Pipeline Control will indicate the new state on the associate entry in 
the Clip window. If a calendar event has been deleted from the CalDav calendar, the clip entry will not be 

Note

If you want to use the Web Service in Pipeline, you must run the application with an 
administrator account because the Web Service requires elevated privileges.

Windows 7 Example:
1. Navigate to \Program Files\Telestream\Pipeline Control
2. Right-click PipelineControl.exe
3. Click the Compatibility tab
4. In the Privilege Level section, check Run this program as an administrator

Note

Scheduled capture events created by Repeat Event functionality of your calendar 
program are not fully supported by Pipeline Control's CalDav calendar trigger and 
should not be used. Instead, create events individually to ensure that all repeated 
events are captured.

Enable/Disable automatic recording via Web service.

Specify the port number.
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removed from Pipeline Control’s Clip window, but it will display a large X over the record icon. You can 
hover over the large X to view the tool reporting that the clip was removed before being captured.

Figure 9–5. Clip Window

.

To use CalDav Calendar with Pipeline Control Trigger, follow these steps:

1. Open a New Trigger Document. If a Trigger document isn’t open, select File > New Trigger 
Document to create a new, untitled Trigger document. Or, you can open a previously-saved document.

2. Calendar checkbox. Check the Calendar check box, then click the down arrow to display the 
calendar controls.

Figure 9–6. Calendar Controls.

3. CalDav URL. In the Calendar field enter the URL to the CalDav calendar you want to use. Example: 
https://www.google.com/calendar/dav/<your Google Calendar ID>/events/. 

Here are some examples:

• Google:

— https://www.google.com/calendar/dav/<calendarid>@group.calendar.google.com/events/

— https://www.google.com/calendar/dav/1jk6tfqu7qqa0fihp2lthqju4o@group.calendar.google.com/events/

Note

The Calendar control requires a license. Without a license, the Calendar checkbox is 
greyed out and the message Calendar Trigger is not Licensed is displayed in red.

Large X

Click down arrow.

Check Calendar
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.

• Bedework Personal Calendar:

— http://<IP or hostname>:<Port>/ucaldav/user/vbede/calendar

— http://QA-RONT1:8080/ucaldav/user/vbede/calendar

• Yahoo Calendar:

— https://caldav.calendar.yahoo.com/dav/telestreamcalendar@yahoo.com/Calendar/telestreamcalendar

.

4. Username. In the Username field enter the email address you use with CalDav Calendar. This is the 
complete email address you use with CalDav Calendar, including the part after the @ sign. If you are 
using Google Apps, be sure to enter your Google Apps email address.

5. Password. In the Password field enter is the password you use to sign in to Google Calendar.

6. Connect. Click Test Connection. If the calendar URL, Username and Password are correct, then “Your 
settings are OK!” will display next to the Test Connection button. If an error message displays, go back 
and correct the URL, Username and Password, and reconnect.

.

Note

The Google Calendar URL must end with exactly all of these characters: /events/

Note

Your Google Calendar ID for your primary calendar is your email address, but for all 
other calendars the Calendar ID is in the form of: <long string of characters>
@group.calendar.google.com. You can get the Calendar ID by clicking the down 
arrow next to your calendar at calendar.google.com and selecting Calendar Settings.

Be sure to use “https” in your URL, because “http” will not work.

When you are using the calendar trigger, make sure the Use Duration as frame count 
instead of Mark Out point checkbox (located near the bottom of the Tools > Options > 
Capture tab) is unchecked. This will enable events to be updated in Pipeline Control.

Events can be scheduled directly on the CalDav calendar or by accepting event 
requests sent by external systems. If an event is requested and tentatively accepted 
with “Maybe”, the event will be captured as fully accepted.

CalDav calendar server applications may implement security restrictions to prevent 
unauthorized access. Set your calendar's security setting appropriately to allow 
Pipeline Control access to calendar events

Note

Pipeline does not support reoccurring events in Google Calendar. To do multiple 
events you must create a new separate event for each occurrence in Google Calendar
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MANUAL & TIMECODE BREAK RECORDING

To manually record – encode and capture media – from Pipeline in real time, follow these steps:

1. Open a New Trigger Document. If a Trigger document isn’t open, select File > New Trigger 
Document to create a new, untitled Trigger document. Or, you can open a previously-saved document.

2. Select and Configure your Pipeline. If you have not already done so, select and configure a Pipeline 
and save your configuration. For details, see Using The Pipeline Settings Panel (page 64).

3. Connect to the Pipeline. When you connect, streaming media (if present) displays in the video panel. 
If you’re connected to a VTR and it is in Remote mode, you can control your video using VTR controls.

4. Set up your live feed. Connect your live feed or insert tapes in your VTR, then use the VTR controls 
to scrub the media to the starting point.

5. Enable Manual recording. Check Manual to enable direct, user-control of this document. Specify the 
file name and enter a duration, then connect the live feed (or insert a tape). 

Figure 9–7. Manual Recording settings panel.

Duration. You can enter a duration for the amount of time Pipeline Control should record media to the 
file. Or, just click the Record button to stop recording when you choose. Default is 00:00:00:00 which 
creates a clip with a maximum duration of nine hours.

Segment. Optionally, you can enter a segmented duration which causes multiple clips to be captured 
during the full Duration time. If more than one segment is specified, the value specified in the duration 
field is divided by the number of segments. For example, a duration of sixty minutes with a segments 
value of 60, results in sixty one-minute clips. A duration of 60 minutes with a segments value of 2, 
results in two 30-minute clips. Default is 00:00:00:00, which disables segmented duration.

.

6. Capture the Video. Click the Activate slider, then click the Record button to start recording. The 
recording will continue until the specified duration is reached or the capture is stopped manually by 
clicking the record button a second time. To use the Record button to start and stop recording, enter 0 
in the Duration field. When recording using Open QuickTime, if you stop recording before the duration 
value is reached, the file will retain the original duration value.

WARNING: During capture within a Trigger session depressing the '-' or '=' key will stop the 
capture immediately.

When capture is complete, the file is closed. 

Note

When using the Segment value during capture, the last segmment may be larger than 
any previous segment.

Enable/Disable manual recording.

Enter filename 

Click to start/stop recording. 
Displays only when document is active.

Enter segment duration

Enter duration

Select filename tokens
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To set up timecode break recording, which is performed by timecode breaks in the feed, make sure the 
Pipeline is configured and connected. After you’ve set up your configuration (details below), click Activate 
to enable timecode break recording.

Generally these feeds have been recorded using time of day time code. Once activated the Timecode 
Break feature will create separate files when a break in the time code is detected. To accommodate for 
dropped frames when the tape was recorded, a Frame Threshold parameter is available. 

Figure 9–8. Timecode Break Recording

Duration. Duration is the maximum duration of any one individual clip. If the max duration is reached 
before a time code break is detected any clip being captured will stop. The system will continue in capture 
mode and will start a new clip at the next time code break. Duration default is 00:00:00:00, which allows for 
a maximum duration of nine hours. The duration control is inactive when the Record button is clicked.

Timecode Break Checkbox. Check the Timecode Break checkbox to enable timecode break recording.

Frame Threshold. Defines how many discontinuous timecode frames required to constitute a break. Use 
the slide bar to set the frame threshold from 1 to 32. Default is 1. 

Enter the minimum number of frames between time code breaks that will trigger a new clip to begin. For 
example if the Frame Threshold is set to '3' a new clip will be created when a break of 3 or more frames is 
detected. If a Time code breaks of less than '3' frames is detected it will be ignored and capturing will 
continue until a break of more than 3 frames is detected, the Max Duration is achieved for this clip, the end 
of tape is detected or the document is deactivated.

RS422

Check RS422 to enable Pipeline system remote control for automation capability using a standard BVW 
(Sony 9-pin) connector. If the REC command (20.02) or the EDIT ON command (20.65) is received on the 
Pipeline's RS422 command, then a clip will be started. If the STOP command (20.00) is received on the 
Pipeline's RS422 command then a clip will be stopped. If a REC command is received while another 
RS422 capture is in progress, the previous capture will be stopped and a new one will begin.

Note

A dropped or skipped frame will cause the capture session to stop. If you are capturing 
more than one segment and the capture session has stopped prematurely, some 
segments will not be captured. To prevent the capture session from being prematurely 
stopped by a lost or skipped frame, select the Ignore lost frames option from Tools-
>Options->Capture (see Setting Up Pipeline Control Options on page 81), or enable 
the firmware option Ignore input discontinuities on the Configure Panel (see Using 
the Configure Panel on page 44).

Check 
Timecode break

Select Frame 
Threshold
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VIEWING AND UPDATING METADATA LABELS

Figure 9–9. Labels Applied Panel.

To view or update the label values for each clip event, click the embedded tab to display each metadata 
sheet. There may be more than one metadata label. The Embedded label is always available; others 
(including FlipFactory labels, Final Cut Pro, and QuickTime) are dynamically generated as appropriate.

For Quicktime only, values in the Embedded label are embedded in the file that is created.

Note

When using RS422 to control a Pipeline system, you must use an RS-422 cable (or 
adapter) that swaps the RS422 transmit and receive lines. Adapters are available from 
Telestream by contacting Technical Support (Part Number: 53-0024-00 RS-422).
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U s i n g  P r i n t  t o  Ta p e
D o c u m e n ts
Chapter 10, Using Print to Tape Documents

Pipeline Control’s Print to Tape document enables you to implement various types of print-to-tape 
operations from media files played out via Pipeline to your VTR. You can use the Print to Tape document to 
specify a set of clips and perform assembly and insert edits or crash print to tape.

Topics

 Playout & Print to Tape Overview (page 138)

 Creating Print to Tape Documents (page 139)

 Using the Clip Panel (page 140)



Chapter 10
Using Print to Tape Documents

138
PLAYOUT & PRINT TO TAPE OVERVIEW

The Print to Tape document is designed to facilitate print to tape operations via Pipeline. You can set up the 
following print-to-tape operations:

 Assemble edits

 Insert edits

 Crash records.

Figure 10–1. Print to Tape window panels and toolbars.

At the top of the window is the Pipeline Settings panel, and to the left is the Preview panel. For details on 
how to use these panels, see Chapter 6, Using Pipeline Control (page 57). 

When your VTR (or VTR-enabled camera) is connected via RS-422 in remote mode, VTR controls below 
the Preview panel enable you to scrub the tape.

The Print to Tape document panel (bottom right) displays configuration settings and timecode settings. 
Below the timecode settings is the clip list, which displays a list of clips you have added.

Pipeline Status. 
Displays status. 

Preview panel. 
Displays video.

Timecode. 
Displays when 
connected.

Clip list 
panel. 
Displays 
all clip 
events 
ordinally.

Clip Events. Add these clip 
events to play out media.

Pipeline Settings Panel. Use to configure 
Pipeline for use in this document.

Print to Tape Details. Displays number of 
clips and total capture hours.

Clip List Toolbar. Provides buttons 
for frequently used functions.

Print to Tape 
Configuration 
Panel.

Activation 
Slider.

Print Time Tape. 
Visual depiction of 
layout on tape.
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Pipeline Control automatically reconnects a Print to Tape document if network connectivity or video signal 
is lost when you are previewing the tape, but it will not reconnect if the document has been activated.

CREATING PRINT TO TAPE DOCUMENTS

A Print to Tape document contains one or more clip file events in QuickTime (mov) or OP-1a MXF format, 
which you use to play out SDI video from Pipeline in real time. The video format is automatically detected, 
and decoded by the appropriate codec in the Pipeline, and played out under control of Pipeline Control.

Here are the steps you’ll take to create and use a Print to Tape document:

1. Open a New Print to Tape document. If a Print to Tape document isn’t open, select File > New Print 
to Tape Document to display a new, untitled Print to Tape document window.

Or, you can open a previously-saved document.

2. Select your Pipeline. If you haven’t already selected your Pipeline for this workflow, do so now. After 
configuring Pipeline for your workflow requirements, save the file. For details, see Using The Pipeline 
Settings Panel (page 64).

3. Select insert, assemble, or crash print type. Insert allows the replacement of video and/or audio. 
Assemble takes the entire video/audio stream for a given amount of time. Crash starts the deck in 
record mode and writes everything to tape. It is not guaranteed to be frame accurate. Only Insert 
allows the video and audio operation to be configured.

4. Select the type of operation you want. If Insert print type has been selected, configure your Print to 
Tape operation by checking the Preview, Video, and Audio check boxes as desired.

Figure 10–2. Print to Tape configuration panel.

Preview. When Preview is selected the Pipeline Control software will put your VTR into its Preview mode. 
This allows you to review your edit via the VTR's preview mode prior to committing it to tape.

Note

There are two ways to playout VANC data with a Pipeline system. 

1. Track based VANC Data is obtained from the data tracks of the respective file 
formats. For QuickTime this includes the time code and closed caption tracks. For MXF 
OP1a this includes all data stored in the SMPTE 436M track data.

2. Video Essence based VANC Data plays out VANC data embedded into DVCProHD, 
ProRes, and DNxHD video essence frames. This method requires you to enable VANC 
essence playout option from the Pipeline Administration page. This option overrides 
Pipeline’s track based playout. (See Using the Configure Panel on page 44.)

(For more detail see:  http://www.telestream.net/pdfs/app-notes/app_Pipeline_VBI-
VANC_Support.pdf).

Select the type of print to tape operation.

Check to preview during playout.

Check video and audio to play out, 
as appropriate.
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Video. Check to play out video (available in Insert edit mode only).

Analog Audio. Check audio flag 1 and/or 2 to route audio channels based on the deck configuration. 
(Available in Insert edit mode only).

Digital Audio. Check audio flag 1 and/or 2 to play out these channels (available in Insert edit mode only).

5. Set timecode values. Set timecode values for Mark In, Leader, Padding, and Trailer as desired.

Figure 10–3. Print to Tape Timecode panel.

Mark In. Enter the timecode of the first frame on the tape where media will begin to be laid down.

Leader. Enter the length of black leader to play out before the first clip.

Padding. Enter the length of space to leave between clips as they are played out.

Trailer. Enter the length of black trailer to play out at the end of the last clip.

6. Add your Clips. Using the Clip panel, add your files to the list, trimming each file as appropriate. You 
can only add QuickTime and OP-1a MXF movies that conform to the requirements of the Print to Tape 
document, and all clips must have the same essence. For details, see (Using the Clip Panel (page 
140)).

7. Play Out the Video as Print to Tape. Click the Activate slider to start playing out your clips.

USING THE CLIP PANEL

The clip panel (on bottom, right side of the window) allows you to specify a set of clip files to play out in a 
print to tape operation, view a virtual tape track, and adjust trim points on each clip (clip markers).

Figure 10–4. The clip panel allows you to create a collection of clip files to print to tape.

Set your tape’s 
mark in time code.

Specify the length of black leader 
to print before the first clip.

Specify the length of black 
trailer to print after the last clip.

Specify the padding to print 
between each clip.

Clips. Drag QuickTime mov files or click + to 
add them to the list. Click and drag to rearrange. 

Clip Toolbar. 
Provides 
buttons for 
frequently 
used 
functions. 

Tape Stripe. Visual track for each 
leader, clip, and padding, by timecode. 

Timecode 
Summary.
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At the bottom of the clip list is the document’s time code summary. The timecode summary includes Mark 
In – (start of leader or first clip), First Clip Start, Last Clip End, and Mark Out. By convention, the terms 
Mark In and Mark Out are inclusive-exclusive. Thus, Mark Out is the time code of the first frame NOT 
recorded. Clip start and clip end times are inclusive-inclusive.

Adding, Organizing, and Deleting Clips

To add a clip, drag an OP-1a MXF or QuickTime movie file (containing media essences supported by 
Pipeline) onto the clip space. You can only drag one clip file at a time using this method. Or, click + (Plus 
icon) in the toolbar to display a File System dialog. Navigate and select files to add to the clip list.

To delete a clip, select it in the clip list and press Delete or click the - (Minus icon) in the toolbar.

To rearrange clips, click and drag them to the position you want them in. 

Clip Panel Toolbar

At the far left is a toolbar with buttons for frequently used functions. 

Figure 10–5. The Clip Panel toolbar displays icons for frequently used commands.

Note

Files used for Playout must contain identical number of audio channels and the same 
bit depth/type.

Add Clip. Click to navigate and select clips to add to the list. 

Mark In Timecode. Click to copy the current timecode to the mark in timecode. 

Stop Preview. Stops preview and returns to beginning of clip. 

Play Preview. Plays currently selected clip in preview panel. 

Pause Preview. Pauses preview of the current clip. 

Delete Clip. Click to delete the selected clip from the list. 
178027



Chapter 10
Using Print to Tape Documents

142
Print Time Tape

To the right of the toolbar is the Print Time Tape. The Print Time Tape is a virtual representation of the order 
and time the leaders, padding, trailer, and clips will be applied to the tape.

Figure 10–6. Print Time Tape details.

The print time tape helps you visualize how the clips will be printed, and includes leader, trailer and 
padding so that you can visualize and confirm the result of the print to tape operation before you actually 
perform it.

Figure 10–7. Print Time tape during playout.

During a print to tape operation, the current timecode of the tape displays, along with a bar indicating the 
relative number of frames held in RAM. Additionally, the clip being printed displays a progress bar. 

Clip 
Events. 

Clip Pointers. 
Identifies the 
clip associated 
with a given 
block on the 
tape. 

Tape. Displays 
clips, leaders, 
and padding 
ordinally.

Timecode.
Identifies the current 
timecode of the tape. 

Frames in RAM. 
Representation of 
the number of frames 
currently in RAM.
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Clip Events

Each clip file you add to the clip list is identified by a clip event.

Figure 10–8. Clip events in your schedule provide details about the clip.

Each clip event has several controls:

Preview Thumbnails. Displays previews of the mark-in and mark-out frames.

File Path. Displays the full path and file name of the clip for this clip event.

Duration. Specifies the duration of playout, as calculated by the clip in and clip out points.

Clip In & Clip Out. Set by using the scrubber controls to adjust clip in and clip out points.

Trimmer. Use the scrubber controls at the left and right to set your clip in and clip out points.

Progress Bar. When a file is playing out, displays relative progress and amount of media frames currently 
held in RAM.

Thumbnail. 
Displays thumbnail 
at mark in point.

Clip Trimmer. Scrub to set 
clip in and out points.

File. Clip file path and filename.

Clip In. Start 
time code.

Thumbnail. 
Displays thumbnail 
at mark out point.

Clip Out. End 
time code.

Progress Bar. Displays 
playout progress.
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U s i n g  C o n t r o l l e d  P l a y o u t
D o c u m e n ts
Chapter 11, Using Controlled Playout Documents

Pipeline Control's Controlled Playout document enables you to assemble a sequence of media files and 
play them out in a controlled fashion. Controlled Playout, when activated, acts as a virtual tape deck that 
provides play, stop, pause, rewind, fast forward, jog and shuttle controls. External control using JLCooper 
MCS2 USB controller, standard RS422 (Sony 9-pin/BVW) controllers, or Pipeline Web Service is also 
provided.

Topics

 Controlled Playout Overview (page 146)

 Creating Controlled Playout Documents (page 147)

 Using the Clip Panel (page 149)

Note

The Controlled Playout doc requires v2.5 or later firmware
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CONTROLLED PLAYOUT OVERVIEW

The Controlled Playout document is designed to provide a method to play out media via Pipeline's SDI 
output with standard deck controls:

Figure 11–1. Controlled Playout window panels and toolbars.

At the top of the window is the Pipeline Settings panel, and to the left is the Preview panel. For details on 
how to use these panels, see Chapter 6, Using Pipeline Control (page 57). 

The Controlled Playout document panel (bottom right) displays configuration settings. Below these settings 
is the clip list, which displays a list of clips you have added.

Pipeline Control will automatically reconnect a Controlled Playout document if network connectivity is lost 
while in the preview state (Pipeline State displays Previewing). However, if the document has been 
activated into a play out state (Pipeline State displays Playing Out) and network connectivity is lost, you 
must manually re-activate the document.

Pipeline Status. 
Displays status.

Clip list 
panel. 
Displays 
all clip 
events 
ordinally.

Pipeline Settings Panel. Use to configure 
Pipeline for use in this schedule.

Controlled Playout Details. Displays 
storage location, number of clips, total 
capture hours, and approx. space required.

Clip List Toolbar. Provides 
buttons for frequently used 
functions.

Controlled Playout 
Configuration Panel.

Activation 
Slider.

Timecode. 
Displays when 
connected.

Preview panel. 
Displays video.
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.

CREATING CONTROLLED PLAYOUT DOCUMENTS

A Controlled Playout document contains one or more clip file events in QuickTime (mov) or OP-1a MXF 
format, which you use to play out SDI video from Pipeline in real time. The video format is automatically 
detected, and decoded by the appropriate codec in the Pipeline, and is played out under control of Pipeline 
Control.

Here are the steps you’ll take to create and use a Controlled Playout document:

1. Open a New Controlled Playout document. Select File > New Controlled Playout Document to 
display a new, untitled document window. (You can also open a previously-saved document by 
selecting File > Open.)

2. Select your Pipeline. If you haven’t already selected your Pipeline for this workflow, do so now. After 
configuring Pipeline Control for your workflow requirements, save the file. For details, see Using The 
Pipeline Settings Panel (page 64).

3. Enable Web service. If Pipeline Web service is used, check the Web Service checkbox and enter the 
port number to be used in the Port field. (See Web Service application note for API details):

Figure 11–2. Web services configuration panel.

4. Enable manual control. Check Manual checkbox to enable manual control and click Jog/Shuttle 
button to select mode:

Figure 11–3. Manual control configuration panel.

The Controlled Playout document can be controlled from an external JL Cooper MSC2 USB controller. 
This device provides Play, Stop, FWD, Rewind, Jog and Shuttle controls. All necessary drivers are 

Note

There are two ways to playout VANC data with a Pipeline system. 

1. Track based VANC Data is obtained from the data tracks of the respective file 
formats. For QuickTime this includes the time code and closed caption tracks. For MXF 
OP1a this includes all data stored in the SMPTE 436M track data.

2. Video Essence based VANC Data plays out VANC data embedded into DVCProHD, 
ProRes, and DNxHD video essence frames. This method requires you to enable VANC 
essence playout option from the Pipeline Administration page. This option overrides 
Pipeline’s track based playout. (See Using the Configure Panel on page 44.)

(For more detail see:  http://www.telestream.net/pdfs/app-notes/app_Pipeline_VBI-
VANC_Support.pdf).

Check Web Services checkbox
Enter port number

Check to enable

Playout Controls

Click Jog/Shuttle button 
to select mode.

Jog/Shuttle wheel
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installed when Pipeline Control is installed on your workstation. Simply plug the device into any available 
USB port on your workstation.

If you have a Pipeline Controlled Playout document open when the JL Cooper MSC2 USB controller is 
connected, you will see this image appear:

When a JL Cooper MSC2 USB controller is installed, Connected to a shuttle device on COMx is displayed 
in the Manual control user interface:

5. Enable remote control automation. Check the RS422 checkbox to enable remote control via the 
RS422 port. This functionality allows for external control using an RS422 playout controller:

If playout is being controlled via an automation system that utilizes the full set of Sony 9-pin BVW 
commands through RS422, the following restrictions apply:

• Only a single clip can be loaded into the clip list. Adding more than one clip into the clip list can cause 
an error when an automation command attempts to pre-roll to a time code prior to the first frame time 
code of the clip to be played out.

• Playout Mode must be set to Play out all clips. 

• Clip Transition Mode must be set to Continue playout after each clip. 

6. Add your Clips. Using the Clip panel, add your files to the list, trimming each file as appropriate. You 
can only add QuickTime or MXF OP1a files that conform to the requirements of the Controlled Playout 
document, and all clips must have the same essence. For details, see Using the Clip Panel (page 
149).

7. Play Out the Video as a virtual Tape deck. Click the Activate slider to activate the Controlled Playout 
document. For manual Control use playout controls and the jog/shuttle wheel to control the play out. 
Use an RS-422 controller or the Pipeline Web Service commands to play out clips from an external 
source.

Note

When using RS422 to control a Pipeline system in the Controlled Playout mode, you 
must use an RS-422 cable (or adapter) that swaps the RS422 transmit and receive 
lines. Adapters are available from Telestream by contacting Technical Support (Part 
Number: 53-0024-00 RS-422).

Check to enable
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USING THE CLIP PANEL

The clip panel (on bottom, right side of the window) allows you to specify a set of clip files to view as tracks, 
adjust trim points on each clip (clip markers), and play out in a virtual tape deck operation.

Figure 11–4. The clip panel allows you to create a collection of clip files to play out.

Adding, Organizing, and Deleting Clips

To add a clip, drag a QuickTime or MXF OP1a file (containing media essences supported by Pipeline) onto 
the clip space. You can only drag one clip file at a time using this method. Or, click + (Plus icon) in the 
toolbar to display a File System dialog. Navigate and select files to add to the clip list.

To delete a clip, select it in the clip list and press Delete, or click the - (Minus icon) in the toolbar.

To rearrange clips, click and drag them to the position where you want them. 

Clip Panel Toolbar

At the far left is a toolbar with buttons for frequently used functions. 

Figure 11–5. The Clip Panel toolbar displays icons for frequently used commands.

Note

Files used for Playout must contain identical number of audio channels and the same 
bit depth/type.

Clips. Drag QuickTime 
mov or MXF OP1a 
files, or click + to add 
them to the list. (Click 
and drag to rearrange.) 

Clip Toolbar. Provides buttons for frequently used functions. 

Add Clip. Click to navigate and select clips to add to the list. 

Playout Mode: Click to select tri-state playout mode (play out all clips once, loop 
through all the clips continuously, or loop through the currently selected clip).

Stop Preview. Stops preview and returns to beginning of clip. 

Play Preview. Plays currently selected clip in preview panel. 

Pause Preview. Pauses preview of the current clip. 

Delete Clip. Click to remove the selected clip from the list. 

Clip Transition Mode: Click to toggle action taken after clip ends 
(automatically start playing next clip, or stop playout after each clip).
178027



Chapter 11
Using Controlled Playout Documents

150
Clip Events

Each clip file you add to the clip list is identified by a clip event.

Figure 11–6. Clip events in your document provide details about the clip.

Each clip event has several controls:

Preview Thumbnails. Displays previews of the mark-in and mark-out frames.

File Path. Displays the full path and file name of the clip for this clip event.

Duration. Specifies the duration of playout, as calculated by the clip in and clip out points.

Clip In & Clip Out. Set by using the scrubber controls to adjust clip in and clip out points.

Trimmer. Use the scrubber controls at the left and right to set your clip in and clip out points.

Progress Bar. When a file is playing out, displays relative progress and amount of media frames currently 
held in RAM.

Thumbnail. 
Displays thumbnail 
at mark in point.

Clip Trimmer. Scrub to set 
clip in and out points.

File. Clip file path and filename.

Clip In. Start 
time code.

Thumbnail. 
Displays thumbnail 
at mark out point.

Clip Out. End 
time code.

Progress Bar. Displays 
playout progress.
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Appendix A, Troubleshooting

This appendix provides instructions for gathering information to assist in troubleshooting. For a complete 
and current list of potential issues and recommendations, go to http://www.telestream.net/download-files/
pipeline/guides/Pipeline_FAQ.pdf

This information may be useful to Telestream Customer Service when you’re obtaining support (Obtaining 
Pipeline Support | Information | Assistance (page i)).

GATHERING INFORMATION FOR TROUBLESHOOTING

These topics enable you to gather various details that aid in troubleshooting, depending on your workflow 
and environment. 

 Workflow Information (immediately following)

 Pipeline Device Firmware Information (page 153)

 Pipeline Administrator Counters Panel Details (page 153)

 Obtaining Debug Logs from Pipeline Control (page 153)

Workflow Information
First, briefly document the workflow and obtain system information about your source and/or destination 
system: FlipFactory (immediately following), Episode Engine (Page 152), Pipeline Control for Mac OS X 
(Page 152), Pipeline Control for Windows (Page 152), or Final Cut Pro (Page 153).

FlipFactory

Obtain FlipFactory information using FlipFactory's automatic support email or obtain it manually.

To obtain the information automatically, send email to Telestream by using the Email Tech Support button 
on the FlipFactory System Settings window (see the FlipFactory User’s Guide, Chapter 5, Using 
FlipFactory, in the Sending Email to Tech Support section). 

To obtain this information manually:

• Get FlipFactory version and all update packs which are installed

• Get a copy of the FlipFactory license file

• Get account and factory details – obtain an XML output of the account when possible

• Obtain the FlipFactory server and/or Pipeline client system information:

http://www.telestream.net/download-files/pipeline/guides/Pipeline_FAQ.pdf
http://www.telestream.net/download-files/pipeline/guides/Pipeline_FAQ.pdf
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1. Click Start > Help and Support.
2. On the Help and Support panel, click Support from the top menu.
3. Click Advanced System Information.
4. Click View detailed system information.
5. On the System Information dialog, select File > Save to save an nfo file containing your system 

information to the desktop of the computer.

Episode Engine

Obtain the Episode Engine version and export your compression template to a file.

Obtain the Mac OS X system profile:

1. Launch the System Profiler, which is located at: /Applications/Utilities/System Profiler.

2. Select Save As... from the File menu.

3. Select Rich Text Format (RTF) from the Format popup menu.

4. Save the file to the desktop.

Pipeline Control for Mac OS X

Obtain the Pipeline Control for Mac OS X version and the Pipeline device firmware version (Pipeline 
Device Firmware Information (page 153)).

Obtain the Mac OS X system profile:

1. Launch the System Profiler, which is located at: /Applications/Utilities/System Profiler.

2. Select Save As... from the File menu.

3. Select Rich Text Format (RTF) from the Format popup menu.

4. Save the file to the desktop.

Save the Pipeline document(s) containing all of your settings, and send the system profile document and 
all Pipeline documents to Telestream support with other debug information.

If you are using a FlipFactory or Episode Engine publisher, obtain all of the system information associated 
with these systems (FlipFactory (page 151) and Episode Engine (page 152)).

Pipeline Control for Windows

Obtain the Pipeline Control for Windows version and the Pipeline device firmware version (Pipeline Device 
Firmware Information (page 153)).

Obtain the Windows system information profile:

1. Run the System Information tool: Start > All Programs > Accessories > System Tools > System 
Information.

2. Select Export from the File menu.

3. Save the System Information file to the desktop.

Save the Pipeline document(s) containing your settings and send the system profile document and 
Pipeline documents to Telestream support with other debug information.

If you are using a FlipFactory publisher, obtain all of the system information associated with these systems 
(FlipFactory (page 151)).
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Final Cut Pro

Obtain the Final Cut Pro version and Pipeline plug-in revision.

Obtain the Mac OS X system profile:

1. Launch the System Profiler, which is located at: /Applications/Utilities/System Profiler

2. Select Save As... from the File menu.

3. Select Rich Text Format (RTF) from the Format popup menu.

4. Save the file to the desktop.

Pipeline Device Firmware Information
Obtain the Pipeline’s firmware revision number. Locate the Main and App Loader revision numbers on the 
Configure panel of Pipeline Administrator (Using the Configure Panel (page 44)).

Obtain Network Details

Pipeline IP address – default, static or DHCP (F/W v2.4 or earlier).

Document whether the connection is direct or through a switch.

If the connection is through a switch, is the route through more than one?

Are there any managed switches between the Pipeline and the target system?

What is the speed of each leg of the connection: 100Mb or 1000Mb (Gigabit).

Document whether the LAN is used for general data traffic and video traffic or only video traffic.

Pipeline Administrator Counters Panel Details
If a video or audio issue is being reported, repeat the encode or playout process while running Pipeline 
Administrator and viewing the counters on the Counters panel (see Using the Counters Panel (page 53) for 
a description of these parameters). To display the Counters panel, click counters in Pipeline 
Administrator’s menu.

Obtaining Debug Logs from Pipeline Control
Debugging Pipeline components (hardware, client applications, etc.) can rarely be done independently. 
Since they all work as a system, they must be debugged as a system. The information obtained through 
these techniques can point to a problem anywhere in the system, and even to problems in multiple points 
in the system.
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Mac OS X

Debug logs for Pipeline Control are generated only when you enable them, by editing property list files:

• Net.telestream.system.plist

• Net.telestream.PipelineControl.plist

• Net.telestream.tifo.plist

• Net.telestream.dvcprohd.plist

• Net.telestream.imx.plist

Each of these files controls, among other things, the output of debug information for different subsystems. 
The system plist handles enabling and disabling debug logging for the Pipeline Engine, the lowest layer of 
the Pipeline software suite. The second plist, PipelineControl, handles application level logging – the 
Pipeline Control application itself. The media format plists (tifo, devprohd, and imx, for example), handle 
debug logging for various QuickTime decompressor components. 

To enable debug logging, first exit Pipeline Control. If you want to obtain debug logging for QuickTime 
decompressors, then you’ll need to also exit QuickTime-enabled applications including QuickTime Player 
or Final Cut Pro. 

Now, add a DebugLevel key to the plist as a number (for example, NSNumber), and a value 5. Save the 
changes to the plist and start PipelineControl again. Optionally, you can add a DebugLog key as a string 
(for example, NSString) to the plist, with a complete absolute path to a target text file. This causes debug 
logging to be output to the target text file instead of to the default location, which is viewable by the 
Console application.

To view the logs, you can open the Console application (located in Applications/Utilities) and select the log 
from the panel on the left. This panel may need to be opened first – click the Show Log List icon in the 
upper left. After selecting the desired log file in the list, select File > Save As to save a copy to send to 
Customer Service.

Windows

Pipeline Control for Windows saves details in trace (...trace.log) files, located at:

Win7: C:\Users\<username>\AppData\Local\Telestream\Pipeline Control.

When requested, E-mail the latest log file, along with other details, to Customer Service.
December 2015



155
A P P E N D I X B

P i p e l i n e  E D L  S y n ta x
Appendix B, Pipeline EDL Syntax

This appendix provides information about the proper syntax for the content of Pipeline EDL documents.

PIPELINE EDL SYNTAX REQUIREMENTS

Pipeline EDL files contain an entry for each clip to be captured. Each entry consists of a single-line event, 
a clip name field, and optional Telestream specific metadata fields. Columns are significant. 

Event Line Fields

Pipeline EDL files contain an entry for each clip to be captured. Each entry consisting of a single-line 
event, a clip name field and optional Telestream specific metadata fields. 

Event Line Form

1111 222222 333333 4444 555 66666666666 77777777777 88888888888 99999999999

Event Parameters

1111 = Column 1, 4-digit event number 0001 to 9999

222222 = Column 6, six character alphanumeric tape name (can be overridden by optional TAPENAME)

333333 = Column 13, six characters, leading with an A (audio) or V (video)

4444 = Column 20, must always be "C   " (C followed by three spaces)

555 = Column 25, Must always be "   ", three spaces

66666666666 = Column 29, SMPTE timecode of source Mark-In (hh:mm:ss:ff)

77777777777 = Column 41, SMPTE timecode of source Mark-Out

88888888888 = Column 53, not used

Note

Line endings for a Pipeline EDL file must be CRLF (Carriage Return followed by Line 
Feed), which is the DOS/Windows standard. Therefore, if you create an EDL file from 
scratch on a Macintosh, you may have to convert the line endings.
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99999999999 = Column 65, not used.

Example: 0001 Reel01 A12V   C        00:00:38;22 00:00:41;14 00:00:38;22 00:00:41;14

Clip Name Field (optional)

*CLIP: <Name_of_the_clip>

This name will be used by FlipFactory as the file name.

Begin Additional Fields Parameter

Telestream metadata fields (optional):

*TELESTREAM_METADATA: BEGIN

If optional TELESTREAM fields are included, the BEGIN parameter is required to be first.

Pipeline

This parameter determines which Pipeline to connect to for this clip entry. The name used for this field is 
the Bonjour friendly name assigned to the Pipeline device. This name defaults to Pipeline_XXXX where 
XXXX is the Pipeline's serial number.

The friendly name can be obtained by issuing the config CGI GET command to the Pipeline. The friendly 
name is contained within the Identity element of the returned XML descriptor. Config command example: 
http://<Pipeline IP Address>/command.cgi?config.

*TELESTREAM_METADATA: PIPELINE <Pipeline service name>

Example: *TELESTREAM_METADATA: PIPELINE    Pipeline_3005

Pre-roll Value to VTR

*TELESTREAM_METADATA: PREROLL <Numeric value in seconds>

Example: *TELESTREAM_METADATA: PREROLL     2

Offset for Frame Accuracy

*TELESTREAM_METADATA: OFFSET <Numeric value in frames>

Example: *TELESTREAM_METADATA: OFFSET      0

Anamorphic Flag

Produced when video is specified as 16 x 9 format because the 16 x 9 check box has been selected on the 
live page for proper video display. Any EDL produced with this option checked will also set the 
ANAMORPHIC flag to TRUE:

*TELESTREAM_METADATA: ANAMORPHIC TRUE

This flag insures that anamorphic flags are set in appropriate output files in FlipFactory.

Note

Each parameter (1 through 9) must be separated by a single space.
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Abort Switch for Dropped Frames

A true value will abort the process if a frame is dropped, false will continue even if a frame is dropped

*TELESTREAM_METADATA: ABORT <true/false>

Example: *TELESTREAM_METADATA: ABORT       false

Name of Tape

*TELESTREAM_METADATA: TAPENAME <Alphanumeric>

Example: *TELESTREAM_METADATA: TAPENAME    TAPE1234

Description of Clip

*TELESTREAM_METADATA: DESCRIPTION <Alphanumeric>

Example: *TELESTREAM_METADATA: DESCRIPTION This is a test

Scene Number or Name

*TELESTREAM_METADATA: SCENE <Alphanumeric>

Example: *TELESTREAM_METADATA: SCENE       Good cop bad cop

Take Number

*TELESTREAM_METADATA: TAKE <Numeric>

Example: *TELESTREAM_METADATA: TAKE        2

Additional Notes

*TELESTREAM_METADATA: NOTES <Alphanumeric>

Example: *TELESTREAM_METADATA: NOTES       Additional information goes here.

End of Additional Fields Parameter

*TELESTREAM_METADATA: END

If optional TELESTREAM fields are included this parameter is require to be last.
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C o d e c  P r o f i l e s
Appendix C, Pipeline Control Codec Profiles

This appendix describes each Pipeline codec’s preset profiles. SD profiles are available in Pipeline SC and 
Pipeline Quad. Both SD and HD codec profiles are available in Pipeline HD Dual.

Some wrapper/file formats do not support all possible audio / video options. For example, MXF wrappers 
(Avid, XDCam, and Op1a) do not support 16 channels of audio.

Video Profiles

 DNxHD Profiles (page 160)

 DV and DVCPro Profiles (page 160)

 DVCPro HD Profiles (page 160)

 Avid IMX Profiles (page 161)

 ProRes Profiles (page 161)

 Motion JPEG Profiles (page 161)

 SD Uncompressed Profiles (page 162)

Audio Profiles

 Linear PCM Profiles (page 162)
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DNxHD Profiles
Table C–1. DNxHD Profiles

*1080i Field Order: Upper Field First

DV and DVCPro Profiles
Table C–2. DV and DVCPro Profiles

*NTSC Field Order: Lower Field First

**PAL Field Order: Upper Field First

*** Available with Pipeline HD Dual Channel Only

DVCPro HD Profiles
Table C–3. DVCPro HD Profiles

*1080i Field Order: Upper Field First

Vertical Horizontal Aspect Ratios Frame 
Rates Quality

720p 1280 16:9 23.976, 25, 
29.97, 50, 
59.94

8bit SQ, 8bit 
HQ, 10bit HQ

1080i* 1440 16:9 25, 29.97 8bit SQ

1080i* 1920 16:9 25, 29.97 8bit SQ, 8bit 
HQ, 10bit HQ

1080p 1920 16:9 23.976, 24, 
25

8bit LQ

1080p 1920 16:9 23.976, 24, 
25, 29.97

8bit SQ, 8bit 
HQ, 10bit HQ

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

480i*, 486i* 720 4:3, 16:9 29.97 25, 50***

576i** 720 4:3, 16:9 25 25, 50***

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

720p 960 16:9 23.976, 25, 
29.97, 50, 
59.94

100

1080p 1280 16:9 23.976 100

1080i*, 1080p 1280 16:9 29.97 100

1080i*, 1080p 1440 16:9 25 100
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IMX Profiles
Table C–4. Avid IMX Profiles

*NTSC Field Order: Lower Field First

**PAL Field Order: Upper Field First

*** 50Mb/s compatible with Avid QuickTime AMA

ProRes Profiles
SD Pipeline devices support ProRes SQ, LT and Proxy quality levels; HD Pipeline devices support ProRes 
HQ, SQ, LT and Proxy quality levels.

Table C–5. ProRes Profiles

*NTSC Field Order: Lower Field First

**PAL Field Order: Upper Field First

***1080i Field Order: Upper Field First

Motion JPEG Profiles
Motion JPEG A is supported in SD profiles; Standard and HQ are supported in HD profiles.

Table C–6. Motion JPEG Profiles

Vertical Horizontal Aspect Ratios Frame Rates Quality (Mbps)

486i* 720 4:3, 16:9 29.97 30, 40, 50, Avid IMX***

576i** 720 4:3, 16:9 25 30, 40, 50, Avid IMX***

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

486i* 720 4:3, 16:9 29.97 SQ, HQ

576i** 720 4:3, 16:9 25 SQ, HQ

720p 960, 1280 16:9 23.976, 25, 
29.97, 50, 
59.94

SQ, HQ, LT, 
Proxy

1080p 1440, 1920 16:9 23.976 SQ, HQ, LT, 
Proxy

1080i***, 1080p 1440, 1920 16:9 25, 29.97 SQ, HQ, LT, 
Proxy

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

240p 320 4:3 25, 29.97 Q80

240p 427 16:9 25, 29.97 Q80
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SD Uncompressed 8-bit Profiles
Table C–7. SD Uncompressed Profiles

*NTSC Field Order: Lower Field First

**PAL Field Order: Upper Field First

Linear PCM Profiles
Table C–8. Linear PCM Profiles

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

480i*, 486i* 720 4:3, 16:9 29.97 uncompressed

576i** 720 4:3, 16:9 25 uncompressed

Parameter Value

Channels 2 | 4 | 8 | 16

Sample Rate 48 KHz

Quality 16 | 24 bit, Big Endian | Little Endian
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Symbols

.Net Framework 3.5, required 3-24

Numerics

525/625, automatic detection of 2-8, 2-10
554 port (RTSP) must be open 2-20
80, http port, must be open 2-20

A

About panel, generally 5-43
assemble edits, in Pipeline Control 10-138
audio flag, in print to tape 10-140
auto timecode clock source 6-67
Avid IMX C-161
Avid, MXF file support 4-26

B

back plane, HD Dual, ports and connectors 2-17
back plane, SC, ports and connectors 2-9
Big Endian C-162
BNC, SMPTE-259M 270MBPS 2-10, 2-14
Bonjour panel 4-30–4-31

C

Canadian EMC Notice of Compliance i-iii
Cat-5 cable, must be used with Pipeline i-ii
Channel 1 (Quad), timecode clock source 6-67
clip list files, loading and saving 6-81
clip list panel, using generally 8-120
clip list, creating for log and capture 8-117
clip panel, in print to tape documents 10-140, 

11-149
clip, creating 8-124
clip, deleting 8-124

closed caption 1-2, 2-8
closed caption data extraction 2-8
closed caption, processing 2-15
comparison of features 4-26
computer clock, timecode source 6-67
confidence monitoring 1-2, 2-11, 5-50–5-52, 8-117, 

9-127
confidence monitoring, disabling 5-51
confidence monitoring, enabling 5-51
Configure panel, generally 5-44
Connect dialog, authenticating with 5-42
Copy File, configuring publisher for 6-74
copyright notice i-i
Counters panel 5-53
CPLD chip version 5-45
crash records, in Pipeline Control 10-138

D

DAM 1-2
DHCP address 2-21, 5-49, A-153
dimensions, of Pipeline Quad 2-10, 2-14
dimensions, of Pipeline SC 2-8
DNxHD, Avid DNxHD 1-3
DV 2-10, 5-52
DVCPro 2-10, 5-52
DVCProHD 1-3

E

edit decision list 5-55
EDL 5-55
EDL files B-155
EDL for Pipeline syntax B-155
EDL, loading and saving 6-81
electrical safety, standards complied with i-iii
emission information i-ii
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emission standards complied with i-iii
EN55022 Class A Warning i-iii
environmental operating requirements 2-6
Episode 2-8, 5-51
Episode | Episode Pro, Pipeline Plugin for 4-26
Episode, version requirements for use with 

Pipeline 4-27
Ethernet 2-6, 2-8–2-9, 2-11
Ethernet port (SC) 2-9
Ethernet port, LED indicators for 2-14, 2-18
Ethernet, gigabit 1-2, 2-10, 2-14
Ethernet, gigabit in Quad 1-2
Ethernet, gigabit port (HD Dual) 2-18
Ethernet, gigabit port (Quad) 2-14

F

FCC Emission Information i-ii
features, comparison of Pipeline applications 4-26
Final Cut Pro 1-2, 2-19, 2-21, 5-51, A-151, A-153
Final Cut Pro version 5.0.1, requirement for using 

with Pipeline 4-27
Final Cut Pro, Pipeline Plugin for 4-26
firmware update 2-8, 2-11, 5-56
FlipFactory 1-2, 2-8, 2-19, 2-21, 5-51, A-151
FlipFactory / Pipeline workflow, system 

requirements for 4-37
FlipFactory console 5-52
FlipFactory, configuring publisher for 6-75
FlipFactory, requirements for using with 

Pipeline 4-27
FlipFactory, version requirements 4-27
FPGA chip version 5-45
front panel indicators 2-11, 2-16
front panel indicators for SC 2-8

G

gigabit Ethernet 1-2, 2-10, 2-14, 2-19
gigabit Ethernet port (HD Dual) 2-18
gigabit Ethernet port (Quad) 2-14

H

hardware for Quad 2-10, 2-14
hardware for SC 2-8
HD Dual, reset switches 2-12, 2-16
HTTP password rules 5-46
http port 80, must be open 2-20

I

IMX 2-10, 5-52
insert edit 10-140
insert edits, in Pipeline Control 10-138
installing Pipeline software on 3-23
installing Pipeline software on Windows 3-23
installing Pipeline software, generally 4-25
Internet Explorer 5-45
Internet Explorer 6 5-41
Internet Explorer, req’d settings for Pipeline 

Administrator 5-42

L

LAN LED (HD Dual) 2-16
LED SDI, front, on Quad, lights orange 2-11
LED, Ethernet on Quad 2-14, 2-18
LED, Ethernet on SC, lights orange 2-9
LED, Ethernet, on SC, unlit 2-10
LED, front, on Quad, lights yellow 2-11
LED, on HD Dual front panel 2-16
LED, on Quad front panel 2-11
LED, on SC, lights orange 2-8
LED, on SC, lights yellow 2-8
LED, SDI on front, Quad, blinks orange 2-11
LEDs 2-11, 2-16
LEDs, for SC 2-8
license requirements, for MPEG-2 i-i
Link LED (Quad) 2-11
link-local 2-20–2-21, 5-45
link-local IP address, default 2-20
Little Endian C-162
log and capture window, using generally 8-118
log and capture, generally 8-117
loopback, disabling 5-47

M

MAC address 2-21
Mac OS X 2-19
Mac OS X, Pipeline Control, supported 4-26
Mode LED (HD Dual) 2-16
MPEG-2, license requirements i-i
MXF file support 4-26

N

name of Pipeline, editing 5-45
network settings, configuring 2-22
notices
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Canadian EMC Notice of Compliance i-iii
FCC emission information i-ii

notices, legal, generally i-i
NTSC 2-10

O

operating temperatures 2-6
overheating warning 2-6
overheating, or Pipeline, avoiding 2-6

P

PAL 2-10
password, none by default, assigning 5-46
Pipeline

adding to LAN 2-20
configuring and connecting 2-21
connecting directly to computer 2-19
dimensions of Quad 2-10, 2-14
dimensions of SC 2-8
LEDs 2-8
name, editing 5-45
network settings 2-22
power requirements 2-6
rebooting 5-49
registering 2-22
soft rebooting 5-49
version 5-45

Pipeline Administrator
About panel 5-43
Configure panel 5-44
Upgrade panel 5-55

Pipeline Administrator, generally 5-41
Pipeline Administrator, launching 5-42
Pipeline applications, features compared 4-26
Pipeline clock, timecode source 6-67
Pipeline Control, feature comparison 4-26
Pipeline Control, supported 4-26
Pipeline HD Dual

contents of shipping container 2-7
features 1-3
front panel indicators 2-16
locating for operation 2-7
rear panel 2-17

Pipeline Plugin, feature comparison 4-26
Pipeline Quad

contents of shipping container 2-7
features 1-2

front panel indicators 2-11
hardware, specifications 2-10, 2-14
locating for operation 2-7
rear panel 2-13

Pipeline SC
contents of shipping container 2-7
features 1-2
front panel indicators 2-8
hardware, specifications 2-8
locating for operation 2-7
rear panel 2-9

Pipeline software, general hardware and OS 
requirements for 4-37

Pipeline software, installing 4-25
Pipeline software, installing on Windows 3-23
Pipeline software, uninstalling from Windows 3-24
Pipeline software, upgrading on Windows 3-24
PipelineAdministrator 5-53

Quad panel 5-50
ports, that must be open 2-20
Postroll Duration 6-84
power connector (HD Dual) 2-17
power connector (Quad) 2-13
power connector (SC) 2-9
Power LED (SC) 2-8
power requirements for Pipeline 2-6
pre-roll 7-112
preroll duration 6-84
pre-roll value to VTR B-156
pre-roll, excessive, problem 7-112, 8-121, 9-129
Preview Panel, using generally 6-79
preview panel, using in log and capture 8-119, 

9-130
Print Time Tape, in print to tape documents 10-142
Print to Tape configuration panel 10-139, 11-147
print to tape documents, creating, 

generally 10-139, 11-147
Print to Tape Timecode panel 10-140, 11-147
print-to-tape operations, generally 10-137
print-to-tape, requires QuickTime clips 10-139, 

11-147
ProRes 422 HD, Apple ProRes 422 HD 1-3
publisher, configuring Copy File as 6-74
publisher, configuring for FlipFactory 6-75
publisher, configuring, generally 6-68
publisher, selecting 6-68
PWR LEDs (HD Dual) 2-16
PWR LEDs, on Quad 2-12
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Q

Quad panel, generally 5-50
QuickTime file support 4-26
QuickTime format, used exclusively in print-to-tape 

ops 10-139, 11-147

R

Radiation Emission Susceptibility Regulatory 
Approved Standards

complied with i-iii
rear panel, HD Dual, ports and connectors 2-17
rear panel, Quad, ports and connectors,back 

plane, Quad, ports and connectors 2-13
rear panel, SC, ports and connectors 2-9
rebooting, Pipeline 5-49
Reference LED (HD Dual) 2-16
Register, using button on About panel 5-43
registering your Pipeline 2-22
registering, URL for 5-43
reset switches, HD Dual 2-12, 2-16
RS-422 2-9–2-10, 2-13–2-14, 2-17–2-18, 2-21, 

5-54, 6-79, 8-119–8-120, 9-128, 9-130, 10-138
RS-422 deck control 2-8
RS-422 port (Quad) 2-13
RS-422 port (SC) 2-9, 2-13
RS422, timecode clock source 6-67
RTSP port 554 must be open 2-20

S

Safari 5-45
safety instructions when using Pipeline i-iii
SDI In (HD Dual), indicators for 2-16
SDI In (SC) 2-8
SDI In LED (Quad) 2-11
SDI In port (HD Dual) 2-18
SDI In port (Quad) 2-14
SDI In port (SC) 2-9
SDI LED (SC) 2-8
SDI Out (HD Dual), indicators for 2-16
SDI Out (SC) 2-9
SDI Out LED (Quad) 2-11
SDI Out port (Quad) 2-14
SDI Out port (SC) 2-10
SDI Out, indicators for 2-18
SDI Sync Input (HD Dual) 2-17
SDI time code 6-67
Serial Digital Interface 2-8, 2-10, 2-14

settings, returning to default 5-49
SMPTE-259M 270MBps 2-8
soft rebooting, Pipeline 5-49
Sony Protocol 2-8
stack limit two, overheating 2-6
Static IP address 5-45
static IP address 2-20–2-21, 5-49, A-153
surge protector, recommended 2-6
Sync In (HD Dual) 2-17
Sync In port (Quad) 2-13
Sync LED (HD Dual) 2-16
Sync LED (Quad) 2-12
Sync Out (HD Dual) 2-18
Sync Out port (Quad) 2-13
sync reference 1-2, 2-12, 2-16
sync reference, using in HD 2-15
sync reference, using in Quad 2-10

T

TCP ports that must be open 2-20
Telestream

contacting i-iv
International i-ii
sales and marketing i-i–i-ii
technical support i-i–i-ii
Web site i-i–i-ii

Telestream, contacting i-ii
temperature, operating requirements for 2-6
TIFO file support 4-26
time code 1-2, 2-15, B-155
time code, processing 2-8, 2-15
timecode clock source, Auto 6-67
timecode clock source, Channel 1 (Quad) 6-67
timecode clock source, RS422 6-67
timecode clock source, video input 6-67
timecode clock source, Zero based 6-67
timecode clock sources, options 6-67
timecode source, computer clock 6-67
timecode source, Pipeline clock 6-67
trademark notice i-i
trigger document, in Pipeline Control, 

generally 9-127
trigger window, using generally 9-128

U

UDP ports that must be open 2-20
Uncompressed SD 8- and 10-bit 1-3
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uninstalling Pipeline software from Windows 3-24
Upgrade panel 5-55
upgrading software on Windows 3-24

V

VANC Closed Caption and Time Code, processing 
with Pipeline 2-15

VBI Closed Caption and Time Code, processing 
with Pipeline 2-8

version 5-45
Vertical Blanking Interval, processing 2-8
Video Input, timecode clock source 6-67
VITC time code 1-2
VTR 6-62, 6-67, 6-79, 7-108, 8-117, 8-119–8-121, 

8-124, 9-127–9-128, 9-130, 9-134, 
10-137–10-138, B-156

VTR RS-422 2-20

W

warranty i-iv
Warranty and Disclaimers i-iv
Web browsers

supported 5-41
Windows 2-19
Windows, installing Pipeline software on 3-23
Windows, uninstalling Pipeline software from 3-24
Windows, upgrading Pipeline software on 3-24
workflows for FlipFactory, version 

requirements 4-27

Z

Zero based, timecode clock source 6-67
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